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TMS320C28x™ DSP Workshop Outline

1. Architecture Overview

2. Programming Development Environment
Lab: “User" linker command file
Lab: DSP/BIOS configuration tool
. Peripheral Register Header Files
. Reset and Interrupts
5. System Initialization
Lab: Watchdog and interrupts
6. Analog-to-Digital Converter
Lab: Build a data acquisition system

7. Control Peripherals
Lab: Generate and graph a PWM waveform

8. Numerical Concepts and 1Q Math
Lab: Low-pass filter the PWM waveform

9. Using DSP/BIOS
Lab: Change the code to use DSP/BIOS

10. System Design
Lab: Run the code from flash memory

11. Communications
12. Support Resources
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Architecture Overview

Introduction

This architecture overview introduces the basic architecture of the TMS320C28x (C28x) series of
Digital Signal Processors from Texas Instruments. The C28x series adds a new level of general
purpose processing ability unseen in any previous DSP chips. The C28x is ideal for applications
combining DSP, standard microcontroller processing, efficient C code execution, or operating
system tasks.

Unless otherwise noted, the terms C28x and C280x refer to TMS320C280x and TMS320F280x
devices throughout the remainder of these notes. For specific details and differences please refer
to the device data sheet and user’s guide.

Learning Objectives

When this module is complete, you should have a basic understanding of the C28x architecture
and how all of its components work together to create a high-end, uniprocessor control system.

Learning Objectives

¢ Identify the three main components
of the C28x

¢ List the key features of the C28x
CPU

¢ ldentify the memory capabilities of
the C28x

¢ lIdentify the peripherals available on
the C28x
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What is the TMS320C28x?

What is the TMS320C28x?

The TMS320C28x is a 32-bit fixed point DSP that specializes in high performance control
applications such as, robotics, industrial automation, mass storage devices, lighting, optical

networking, power supplies, and other control applications needing a single processor to solve a
high performance application.

C28x Block Diagram

Program Bus

Realtime
JTAG

Boot
Sectored 1
Flash ~  eQeP  [s—
1 ]
3 — 12-bit ADC [«
1 ]
A. 1 1
<-,—-|' Watchdog I_I_"
J, .
PIE jmmmmmmmmmmmmy
-bi R-M-W| | Interrupt « 1 1
32_1_)” 32x32 bit . Manager i Gy 2l 1
Auxiliary ltili Atomic I 1
Registers LAl Ve ALU : 12C -
3 1 1
________ 1 1
Ll i (oo so k-
CPU : :
Data Bus GPIO

The C28x architecture can be divided into 3 functional blocks:

e CPU and busing

e Memory

e Peripherals

TMS320C28x DSP Workshop - Architecture Overview



What is the TMS320C28x?

TMS320C28x Internal Bussing

As with many DSP type devices, multiple busses are used to move data between the memories
and peripherals and the CPU. The C28x memory bus architecture contains:

e A program read bus (22 bit address line and 32 bit data line)
e A data read bus (32 bit address line and 32 bit data line)

e A data write bus (32 bit address line and 32 bit data line)

C28x Internal Bus Structure
Program Program Address Bus (22) :
Program-read Data Bus (32) HORELT]
Decoder I 1 (4M* 16)
| Data-read Address Bus (32)
1 I f
| Data-read Data Bus (32) Data
1 1 l I (4G * 16)
Registers Execution Debug
ARAU MPY32x32 P e Memory
[ sP ] ALU R-M-W | | ||Emulation
DP_|@X XT Atomic & JTAG
XARO 5 ALU Test |lemmmmp Standard
X/E\%QY ACC Engine Peripherals
[ Register Bus / Result Bus | External
1 1 Interfaces
| . Data/Program-write Data Bus (32) .
[ Data-write Address Bus (32)

The 32-bit-wide data busses enable single cycle 32-bit operations. This multiple bus architecture,
known as a Harvard Bus Architecture enables the C28x to fetch an instruction, read a data value
and write a data value in a single cycle. All peripherals and memories are attached to the memory
bus and will prioritize memory accesses.
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C28x CPU

C28x CPU

The C28x is a highly integrated, high performance solution for demanding control applications.
The C28x is a cross between a general microcontroller and a digital signal processor, balancing
the code density of a RISC chip and the execution speed of a DSP with the architecture,
firmware, and development tools of a microcontroller.

The DSP features include a modified Harvard architecture and circular addressing. The RISC
features are single-cycle instruction execution, register-to-register operations, and modified
Harvard architecture. The microcontroller features include ease of use through an intuitive
instruction set, byte packing and unpacking, and bit manipulation.

C28x CPU

& MCU/DSP balancing code density
& execution time.

& Supports 32-bit instructions

Program Bus for improved execution time;

& Supports 16-bit instructions
for improved code efficiency
— o 32-bit fixed-point DSP
2:0it oz bitfli MW mgggg; & 32X 32bit fixed-point MAC
Multiplier FeImie & Dual 16 x 16 single-cycle fixed-
ALU 5 point MAC (DMAC)
32 bit & 32-/64-bit saturation
ReanimeIReg'scthLB“S Timers & 64/32 and 32/32 modulus division
JUAIET] & Fast interrupt service time
I Data Bus & Single cycle read-modify-write
instructions

*

Unique real-time debugging
capabilities

& Upward code compatibility

The C28x design supports an efficient C engine with hardware that allows the C compiler to
generate compact code. Multiple busses and an internal register bus allow an efficient and
flexible way to operate on the data. The architecture is also supported by powerful addressing
modes, which allow the compiler as well as the assembly programmer to generate compact code
that is almost one to one corresponded to the C code.

The C28x is as efficient in DSP math tasks as it is in system control tasks that typically are
handled by microcontroller devices. This efficiency removes the need for a second processor in
many systems.

The C28x is one of several members of the fixed-point generations of digital signal processors
(DSPs) in the TMS320 family. The C28x is source-code and object-code compatible with the
C27x. In addition, the C28x is source code compatible with the 24x/240x DSP and previously
written code can be reassembled to run on a C28x device. This allows for migration of existing
code onto the C28x.
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C28x CPU

Multiplier, ALU, and Shifters
C28x Multiplier and ALU / Shifters

Program Busw
Data Bus &z ,_T 5
16 XT (32) or T/TL 16/32
MULTIPLIER
- - 32 32x32o0r 8/16/32
Shift R/L (0-16) Dual 16 X 16 —
N 32
< P (32) or PH/PL
432
2 | shift RIL (0-16) |

N aue

32
ACC (32)

AH (16) AL (16)
AH.MSB |AH,LSB AL.MSB | AL.LSB
32
| shift RIL (0-16) |

32

Data Bus

The 32 x 32-bit MAC capabilities of the C28x and its 64-bit processing capabilities, enable the
C28x to efficiently handle higher numerical resolution problems that would otherwise demand a
more expensive floating-point processor solution. Along with this is the capability to perform
two 16 x 16-bit multiply accumulate instructions simultaneously or Dual MACs (DMAC).

C28x XARn, DP and Memory

Data Bus

Program Bus

6 LSB

XARO DP (16) from IR

XAR3 32 22

XAR4 X

Data Memory

XARN — 32-bits
ARN — 16-bits
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C28x CPU

Special Instructions
C28x Atomic Read/Modify/Write

& Atomic Instructions Benefits:

LOAD > Simpler programming
J READ
= > Smaller, faster code
[ Registers ALU / MPY ] | Mem
‘ > Uninterruptible (Atomic)
WRITE
STORE > > More efficient compiler

Standard Load/Store Atomic Read/Modify/Write

DINT

MOV  AL,*XAR2
AND  AL,#1234h
MOV  *XAR2,AL
EINT

6 words / 6 cycles

AND *XAR2,#1234h

2words / 1 cycles

Atomics are small common instructions that are non-interuptable. The atomic ALU capability
supports instructions and code that manages tasks and processes. These instructions usually
execute several cycles faster than traditional coding.
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C28x CPU

Pipeline Advantage

C28x Pipeline

A|FiiF|DiiD,| RiiR, | X|W 8-stage pipeline
B FiiF |DiiDy | RiGR | X | W
C FiiF |DiiDy| Ry Ry | X | W

""""" F,|F,|D,iD,|R|R,| X
b 1372 |Dai D] Ryl Ry | X W __E &G Access
E_ FiiF, D] D[ RiIR, | X)W "" same address
F FlEFZ Dl D2 RliRZ X W
G F.]F, D Dy | Ryl “[R, | X |W
H F,|F,|D;|D,: RiiR,| X |W
F1: Instruction Address
F2: Instruction Content Protected Pipeline
D1: Decode Instruction i )
D2: Resolve Operand Addr » Order of results are as written in
R1: Operand Address source code
R2: Get Operand
X: CPU doing “real” work » Programmer need not worry about
W: store content to memory the pipeline

The C28x uses a special 8-stage protected pipeline to maximize the throughput. This protected
pipeline prevents a write to and a read from the same location from occurring out of order.

This pipelining also enables the C28x to execute at high speeds without resorting to expensive
high-speed memories. Special branch-look-ahead hardware minimizes the latency for conditional
discontinuities. Special store conditional operations further improve performance.
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Memory

Memory

The memory space on the C28x is divided into program and data space. There are several
different types of memory available that can be used as both program or data space. They include
the flash memory, single access RAM (SARAM), expanded SARAM, and Boot ROM which is
factory programmed with boot software routines or standard tables used in math related
algorithms.

Memory Map

The C28x CPU contains no memory, but can access memory both on and off the chip. The C28x
uses 32-bit data addresses and 22-bit program addresses. This allows for a total address reach of
4G words (1 word = 16 bits) in data space and 4M words in program space. Memory blocks on
all C28x designs are uniformly mapped to both program and data space.

This memory map shows the different blocks of memory available to the program and data space.

TMS320F2808 Memory Map

Data | Program
0x00 0000[ MO SARAM (1Kw)
0x00 0400| M1 SARAM (1Kw)
0x00 0800 [PF 0 (2Kw)| reserved

0x00 0DO0O0 |PIE vector
EﬁsGW) reserved

0x00 OEO00 reserved

0x00 6000 |PF 1 (4Kw)| reserved
0x00 7000 [PF 2 (4Kw) reserved
0x00 8000 LO SARAM (4Kw)
0x00 9000 |1 SARAM (4Kw)
0x00 AOOO| HO SARAM (8Kw)

0x00 C000 reserved

0x3D 7800 OTP (1Kw)

0x3D 7C00 reserved Dual
0x3E 8000 FLASH (64KW) Mapped

Ox3F 7FF8 128-Bit Password
O0x3F 8000 LO SARAM (4Kw)
Ox3F 9000 |1 SARAM (4Kw)
0x3F AOOO| HO SARAM (8Kw)
0x3F C000 reserved

Ox3F FOOO| Boot ROM (4Kw)

0x3F FFCO| BROM vector (32w) e
X vector W
VMAP=1 ENPﬁEzo OTP, FLASH
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Memory

Code Security Module (CSM)

¢ Prevents reverse engineering and
protects valuable intellectual property

* o

Code

0x00 8000
0x00 9000
0x00 A00O
0x00 C000
0x3D 7800
0x3D 7C00
0x3E 8000
Ox3F 7FF8
0x3F 8000
0x3F 9000

128-bit user defined password is stored in Flash
128-bits = 2128 = 3.4 x 1038 possible passwords

¢ Totry 1 password every 8 cycles at 100 MHz, it
would take at least 8.8 x 1023 years to try all
possible combinations!

Security Module

LO SARAM (4Kw)
L1 SARAM (4Kw)
reserved
OTP (1Kw) - Dual
reserved Mapped

FLASH (64Kw)

128-Bit Password

LO SARAM (4Kw)
L1 SARAM (4Kw)

Peripherals

The C28x comes with many built in peripherals optimized to support control applications. These
peripherals vary depending on which C28x device you choose.

ePWM
eCAP

eQEP

Analog-to-Digital Converter

Watchdog Timer

e SPI

e SCI

e |2C

e CAN

e GPIO

TMS320C28x DSP Workshop - Architecture Overview



Fast Interrupt Response

Fast Interrupt Response

The fast interrupt response, with automatic context save of critical registers, resulting in a device
that is capable of servicing many asynchronous events with minimal latency. C28x implements a
zero cycle penalty to do 14 registers context saved and restored during an interrupt. This feature
helps reduces the interrupt service routine overheads.

C28x Fast Interrupt Response Manager

> 96 dedicated PIE
vectors

> No software decision [
making required PIE module

> Direct access to RAM thgrrrfsts

vectors

Auto flags update

Concurrent auto

context save

28x CPU Interrupt logic

96

INT1 to

INT12 28x
T,\ IFR|[ IER || INTM ™ CPU
12 interrupts

PIE

Register

>
>

Map

Auto Context Save

T STO
AH AL

PH PL
AR1 (L) | ARO (L)
DP ST1
DBSTAT| IER
PC(msw)| PC(Isw)

Peripheral Interrupts 12x8
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C28x Mode

C28x Mode

The C28x is one of several members of the fixed-point generations of digital signal processors
(DSPs) in the TMS320 family. The C28x is source-code and object-code compatible with the
C27x. In addition, the C28x is source code compatable with the 24x/240x DSP and previously
written code can be reassembled to run on a C28x device. This allows for migration of existing
code onto the C28x.

C28x [ C24x Modes

Mode Type Mode Bits Compiler
OBJMODE AMODE Option
C24x Mode 1 1 -v28 -m20
C28x Mode 1 0 -v28 (workshop)
Test Mode (default) 0 0 -v27
Reserved 0 1

» C24x source-compatible mode:
> Allows you to run C24x source code which has been reassembled
using the C28x code generation tools (need new vectors)
> C28x mode:
» Can take advantage of all the C28x native features
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Reset

Reset

Reset — Bootloader

Reset
OBJMODE=0 AMODE=0
ENPIE=0 VMAP=1

Bootloader sets
OBJMODE =1
Reset vector fetched AMODE =0

Boot determined by
from boot ROM state of GPIO pins
0x3F FFCO

Execution
Entry Point
Note: MO SARAM

Details of the various boot options will be
discussed in the Reset and Interrupts module
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Summary

Summary

Summary

High performance 32-bit DSP

32 x 32 bit or dual 16 x 16 bit MAC
Atomic read-modify-write instructions
8-stage fully protected pipeline
Fast interrupt response manager
64Kw on-chip flash memory

Code security module (CSM)
Control peripherals

12-bit ADC module

35 shared GPIO pins

Watchdog timer

Communications peripherals

L K K JEE B JBE 2B R 2N IR IR R 4
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Programming Development Environment

Introduction

This module will explain how to use Code Composer Studio (CCS) integrated development
environment (IDE) tools to develop a program. Creating projects and setting building options
will be covered. Use and the purpose of the linker command file will be described. Additionally,
the DSP/BIOS Configuration Tool will be used to handle system memory and system setup.

Learning Objectives

Learning Objectives

¢ Use Code Composer Studio to:
+ Create a Project
+ Set Build Options

& Create a user linker command file which:
+ Describes a system’s available memory

+ Indicates where sections will be placed
in memory

¢ Use DSP/BIOS Configuration Tool to:
+ Handle system memory and system setup
+ Create a .cdb and .cmd file
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Module Topics
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Code Composer Studio

Code Composer Studio

Software Development and COFF Concepts

In an effort to standardize the software development process, T1 uses the Common Object File
Format (COFF). COFF has several features which make it a powerful software development
system. It is most useful when the development task is split between several programmers.

Each file of code, called a module, may be written independently, including the specification of
all resources necessary for the proper operation of the module. Modules can be written using
Code Composer Studio (CCS) or any text editor capable of providing a simple ASCII file output.
The expected extension of a source file is . ASM for assembly and . C for C programs.

Code Composer Studio

DSP/BIOS
Edit Config DS’P/B!OS
Libraries
Tool

—eZdsp™

— EVM

Probe Out -
Graphs Third
Profiling Party

¢ Code Composer Studio includes:
+ Integrated Edit/Debug GUI
+ Code Generation Tools
+ DSP/BIOS

Code Composer Studio includes a built-in editor, compiler, assembler, linker, and an automatic
build process. Additionally, tools to connect file input and output, as well as built-in graph
displays for output are available. Other features can be added using the plug-ins capability

Numerous modules are joined to form a complete program by using the linker. The linker
efficiently allocates the resources available on the device to each module in the system. The
linker uses a command (. CMD) file to identify the memory resources and placement of where the
various sections within each module are to go. Outputs of the linking process includes the linked
object file (.OUT), which runs on the DSP, and can include a . MAP file which identifies where
each linked section is located.

The high level of modularity and portability resulting from this system simplifies the processes of
verification, debug and maintenance. The process of COFF development is presented in greater
detail in the following paragraphs.
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Code Composer Studio

The concept of COFF tools is to allow modular development of software independent of
hardware concerns. An individual assembly language file is written to perform a single task and
may be linked with several other tasks to achieve a more complex total system.

Writing code in modular form permits code to be developed by several people working in parallel
so the development cycle is shortened. Debugging and upgrading code is faster, since
components of the system, rather than the entire system, is being operated upon. Also, new
systems may be developed more rapidly if previously developed modules can be used in them.

Code developed independently of hardware concerns increases the benefits of modularity by
allowing the programmer to focus on the code and not waste time managing memory and moving
code as other code components grow or shrink. A linker is invoked to allocate systems hardware
to the modules desired to build a system. Changes in any or all modules, when re-linked, create a
new hardware allocation, avoiding the possibility of memory resource conflicts.

Code Composer Studio: IDE

File Edit View Project Debug GEL Option Profile Tools DSPBIOS Window Help

2 | | B
[ esample. pit ~|[Debug ~] i &

B é | 0 EliEL &

+-[_ 1 GEL Files
= 3 Projects i i
=& examplepit (Debug) ¢ Integrates: edit, code generation,
'E!!, [ Dependent Projects
(21 Dacuments
w =1 {23 DSP/BIOS Config and debug
= example.cdb
o | éénerateg Files
) B # Single-click access using buttons
2 2 ﬂ examplecfg_c.c
#-[ Include ) .
2 L ¢ Powerful graphing/profiling tools
% Adc.c
= #] CodeStartBranch,asm . .
= %Defamus,.[ ¢ Automated tasks using GEL scripts
*] Delayls.asm
ﬁ ﬂ gSPZYBUDfo\obaIVariah\eDefs‘c
& %EE;‘;TC ¢ Built-in access to BIOS functions
% Gpio.c
] Main.c .
 recic ¢ Support Tl or 39 party plug-ins
B D“SPZ;DfoIeadersiBIOS.cmd
[#] Fz808.cmd
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Code Composer Studio

Projects

Code Composer works with a project paradigm. Essentially, within CCS you create a project for
each executable program you wish to create. Projects store all the information required to build
the executable. For example, it lists things like: the source files, the header files, the target
system’s memory-map, and program build options.

The CCS Project

I® JF2B0B eZdsp/cpu_0 - TMS320C28xx - Code (]
File Edit Wiew Project Debug GEL Option Profile 1

‘.%1@. 8 lﬁ Project (.pjt) files contain:

Fé& OEFBEHEHEZL &

& Source files (by reference)

+ [ GEL Files

=3 Projects * SOUFCQ (C, assembly)
= g example.pjt (Debug) . .
™ @ De;enc‘l)e]nt Prnjactgs * Ll b raries
= '{_‘! Documents . )
N s it + DSP/BIOS configuration
e + Linker command files
& ] examplecfq.sza . .
2 | g B st ¢ Project settings:
& el + Build Options (compiler and
= %gﬂ;-tﬁ . assembler)
& Eloar + Build configurations
g % [E)EzschDx_G\ubaIVarlah\eDefs‘c . DSP/B IOS
*] EPwm.c .
4] spio.c + Linker
ﬂ Main.c
[#] Piectrlc

L [#] sysctrl.c
2] D3P2E:_Headers_BI05.cmd
[#] Fze08.cmd

The project information is stored in a .PJT file, which is created and maintained by CCS. To
create a new project, you need to select the Project:New... menu item.

Along with the main Project menu, you can also manage open projects using the right-click
popup menu. Either of these menus allows you to Add Files... to a project. Of course, you can
also drag-n-drop files onto the project from Windows Explorer.
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Code Composer Studio

Build Options

Project options direct the code generation tools (i.e. compiler, assembler, linker) to create code
according to your system’s needs. When you create a new project, CCS creates two sets of build
options — called Configurations: one called Debug, the other Release (you might think of as

Optimize).

To make it easier to choose build options, CCS provides a graphical user interface (GUI) for the
various compiler options. Here’s a sample of the Debug configuration options.

Mew...
open...

Save
Close

Source Control

Euild
Rebuild all

Build Clean

Configurations...

Ep/cpu_0 - TM5320C28xx - Code Cd
Project Debug GEL  Option  Profile T
i Build Dptions for example. pjt (Debug) @g]

Use External Makefile...
Export ta Makefile,
Add Files ko Project...

Project Dependencies. ..

Show Project Dependencies .
Show Fie Dependenties ¢ Controls many aspects of the build process,
Scan All File Dependencies sSuc h as:

Recent Project Files

Build Options GUI - Compiler

General  Compiler ] Linker I Link Drder}

-g -q -r'C:henamplehDebug” 4 \D5P280x_headers\include” -d"_DEBUG I
-d"LARGE_MODEL" -ml -+28

Categony: B asic:
(Basic | Target Version: C28xx [v28) ~
Advanced

Feedback Generate Debug Info: | Full Symbalic Debug [-g) +
Files Opt Level: Mane h

Assembly
Parser Program Lewel Opt. ‘Nona ﬂ

Preprocessor
Diagnostics

F7

¢ GUI has 8 pages of categories for code
generation tools

+ Optimization level
+ Target device
« Compiler/assembly/link options

There is a one-to-one relationship between the items in the text box and the GUI check and drop-
down box selections. Once you have mastered the various options, you can probably find

yourself just typing in the options.
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Build Options GUI - Linker

Build Options for example. pjt (Debug) E]E]
Generall Compiler  Linker ] Link Order I
-q -c -m".\Debughexample.map’ -0 YD ebughexample. out'" -w -«
: ¢ GUI has 2 categories
Categony: Basic - .
B asic v Suppress Banner [-q) fO r I I n kl n g
Advanced |v Exhaustively Read Libraries [-x] . . .
e | ¢ Specifies various link
Output Filename [-o): \Debughexample.out 0 pt I O n S
Map Filename (-m: \Debughexample.map « - .
Autoinit Model: Run-Time Autainitialization [-c] + ‘ -\Deb U g\ I n d I C at eS
Heap Sz e on subfolder level
Far Heap Stack (farheap]: 1 1
i below project (.pjt)
Stack Size [-stack] I .
Fill 'yalue []; O C a't I O n
Code Entry Point (-]
Library Search Path (-]
Include Libraries [H):

There are many linker options but these four handle all of the basic needs.

o -0 <fFilename> specifies the output (executable) filename.

o -m <Filename> creates a map file. This file reports the linker’s results.
o —c tells the compiler to autoinitialize your global and static variables.

o —x tells the compiler to exhaustively read the libraries. Without this option libraries are
searched only once, and therefore backwards references may not be resolved.
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'# JF2B0B eZdspfcpu_0 - TMS320C2Bxx - Code Compa

File Edit Wiew Project Debug GEL Option  Profile  Tools

‘I’

Files
+- (] GEL Files
= a Projects
= @ example.pjt {Debug)

Default Build Configurations

For new projects, CCS automatically
creates two build configurations:

I% Dr’ ,7 . .
Jesance ) De:gug {unopd mljed)
IR NE] - L — + Release (optimized)

Use the drop-down menu to quickly
select the build configuration

. — ¢ Add/Remove your own custom
build configurations using
Bl f cmgloEh [ oo | Project Configurations
i . & Edit a configuration:
Frivase _Remore_| 1. Set it active
_Setfcie | 2. Modify build options
e 3. Save project

To help make sense of the many compiler options, Tl provides two default sets of options
(configurations) in each new project you create. The Release (optimized) configuration invokes
the optimizer with —03 and disables source-level, symbolic debugging by omitting —g (which
disables some optimizations to enable debug).
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Creating a Linker Command File

Sections

Looking at a C program, you'll notice it contains both code and different kinds of data (global,

local, etc.).

Sections

Global Vars (.ebss) Init vals (.cinit)

Lint

e, e

5

233

. Ry

void main(void)
{
~long z;

Local vars (.stack)  Code (.text)

Every C program
consists of different

parts called sections

All default sections
names begin with “.”

The compiler has
default sections
names for initialized
and uninitialized
sections

In the TI code-generation tools (as with any toolset based on the COFF — Common Obiject File

Format), these various parts of a program are called Sections. Breaking the program code and

data into various sections provides flexibility since it allows you to place code sections in ROM
and variables in RAM. The preceding diagram illustrated five sections:

e Global Variables

o Initial Values for global variables
o Local Variables (i.e. the stack)

e Code (the actual instructions)
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Following is a list of the sections that are created by the compiler. Along with their description,
we provide the Section Name defined by the compiler.

Compiler Section Names

Initialized Sections

Name Description Link Location
.text code FLASH
.cinit initialized global and static variables | FLASH
.econst constant data (e.g. constint k =3;) | FLASH
.switch tables for switch statements FLASH
.pinit tables for global constructors (C++) | FLASH

Uninitialized Sections

Name Description Link Location
.ebss global & static variables RAM

.stack stack space low 64Kw RAM
.esysmem | memory for far malloc functions RAM

Note: During development initialized sections could be linked to RAM since
the emulator can be used to load the RAM

Sections of a C program must be located in different memories in your target system. This is the
big advantage of creating the separate sections for code, constants, and variables. In this way,
they can all be linked (located) into their proper memory locations in your target embedded
system. Generally, they’re located as follows:

Program Code (.text)

Program code consists of the sequence of instructions used to manipulate data, initialize system
settings, etc. Program code must be defined upon system reset (power turn-on). Due to this basic
system constraint it is usually necessary to place program code into non-volatile memory, such as
FLASH or EPROM.

Constants (.cinit —initialized data)

Initialized data are those data memory locations defined at reset.It contains constants or initial
values for variables. Similar to program code, constant data is expected to be valid upon reset of
the system. It is often found in FLASH or EPROM (non-volatile memory).

Variables (.ebss — uninitialized data)

Uninitialized data memory locations can be changed and manipulated by the program code during
runtime execution. Unlike program code or constants, uninitialized data or variables must reside
in volatile memory, such as RAM. These memories can be modified and updated, supporting the
way variables are used in math formulas, high-level languages, etc. Each variable must be
declared with a directive to reserve memory to contain its value. By their nature, no value is
assigned, instead they are loaded at runtime by the program
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Placing Sections in Memory

Memory Secti
ections
0x00 0000 MOSARAM
0x400) § "TTTm--d .ebss
0x00 0400 MlSARAM -
(0x400) T
7 .stack
OX3E 8000 FLASH @ fe--------"1 .cinit
(0x10000) _-—
T~ text

Linking code is a three step process:
1. Defining the various regions of memory (on-chip SARAM vs. FLASH vs. External Memory).
2. Describing what sections go into which memory regions

3. Running the linker with “build” or “rebuild”
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Linker Command Files (.cmd)

The linker concatenates each section from all input files, allocating memory to each section based
on its length and location as specified by the MEMORY and SECTIONS commands in the linker
command file.

Linking

e Memory description

e How to place s/w into h/w

Link.cmd

.0bj —| Linker .out

.map

Memory-Map Description

The MEMORY section describes the memory configuration of the target system to the linker.
The format is: Name: origin = 0x????, length = 0x????
For example, if you placed a 64K FLASH starting at memory location 0x3E8000, it would read:

MEMORY

FLASH: origin = Ox3E8000 , length = 0x010000
}

Each memory segment is defined using the above format. If you added MOSARAM and
M1SARAM, it would look like:

MEMORY
MOSARAM: origin = 0x000000 , length = 0x0400
M1SARAM: origin = 0x000400 , length = 0x0400
}
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Remember that the DSP has two memory maps: Program, and Data. Therefore, the MEMORY
description must describe each of these separately. The loader uses the following syntax to
delineate each of these:

Linker Page  TI Definition

Page 0 Program

Page 1 Data

Linker Command File

MEMORY
PAGE O: /* Program Space */
FLASH: org = Ox3E8000, Ilen = 0x10000
PAGE 1: /* Data Space */
MOSARAM: org = 0x000000, lIen = 0x400
ML1SARAM: org = 0x000400, IlIen = 0x400

}
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Section Placement

The SECTIONS section will specify how you want the sections to be distributed through
memory. The following code is used to link the sections into the memory specified in the
previous example:

SECTIONS

{
.text:> FLASH PAGE O
.ebss:> MOSARAM PAGE 1
.cinit:> FLASH PAGE O
.stack:> M1SARAM PAGE 1

}

The linker will gather all the code sections from all the files being linked together. Similarly, it
will combine all ‘like’ sections.

Beginning with the first section listed, the linker will place it into the specified memory segment.

Linker Command File

MEMORY
PAGE O: /* Program Space */
FLASH: org = Ox3E8000, 1len = 0x10000
PAGE 1: /* Data Space */
MOSARAM: org = 0x000000, IlIen = 0x400
M1SARAM: org = 0x000400, Ilen = 0x400
}
SECTIONS
{
.text:> FLASH PAGE O
.ebss:> MOSARAM PAGE 1
.cinit:> FLASH PAGE O
.stack:> M1SARAM PAGE 1
}
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Exercise 2a

Looking at the following block diagram, and create a linker command file.

Exercise 2a

0x00 0000

0x00 8000

O0x3E 8000

F2808

MoSARAM] ©X00 040011 AR
(0x400) (0x400)
LosARAM] 9X0090001 | ;g arAm
(0x1000) (0x1000)
FLASH || 9X00A000hsARAM
(0x10000 (0x2000)

Create the linker command file for the given memory
map by filling in the blanks on the following slide

Fill in the blanks:

Exercise 2a - Command File

MEMORY
{
PAGE__ : /* Program Space */
org = , len =
/* Data Space */
org = . len =
org = , len =
org = . len =
org = , len =
org = , len =
}
SECTIONS
{
-text: > FLASH PAGE O
-ebss: > MOSARAM PAGE 1
.cinit: >  FLASH PAGE O
.stack: >  M1SARAM PAGE 1
}

TMS320C28x DSP Workshop - Programming Development Environment



Exercise 2a

Summary: Linker Command File

The linker command file (.cmd) contains the inputs — commands — for the linker. This
information is summarized below:

Linker Command File Summary

¢ Memory Map Description
+« Name
+ Location
+ Size

¢ Sections Description

+ Directs software sections into named
memory regions

+ Allows per-file discrimination
+ Allows separate load/run locations
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Lab 2a: Linker Command File
» Objective

Create a linker command file and link the C program file (LAB2.C) into the system described
below.

Lab 2a: Linker Command File

MOSARAM j 0x00 0000 | oSARAM [ 0x00 8000
el (0x400) I (0X1000) I
on-chip M1SARAM@ 0x00 0400 | 1SARAM @ 0X00 9000
memory (0x400) I (0x1000) I
HOSARAM f§ 0x00 AOC0CO
F2808 (0x2000) I

System Description:
* TMS320F2808
* All internal RAM blocks allocated

Placement of Sections:

« .text into RAM Block HOSARAM on PAGE 0 (code space)
e .cinit into RAM Block HOSARAM on PAGE 0 (code space)
« .ebss into RAM Block MOSARAM on PAGE 1 (data space)
« .stack into RAM Block M1SARAM on PAGE 1 (data space)

System Description
o TMS320F2808

e All internal RAM blocks allocated

Placement of Sections:
e .textinto RAM Block HOSARAM on PAGE 0 (code space)

e _cinitinto RAM Block HOSARAM on PAGE 0 (code space)
e .ebss into RAM Block MOSARAM on PAGE 1 (data space)
e stack into RAM Block M1SARAM on PAGE 1 (data space)

» Procedure

Create a New Project

1. Double click on the Code Composer Studio icon on the desktop. Maximize Code
Composer Studio to fill your screen. Code Composer Studio has a Connect/Disconnect
feature which allows the target to be dynamically connected and disconnected. This will
reset the JTAG link and also enable “hot swapping” a target board. Connect to the target.
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Click: Debug - Connect

The menu bar (at the top) lists File ... Help. Note the horizontal tool bar below the menu
bar and the vertical tool bar on the left-hand side. The window on the left is the project
window and the large right hand window is your workspace.

A project is all the files you will need to develop an executable output file (. out) which
can be run on the DSP hardware. Let’s create a new project for this lab. On the menu bar
click:

Project > New

type Lab2 in the project name field and make sure the save in location is:
C:\C28x\Labs\Lab2. This will create a .pjt file which will invoke all the necessary
tools (compiler, assembler, linker) to build your project. It will also create a debug
folder that will hold immediate output files.

Add the C file to the new project. Click:

Project - Add Files to Project..

and make sure you’re looking in C:\C28x\Labs\Lab2. Change the “files of type” to
view C source files (*.c) and select Lab2 . c and click OPEN. This will add the file
Lab2 . c to your newly created project.

Add Lab2a.cmd to the project using the same procedure. This file will be edited
during the lab exercise.

Next, add the compiler run-time support library to the project
(C:\CCStudio_v3.1\c2000\cgtools\l1ib\rts2800_ml_lib).

In the project window on the left click the plus sign (+) to the left of Project. Now,
click on the plus sign next to Lab2.pjt. Notice that the Lab2a.cmd file is listed.
Click on Source to see the current source file list (i.e. Lab2.c).

Project Build Options

7. There are numerous build options in the project. The default option settings are sufficient

for getting started. We will inspect a couple of the default linker options at this time.
Click: Project -> Build Options..

Select the Linker tab. Notice that .out and .map files are being created. The .out file is
the executable code that will be loaded into the DSP. The .map file will contain a linker
report showing memory useage and section addresses in memory.

9. Set the Stack Size to 0x200. Select OK and then close the Build Options window.

Edit the Linker Command File - Lab2a.cmd

10. To open and edit Lab2a . cmd, double click on the filename in the project window.

11. Edit the Memory{} declaration by describing the system memory shown on the “Lab2a:

Linker Command File” slide.
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12. Inthe Sections{} area, notice that a section called .reset has already been allocated.
The .reset section is part of the rts2800_ml.lib, and is not needed. By putting the TYPE =
DSECT modifier after its allocation, the linker will ignore this section and not allocate it.

13. Place the sections defined on the slide into the appropriate memories via the
Sections{} area. Save your work.

Build and Load the Project

14. The top four buttons on the horizontal toolbar control code generation. Hover your
mouse over each button as you read the following descriptions:

Button Name Description
1 Compile File Compile, assemble the current open file
2 Incremental Build Compile, assemble only changed files, then link
3 Rebuild All Compile, assemble all files, then link
4 Stop Build Stop code generation

15. Code Composer Studio can automatically load the output file after a successful build. On
the menu bar click: Option > Customize.. and select the “Program/Project
Load” tab, check ““Load Program After Build”.

Also, Code Composer Studio can automatically connect to the target when started. Select
the “Debug Properties” tab, check “Connect to the target when a
control window is opened”, then click OK.

16. Click the ““Bui 1d”” button and watch the tools run in the build window. Check for
errors (we have deliberately put an error in Lab2 .c). When you get an error, scroll the
build window at the bottom of the Code Composer Studio screen until you see the error
message (in red), and simply double-click the error message. The editor will
automatically open the source file containing the error, and position the mouse cursor at
the correct code line.

17. Fix the error by adding a semicolon at the end of the "'z = x + y'' statement. For
future knowlege, realize that a single code error can sometimes generate multiple error
messages at build time. This was not the case here.

18. Rebuild the project (there should be no errors this time). The output file should
automatically load. The Program Counter should be pointingto _c_1nt0O0 in the
Disassembly Window.

19. Under Debug on the menu bar click “Go Main”’. This will run through the C-
environment initialization routine in the rts2800_ml . 11b and stop at main() in
Lab2.c.

Debug Enviroment Windows

It is standard debug practice to watch local and global variables while debugging code. There
are various methods for doing this in Code Composer Studio. We will examine two of them
here: memory windows, and watch windows.
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20.

21.

22.

23.

Open a memory window to view the global variable “z”’.
Click: View > Memory on the menu bar.

Type ‘&z’ into the address field. Note that you must use the ampersand (meaning
"address of") when using a symbol in a memory window address box. Also note that
Code Composer Studio is case sensitive.

Set the properties format to “Hex — T1 style.” This will give you more viewable data in
the window.

Click OK to close the window property selection screen. The memory window will now
open. You can change the contents of any address in the memory window by double-
clicking on its value. This is useful during debug.

Open the watch window to view the local variables x and .
Click: View > Watch Window on the menu bar.

Click the “Watch Locals” tab and notice that the local variables x and y are already
present. The watch window will always contain the local variables for the code function
currently being executed.

(Note that local variables actually live on the stack. You can also view local variables in
a memory window by setting the address to “SP” after the code function has been
entered).

We can also add global variables to the watch window if desired. Let's add the global
variable “z”.

Click the “Watch 1" tab at the bottom of the watch window. In the empty box in the
"Name" column, type ““z”’. Note that you do not use an ampersand here. The watch
window knows you are specifying a symbol.

Check that the watch window and memory window both report the same value for *“z”’.
Trying changing the value in one window, and notice that the value also changes in the
other window.

Single-stepping the Code

Single-step through main() by using the <F11> key (or you can use the Single
Step button on the vertical toolbar). Check to see if the program is working as
expected. What is the value for ““z”” when you get to the end of the program?

End of Exercise
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DSP/BIOS Configuration Tool

The DSP/BIOS Configuration Tool (often called Config Tool or GUI Tool or GUI) creates and
modifies a system file called the Configuration DataBase (.cdb). If we talk about using .cdb files,
we’re also talking about using the Config Tool.

DSP/BIOS Configuration Tool ile cab)

& example.cdb
2 f@w
bl setige ¢ MEM handles system
+-- 4 MEM - Memory Section Manager . .
BUFfBuFFBrDDoIManaqer memory Conf|gurat|0n
B 3%5 - System Settings H H
& HOOK - Module Hook Manager (bu”ds 'Cmd flle)
= [‘E Instrumentation .
+ LOG - Event Log Manager ’ Conflgures BIOS
+ ST5 - Statistics Object Manager H
- (4 Shedlng scheduling, RTA and
+ {1 CLK - Clock Manager 1
@ PRD - Petiodic Function Manager Oth er B I OS fu n Ct I O n S
¥ '"l, HWI - Hardware Interrupt Service Routine Manager .
+--3F SWI - Software Interrupt Manager ‘ A u t 0 m atl C al Iy
S -
9 TSK - Task Manager . H
+ l,'a IDL - Idle Function Manager h an d | eS . ru n -tl m e
= a Synchronization 1 1
%SEM-SemaphnraManager Su pport Ilbrarles’
Q. e -l Manager Interrupt vectors,
Tx QUE - Atomic Queus Manager
% LCK - Resource Lock Manager SyStem res etl etC .
= @ Input/Cutput
4 RTDw - Real-Time Data Exchange Settings
+- B HST - Host Channel Manager
2§, PIF - Buffered Pipe Manager
:3: SIO - Stream Input and Qukput Manager
+- 4y Device Drivers

The GUI (graphical user interface) simplifies system design by:
e Automatically including the appropriate runtime support libraries
e Automatically handles interrupt vectors and system reset
e Handles system memory configuration (builds .cmd file)
o When a .cdb file is saved, the Config Tool generates 5 additional files:

Filename.cdb Configuration Database
Filenamecfg_c.c C code created by Config Tool
Filenamecfg.s28 ASM code created by Config Tool
Filenamecfg.cmd Linker command file
Filenamecfg.h header file for *cfg_c.c
Filenamecfg.h28 header file for *cfg.s28

When you add a .cdb file to your project, CCS automatically adds the C and assembly
(.s28) files and the linker command file (.cmd) to the project under the Generated Files
folder.
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1. Creating a New Memory Region (Using MEM)

First, to create a specific memory area, open up the .cdb file, right-click on the Memory Section
Manager and select “Insert MEM”. Give this area a unique name and then specify its base and
length. Once created, you can place sections into it (shown in the next step).

Memory Section Manager

Estimated Data Size: 824 Est. Min. Stack Size [MAL g]: 191
s ¢ Mem manager allows
=4 MEM - Memory Section Manager yO U to C reate
b memory area and
» [ place sections
o LOSARAM
» T ¢ To create anew
P Genen | memory area:
Iﬁﬂ EFF?E comment: < add comments here> * ng ht-CI | C k on M EM
Boss-t pa T T— and select Insert
& rock memory
- [ Instrumenl  len 02000
i + Fillin base, length,
+ InpukfOukp ’7 S pace
=
,7
space code -
0K | Cancel | | Help
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2. Placing Sections — MEM Manager Properties

The configuration tool makes it easy to place sections. The predefined compiler sections that
were described earlier each have their own drop-down menu to select one of the memory regions
you defined (in step 1).

Memory Section Manager Properties

General | BIOS Data| BIDS Code Compier Sections | Load Address |

I User cmd File For Non-DSP/BIOS Sections ¢ To p|ace a section
Text Section [ test]: [HosareM =) into a memory area:
Switch Jump Tables [ switch) [HOSaReM  ~| . Right-click on MEM
C Variables Section [.bssl: LOSARAM -~ and select

C Yariables Section [ ebss] LOSARAM - Properties

Datalritialzation Section [ciritl ~ [HOS8RAM | + Select the

C Function Initialization Table (pini) [HOSARAM =] appropriate tab (e.g.
Constank Section  ecors; LOSARAN - Compiler)

Constart Section [ canst): LOSARiAM - + Select the memory
Dt Section (st T for each section

Data Section [ciok LOSARAM -

ar Cancel Apply Help
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3. Running the Linker

Creating the Linker Command File (via .cdb)

When you have finished creating memory regions and allocating sections into these memory
areas (i.e. when you save the .cdb file), the CCS configuration tool creates five files. One of the
files is BIOS’s cfg.cmd file — a linker command file.

Files Created by Config Tool
¢ Config tool generates five

Estimated Data Size: 824 Est. Min. Stack Size [MaAls): 191 different files

=1 (& System ¢ Notice, one of them is the
D Global Settings linker command file
=4 MEM - Memary Section Manager & CMDfileis generated from
A BOOTROM .
o FLasH your MEM settings
L JHOSARAM
@ LOSARAM
A L1SARAM
A MOSARAM
MEMORY{
FLASH:  org = Ox3E8000, len = 0x10000 *cfg_c.c
HOSARAM: org = 0x00A000, len = 0x2000 -
3 cfg.s28
SECTIONS{ e = *cfg.cmd
.text: > FLASH  Leef”
-bss: > MOSARAM L *cfg.h
-}
Z *cfg.h28

This file contains two main parts, MEMORY and SECTIONS. (Though, if you open and
examine it, it’s not quite as nicely laid out as shown above.)
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Running the Linker

The linker’s main purpose is to link together various object files. It combines like-named input
sections from the various object files and places each new output section at specific locations in
memory. In the process, it resolves (provides actual addresses for) all of the symbols described in

your code.

Config Tool Linker Command File

“Build”
app.cdb |
Linker

appcfg.cmd >

\—/—/

.obj files h'|"‘ ----- .

libraries II map
(.lib)

¢ Do not modify appcfg.cmd — your changes will
be overwritten during “Build” (or “Rebuild”)

myApp.out

The linker can create two outputs, the executable (.out) file and a report which describes the
results of linking (.map).

Note: If the graphic above wasn’t clear enough, the linker gets run automatically when you
BUILD or REBUILD your project.
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Lab 2b: DSP/BIOS Configuration Tool
» Objective

Use Code Composer Studio and DSP/BIOS configuration tool to create a configuration database
files (*.cdb). The generated linker command file Labcfg.cmd will be then be used with Lab2.c to
verify its operation. The memory and sections of a “user” linker command file will be deleted,
however, the “user” linker command file will be needed and modified in future labs.

Lab 2b: Configuration Tool

MOSARAM @1 0x00 0000 || oSARAM @ 0x00 8000
eIy (0x400) I (0x1000) I
on-chip @ 0x00 0400 @ 0x00 9000
memory (0x400) (0x1000)

HOSARAM § 0x00 AOOO
F2808 MI

System Description:
* TMS320F2808
* All internal RAM blocks allocated

Placement of Sections:

« .text into RAM Block HOSARAM in code space (PAGE 0)
« .cinit into RAM Block HOSARAM in code space (PAGE 0)
¢ .ebss into RAM Block MOSARAM in data space (PAGE 1)
« .stack into RAM Block M1SARAM in data space (PAGE 1)

System Description
o TMS320F2808

e All internal RAM blocks allocated

Placement of Sections:
e .textinto RAM Block HOSARAM in code space (PAGE 0)

e .cinitinto RAM Block HOSARAM in code space (PAGE 0)
e .ebss into RAM Block MOSARAM in data space (PAGE 1)
e .stack into RAM Block M1SARAM in data space (PAGE 1)

> Procedure

Project Lab2.pjt

1. If Code Composer Studio is not running from the previous lab exercise, double click on
the CCS icon on the desktop. Maximize CCS to fill your screen. Then select Lab2.pjt
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fromthe Project > Recent Project Files list. This will putyou at the
proper starting point for this lab exercise.

2. If needed, verify that the project is open in CCS by left clicking the plus sign (+) to the
left of Project. Then, click on the plus sign next to Lab2.pjt ,as well as the other
plus signs to verify all the previous files have been included.

Remove “rts2800_ml.lib” and “Lab2a.cmd” from the Project

3. Highlight the rts2800_ml . 11b in the project window and right click, then select
“Remove from Project”. The DSP/BIOS Config Tool supplies its own rts library.

4. Remove Lab2a.cmd using the same procedure. We will be using the DSP/BIOS
configuration tool to create a linker command file.

Using the DSP/BIOS Configuration Tool

5. The configuration database files (*.cdb), created by the Config Tool, controls a wide
range of CCS capabilities. In this lab exercise, the CDB file will be used to automatically
create and perform memory management. Create a new CDB file for this lab. On the
menu bar click:

File > New - DSP/BIOS Configuration..

A dialog box appears. The CDB files shown in the aforementioned dialog box are called
“seed” CDB files. CDB files are used to configure many objects specific to the
processor. Select the c28xx.cdb template and click OK. A configuration window will
open.

6. Save the configuration file by selecting:
File > Save As..

and name it Lab.cdb in C:\C28x\Labs\Lab2 then click Save. Close the
configuration window and select YES to save changes to Lab . cdb.

7. Add the configuration file to the project. Click:
Project - Add Files to Project..

Make sure you’re looking in C:\C28x\Labs\Lab2. Change the “files of type” to
view All Files (*.*) and select Lab.cdb. Click OPEN to add the file to the project.

8. In the project window left click the plus sign (+) to the left of DSP/BIOS Config.
Notice that the Lab . cdb file is listed. Then left click the plus sign (+) to the left of
Generated Files. The generated linker command file, Labcfg.cmd, is listed and
has been automatically added with the configuration file.

Create New Memory Sections Using the CDB File

9. Open the Lab. cdb file by double clicking on Lab . cdb. In the configuration window,
left click the plus sign next to System and the plus sign next to MEM.
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10.

11.

12.

13.

14.

By default, the Memory Section Manager has combined the memory space for
LOSARAM and L1SARAM into a single memory block called LOSARAM. It has also
combined MOSARAM and M1SARAM into a single memory block called MOSARAM.
We want to split these memory sections as shown in the slide for this lab exercise.

Right clickon MEM — Memory Section Manager andselect Insert MEM.
Rename the newly added memory section to LLSARAM. Create a second new memory
section, and rename it to MISARAM.

Modify the length and base addresses of each of the memory sections LOSARAM,
L1SARAM, MOSARAM, and M1SARAM to correspond to the memory mapping shown
in the figure at the beginning of this lab. To modify the length and base address of a
memory section, right click on the memory in configuration tool, and select “Properties.”
While modifying the length and base address of each section, make sure the

“create a heap in memory” box is checked ONLY for LOSARAM. Uncheck
this box in the other three memory sections.

Check the memory section properties for HOSARAM and make sure that it corresponds
to the memory mapping shown in the figure at the beginning of this lab. Modify, if
needed.

Check the memory section properties for FLASH and make sure that it has the following
settings — base: 0x3E8000, len: OXFFF6, space: code. Modify, if needed.

Right click on MEM — Memory Section Manager and select Properties.
Selectthe Compiler Sections tab and place the .text, .cinit, and .ebss sections
defined on the lab introduction slide into the appropriate memories via the pull-down
boxes. Similarly, place the .stack section into memory using the BIOS Data tab.
Click OK to save your work.

Set the Stack Size in the CDB File

15.

16.

17.

Recall in the previous lab exercise that the stack size was set using the CCS project Build
Options. When using the DSP/BIOS configuration tool, the stack size is instead specified
in the CDB file. First we need to remove the stack size setting from the project Build
Options.

Click: Project > Build Options.. and select the Linker tab. Delete the entry
for setting the Stack Size to 0x200. Select OK to close the Build Options window.

Right click on MEM — Memory Section Manager and select Properties.
Select the General tab. Notice that the Stack Size has been set to 0x200 by default, so
there is no need to modify this. Click OK to close the window. Close the configuration
window and select YES to save changes to Lab . cdb.

Build and Load the Project

18.

Click the ““Bui 1d”” button and watch the tools run in the build window. The output file
should automatically load. The Program Counter should be pointingto _c_int0O0 in
the Disassembly Window.
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19. Under Debug on the menu bar click “Go Main. This will run through the DSP/BIOS
C-environment initialization routine and stop at main() in Lab2.c.

Run the Code

20. We will verify the operation of the code using the same procedure used in Lab2a. Open
the watch window and add the global variable z.

21. Next, single-step the routine through to the end. Check to see if the program is working
as expected. You should get the same value for ““z’” as in Lab2a.

End of Exercise
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Solutions

Exercise 2a - Solution

MEMORY

{
PAGE_O: /* Program Space */
FLASH: org = 0x3E8000, len = 0x10000
PAGE 1: /* Data Space */

MOSARAM: org = 0x000000, len = 0x400
M1SARAM: org = 0x000400, len = 0x400
LOSARAM: org = 0x008000, len = 0x1000
L1SARAM: org = 0x009000, len = 0x1000
HOSARAM: org = 0x00A000, len = 0x2000

}
SECTIONS
{
-text: > FLASH PAGE O
.ebss: > MOSARAM PAGE 1
.cinit: > FLASH PAGE O
.stack: > M1SARAM PAGE 1
}
Lab 2a: Solution - lab2.cmd
MEMORY
PAGE O: /* Program Space */
HOSARAM: org = OxO00A000, [lIen = 0x2000
PAGE 1: /* Data Space */
MOSARAM: org = 0x000000, len = 0x400
M1SARAM: org = 0x000400, len = 0x400
LOSARAM: org = 0x008000, 1len = 0x1000
L1SARAM: org = 0x009000, 1len = 0x1000
}
SECTIONS
{
-text: > HOSARAM PAGE O
.ebss: > MOSARAM PAGE 1
.cinit: > HOSARAM PAGE O
.stack: > M1SARAM PAGE 1
-reset: > HOSARAM PAGE 0, TYPE = DSECT
}
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Introduction

The purpose of the F280x C-code header files is to simplify the programming of the many
peripherals on the C28x device. Typically, to program a peripheral the programmer needs to
write the appropriate values to the different fields within a control register. In it’s simplest form,
the process consists of writing a hex value (or masking a bit field) to the correct address in
memory. But, since this can be a burdensome and repetitive task, the C-code header files were
created to make this a less complicated task.

The F280x C-code header files are part of a library consisting of C functions, macros, peripheral
structures, and variable definitions. Together, this set of files is known as the ‘header files.’

Registers and the bit-fields are represented by structures. C functions and macros are used to
initialize or modify the structures (registers).

In this module, you will learn how to use the header files and C programs to facilitate
programming the peripherals.

Learning Objectives

Learning Objectives

¢ Understand the usage of the F280x
C-Code Header Files

¢ Be able to program peripheral
registers

¢ Understand how peripherals are
mapped with linker command file
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Traditional and Structure Approach to C Coding

Traditional Approach to C Coding

#define ADCTRL1 (volatile unsigned int *)0x00007100
#define ADCTRL2 (volatile unsigned int *)0x00007101

void main(void)

{
*ADCTRL1 = 0x1234; //write entire register
*ADCTRL2 |= 0x4000; //reset sequencer #1
}
Advantages - Simple, fast and easy to type

- Variable names exactly match register names (easy
to remember)

Disadvantages - Requires individual masks to be generated to
manipulate individual bits

- Cannot easily display bit fields in Watch window
- Will generate less efficient code in many cases

Structure Approach to C Coding

void main(void)

{
AdcRegs.ADCTRL1.all = 0x1234; //write entire register
AdcRegs.ADCTRL2 .bit.RST_SEQ1 = 1; //reset sequencer #1

}

Advantages - Easy to manipulate individual bits.

- Watch window is amazing! (next slide)
- Generates most efficient code (on C28x)

Can be difficult to remember the structure names
(Editor Auto Complete feature to the rescue!)
More to type (again, Editor Auto Complete feature
to the rescue)

Disadvantages
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Is the Structure Approach Efficient?

The structure approach enables efficient compiler use of
DP addressing mode and C28x Atomic operations

C Source Code Generated Assembly Code
// Stop CPU TimerO MOVW DP, #0030
CpuTimerORegs.TCR.bIt.TSS = 1; OR @4, #0x0010
// Load new 32-bit period value MOVL XAR4 , #0x010000
CpuTimerORegs.PRD.all = 0x00010000; MOVL @2, XAR4
// Start CPU TimerO AND @4, #Ooxffef
CpuTimerORegs.TCR.bit.TSS = 0;

- Easy to read the code w/o comments 5 Words, 5 cycles

- Bit mask built-in to structure

(This example could not have been coded any more efficiently with hand assembly)

Compare with the #define Approach

The #define approach relies heavily on less-efficient
pointers for random memory access, and often does not
take advantage of C28x atomic operations

C Source Code Generated Assembly Code
// Stop CPU TimerO gg\é ﬁt.*ég:%OCM)
* =] o 9 X
TIMEROTCR |= 0x0010; oy 200:090004) ., AL
// Load new 32-bit period value MOVL XAR4, #3078
*TIMEROTPR32 = 0x00010000; MOVL XAR5, #65536

MOVL *+XAR4[0], XAR5
// Start CPU TimerO

*TIMEROTCR &= OXFFEF; X‘NJ\S ﬁli’ ; 2;%?004)
MOV *(0:0x0c04), AL
- Hard to read the code w/o comments 9 Words. 9 cycles
)

- User had to determine the bit mask
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Naming Conventions

The header files use a familiar set of naming conventions. They are consistent with the Code
Composer Studio configuration tool, and generated file naming conventions

Structure Naming Conventions

¢ The DSP280x header files define:
+ All of the peripheral structures
+ All of the register names
+ All of the bit field names
+ All of the register addresses

PeripheralName.RegisterName.all /I Access full 16 or 32-bit register
PeripheralName.RegisterName.half.LSW /I Access low 16-bits of 32-bit register
PeripheralName.RegisterName.half.MSW /I Access high 16-bits of 32-bit register

PeripheralName.RegisterName.bit.FieldName // Access specified bit fields of register

Notes: [1] “PeripheralName” are assigned by Tl and found in the DSP280x header files.
They are a combination of capital and small letters (i.e. CouTimerORegs).

[2] “RegisterName” are the same names as used in the data sheet.
They are always in capital letters (i.e. TCR, TIM, TPR,..).

[3] “FieldName” are the same names as used in the data sheet.
They are always in capital letters (i.e. POL, TOG, TSS,..).

Editor Auto Complete to the Rescue!
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Example of Peripheral Structure .h file

Example of Peripheral Structure .h file

Example of Peripheral Structure .h file

Example Adc.h

/* ADC Individual Register Bit Definitions */
struct ADCTRL1_BITS{ //bits description

Uintl6 rsvdl:4; /1 3:0 reserved
Example Adc.c or main.c Uintlé SEQ_CASC:1; // 4 Cascaded sequencer mode
#include “DSP280x_Device.h” Uintl6 SEQ_OVRD:1 // 5 Sequencer override
Uintl6 CONT_RUN:1; // 6 Continuous run
Void InitAdc(void) Uintlé CPS:1; /I'7 ADC core clock prescaler
{ Uintl6 ACQ_PS:4; //'11:8 Acquisition window size
/* Reset the ADC module */ Uintl6 SUSMOD:2; //'13:12 Emulation suspend mode
AdcRegs.ADCTRL1.bit.RESET =1; Uintlé RESET:1; /I 14 ADC reset
uUintl6 rsvd2:1; /I 15 reserved
/* configure the ADC register */ s
AdcRegs.ADCTRL1.all = 0x0710;
5 /* Allow access to the bit fields or entire register */
union ADCTRL1_REG {
Uint16 all;

struct ADCTRL1_BITS bit;
h

/I ADC External References & Function Declarations:

extern volatile struct ADC_REGS AdcRegs;
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Mapping Structures to Memory

The data structures describe the register set in detail. And, each instance of the data type (i.e.,
register set) is unique. Each structure is associated with an address in memory. This is done by
(1) creating a new section name via a DATA_SECTION pragma, and (2) linking the new section
name to a specific memory in the linker command file.

Example Mapping Structure to Memory

¢ DATA_SECTION pragma used to assign a unique linker section
name to the peripheral structure

DSP280x_GlobalVariableDefs.C
#pragma DATA_SECTION(AdcRegs,“ AdcRegsFile");

¢ Linker command file maps the unique peripheral section
name to the physical memory address

DSP280x_Headers_BIOS.CMD
MEMORY

{
PAGEL:
ADC:  origin=0x007100, length=0x000020

=

SECTIONS
{

AdcRegsFile :> ADC PAGE = 1

}

Linker Command File

When using the header files, the user adds the MEMORY regions that correspond to the
CODE_SECTION and DATA_SECTION pragmas found in the .h and global-definitons.c file.

The user can modify their own linker command file, or use the pre-configured linker command
files such as EzDSP_RAM_Ink.cmd or F2808.cmd. These files have the peripheral memory
regions defined and tied to the individual peripheral.
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F280x C-Code Header Files

The C-code header files consists of .h, ¢ source files, linker command files, and other useful
example programs, documentations and add-ins for Code Composer Studio.

DSP280x Header File Package

(http://www.ti.com/c2000, literature # SPRC191)

¢ Simplifies program of peripherals and
other functions

¢ Takes care of register definitions and
addresses

¢ Header file package consists of:

+ \DSP280x_headers\include - .h files

+ \DSP280x_common\src - .c source files

+ \DSP280x_headers\cmd - linker command files
+ \DSP280x_headers\gel - .gel files for CCS

+ \DSP280x_examples - example programs

+ \doc - documentation

¢ Tl has done all of the work for you!

A peripheral is programmed by writing values to a set of registers. Sometimes, individual fields
are written to as bits, or as bytes, or as entire words. Unions are used to overlap memory
(register) so the contents can be accessed in different ways. The header files group all the
registers belonging to a specific peripheral.

A DSP280x_Peripheral.gel GEL file can provide a pull down menu to load peripheral data
structures into a watch window. Code Composer Studio can load a GEL file automatically. To
include fuctions to the standard F2808.gel that is part of Code Composer Studio, add:

GEL_LoadGel(“base_path/gel/DSP280x_Peripheral.gel”)
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.h Definition Files

The DSP280x_Device.h header file is the main include file. By including this file in the .c source
code, all of the peripheral specific .h header files are automatically included. Of course, each
specific .h header file can included individually in an application that do not use all the header
files, or you can comment out the ones you do not need. (Also includes typedef statements).

.h Definition Files

¢ Files found in the
\DSP280x_headers\include directory

& Define structures and bit fields in
peripheral and system registers

¢ DSP280x_Device.h —main include file
will include all other .h files

+ #include  “DSP280x_Device.h”

DSP280x_Device.h DSP280x_DevEmu.h DSP280x_SysCitrl.h
DSP280x_PieCtrl.h DSP280x_Adc.h DSP280x_CpuTimers.h
DSP280x_ECan.h DSP280x_ECap.h DSP280x_EPwm.h
DSP280x_EQep.h DSP280x_Gpio.h DSP280x_l2c.h
DSP280x_Sci.h DSP280x_Spi.h DSP280x_XIntrupt.h
DSP280x_PieVect.h DSP280x_Defaultlsr.h
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Global Variable Definition File

With DSP280x_GlobalVariableDefs.c included in the project all the needed variable definitions
are globally defined.

Global Variable Definition File

DSP280x_GlobalVariableDefs.C
Defines all variables to use .h files

DATA_SECTION pragma used to
define data section for each
peripheral structure

¢ Linker will link each structure to the
physical address of the peripheral in
memory

¢ Add DSP280x_GlobalVvariableDefs.C
to the Code Composer Studio project

* o6 o0
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Peripheral Specific Routines

Peripheral Specific Routines

Peripheral Specific C functions are used to initialize the peripherals. They are used by adding the
appropriate .c file to the project.

¢ Contains peripheral specific

Peripheral Specific Routines

initialization routines and other
support functions

DSP280x_SysCtrl.c DSP280x_Gpio.c
DSP280x_PieCtrl.c DSP280x_I2c.c
DSP280x_Adc.c DSP280x_Sci.c
DSP280x_CpuTimers.c DSP280x_Spi.c
DSP280x_ECan.c DSP280x_ECap.c
DSP280x_EPwm.c DSP280x_EQep.c
DSP280x_PieVect.c DSP280x_Defaultlsr.c

Workshop lab files based on above files with modifications

Other files included in the packet:

¢ Linker.cmd files
+ DSP280x_Headers_BIOS.cmd

+ Contains memory allocation for all

¢ DSP280x_CodeStartBranch.asm
+ Used to redirect code execution when

Other Files in Packet

DSP280x_Headers nonBIOS.cmd

peripheral structure definitions
Included in C-code header file package

booting

.ref _c_int00
.sect "codestart"

LB _c_int00 ;branch to start of boot.asm in RTS library

Workshop lab files based on above files with modifications
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Summary

Summary

Peripheral Register Header Files
Summary

Easier code development
Easy to use
Generates most efficient Code

Increases Effectiveness of CCS
Watch Window

Tl has already done all the work!
+ Download literature # SPRC191 from www.ti.com/c2000

*® 6 0 o

*
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Reset and Interrupts

Introduction

This module describes the interrupt process and explains how the Peripheral Interrupt Expansion
(PIE) works.

Learning Objectives

Learning Objectives

¢ Describe the C28x reset process
and post-reset device state

¢ List the event sequence during an
interrupt

¢ Describe the C28x interrupt
structure
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Module Topics

Module Topics

RESET AN INTEITUPDLS ...t bttt b et bbbt b et e b et bt st e neenee e nas 4-1
T LU T=TN o ot PSS 4-2
=] TSP RRTRTOTRSPUPRURPRN 4-3

T T= A = o To 4 0T U [T PSSR 4-4
INEEITUDES .ot b bt e e e r bR R b e e et r e r e E e 4-6
INEEITUDPT PrOCESSING ...ccueeueeteete sttt ettt sttt e bbbt b e bt e b et et nee e b e nbeebe et e e neenee e eas 4-6
Peripheral Interrupt EXPansion (PIE) .......cooiiiiiiiiiee et 4-8
PIE INErrupt VECIOr TaDIE ... e bbb 4-9
Interrupt RESPONSE AN LALENCY ....cveveiiiiiiieite ettt sttt st et be s be e ne e e e e e besresre e e 4-12
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Reset

Reset

Reset Sources

Watchdog Timer

RS pin active

C28x Core

RS

ToR_Spin

Register Bits Initialized at Reset

Register bits defined by reset

PC

ACC
XARO - XAR7
DP

P

XT

SP

RPC
IFR

IER
DBGIER

0x3F FFCO
0x0000 0000
0x0000 0000
0x0000
0x0000 0000
0x0000 0000
0x0400
0x00 0000
0x0000
0x0000
0x0000

PC loaded with reset vector
Accumulator cleared

Auxiliary Registers

Data Page pointer points to page 0
P register cleared

XT register cleared

Stack Pointer to address 0400
Return Program Counter cleared
no pending interrupts

maskable interrupts disabled
debug interrupts disabled
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Reset

Control Bits Initialized at Reset

Status Register 0 (ST0)

SXM =0 Sign extension off

OVM =0 Overflow mode off N=0 negative flag
TC=0 test/control flag V=0 overflow bit

C=0 carry bit PM =000 set to left-shift-by-1
Z=0 zero flag OVC =00 0000 overflow counter
Status Register 1 (ST1)

INTM =1 Disable all maskable interrupts - global

DBGM =1 Emulation access/events disabled

PAGEO =0 Stack addressing mode enabled/Direct addressing disabled
VMAP =1 Interrupt vectors mapped to PM 0x3F FFCO — 0x3F FFFF
SPA=0 stack pointer even address alignment status bit

LOOP =0 Loop instruction status bit

EALLOW =0 emulation access enable bit
IDLESTAT =0 Idleinstruction status bit
AMODE =0 C27x/C28x addressing mode
OBJMODE =0 C27x object mode
MOM1MAP =1 mapping mode bit

XF=0 XF status bit

ARP =0 ARP points to ARO

Reset - Bootloader

Reset — Bootloader

Reset
OBJMODE=0 AMODE=0
ENPIE=0 VMAP=1

Bootloader sets
OBJMODE =1
AMODE =0
Reset vector fetched

Boot determined by
from boot ROM state of GPIO pins

0x3F FFCO
Execution Bootloading
Entry Point Routines
FLASH SCI-A
MO SARAM SPI-A
OTP 12C
eCAN-A
Parallel load
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Reset

Bootloader Options

GPIO pins
18 29 34

jump to FLASH address Ox3F 7FF6

jump to MO SARAM address 0x00 0000
jump to OTP address 0x3D 7800

bootload code to on-chip memory via SCI-A

bootload external EEPROM to on-chip memory via SPI-A
bootload external EEPROM to on-chip memory via I12C

Call CAN_Boot to load from eCAN-A mailbox 1

bootload code to on-chip memory via GPIO port A (parallel)

o O r P PO O
O r O Ok O

O P O O PO P -

Reset Code Flow - Summary

0x00 0000 | Mo SARAM (1Kw)

0x3D 7800 OTP (1Kw)

OX3E 8000 ey
i FLASH (64Kw)
CH— 0x3F 7FF6

Execution Entry
Point Determined pe==x

0x3F FOO0 | Boot ROM (4Kw)

Boot Code By GPIO Pins
0x3F FB50 I
BROM vector (32w) i
RESET BB Ox3F FFCO | Ox3F FB50 Bootloading
Routines

(SCI-A, SPI-A, 12C,
----------------------- eCAN-A, Parallel Load)
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Interrupts

Interrupts

Interrupt Sources

Internal Sources
TINT2

TINTL C28x CORE
TINTO —————— RS
ePWM, eCAP, PIE il
. y ' Interrupt INT2

Watchdog Expansion) a INT3

External Sources :
[ INT12
XINT1 ——
I INT13
XINT2 —b—r
— INT14
TZx —
—_— |
RS —
—_— |
XNMI_XINT13 —

Interrupt Processing

Maskable Interrupt Processing
Conceptual Core Overview

Core (IFR) (IER) (INTM)

Interrupt  “Latch” “Switch” “Global Switch”

N T L

T2 ——{0]—~"" ‘ | C28x
. . . S | Core
NTTd —— [T

¢ A valid signal on a specific interrupt line causes the latch
to display a“1” in the appropriate bit

¢ If the individual and global switches are turned “on” the
interrupt reaches the core
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Interrupts

Interrupt Flag Register (IFR)

15 14 13 12 11 10 9 8
|RTOSINT|DLOGINT| INT14 | INT13 | INT12 | INT11 | INT10 | INT9 |
7 6 5 4 3 2 1 0
| INT8 | INT7 | INT6 | INTS | INT4 | INT3 | INT2 | INT1 |

Pending: IFRg;=1
Absent : IFRg;=0

[** Manual setting/clearing IFR ***/

extern cregister volatile unsigned int IFR;
IFR |= 0x0008; /lset INT4 in IFR
IFR &= OxFFF7; llclear INT4 in IFR

& Compiler generates atomic instructions (non-interruptible) for setting/clearing IFR
< If interrupt occurs when writing IFR, interrupt has priority

¢ IFR(bit) cleared when interrupt is acknowledged by CPU

# Register cleared on reset

Interrupt Enable Register (IER)

15 14 13 12 11 10 9 8
|RTOSINT|DLOGINT| INT14 | INT13 | INT12 | INT11 | INT10 | INT9 |
7 6 5 4 3 2 1 0
| INTS | INT7 | INT6 | INT5 | INT4 | INT3 | INT2 | INTL |

Enable: Set IER g =1
Disable: Clear IERg;=0

[*** Interrupt Enable Register ***/

extern cregister volatile unsigned int IER;
IER |=0x0008; /lenable INT4 in IER
IER &= OXFFF7; /ldisable INT4 in IER

& Compiler generates atomic instructions (non-interruptible)
for setting/clearing IER

¢ Register cleared on reset
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Interrupts

Interrupt Global Mask Bit

Bit 0
ST1 INTM

¢ [INTM used to globally enable/disable interrupts:
+ Enable: INTM =0
+ Disable: INTM =1 (reset value)

¢ INTM modified from assembly code only:

[*** Global Interrupts ***/
asm(“ CLRC INTM”); /lenable global interrupts
asm(“ SETC INTM”); //disable global interrupts

Peripheral Interrupt Expansion (PIE)

Peripheral Interrupt Expansion - PIE

] PIE module for 96 Interrupts Interrupt Group 1
© PIEIFR1 PIEIER1
o INT1.x interrupt group INTL1 e
A—{1}—+" -
0 INT2.x interrupt group B =
_ INTL2—0}—+ -
INT3.x interrupt group . NTT

INT4.x interrupt group . J
INT5.x interrupt group > >
INT6.x interrupt group
INT7.x interrupt group

INT1.8 .

JgL

28x Core Interrupt logic

INT8.x interrupt group

Peripheral Interrupts 12x8

INT9.x interrupt group INTL - INT12
INT10.x interrupt group | 15 interruptsd & = & = || 28x
=||=| | Z]| |Core

INT11.x interrupt group
INT12.x interrupt group :-

INT13 (TINT1/XINT13)
INT14 (TINT2)
NMI

4-8 TMS320C28x DSP Workshop - Reset and Interrupts



Interrupts

PIE Registers

PIEIFRx register (x=1t0 12)
15-8 7 6 5 4 3 2 1 0

reserved INTX.8| INTX.7| INTX.6| INTX.5[ INTX.4| INTX.3| INTX.2 [ INTX.1

PIEIERX register  (x =1to 12)
15-8 7 6 5 4 3 2 1 0

reserved INTX.8| INTX.7| INTX.6 [ INTX.5| INTX.4| INTX.3| INTX.2| INTX.1

PIE Interrupt Acknowledge Register (PIEACK)
15-12 11 10 9 8 7 6 5

reserved PIEACKXx

4 3 2 1 0

PIECTRL register 15-1 0
PIEVECT ENPIE

#include “DSP280x_Device.h”
PieCtrIRegs.PIEIFR1.bit.INTx4 = 1; //manually set IFR for XINT1 in PIE group 1
PieCtrIRegs.PIEIER3.bit.INTx5 = 1; //enable EPWMS5_INT in PIE group 3
PieCtrIRegs.PIEACK.all = 0x0004;  //acknowledge the PIE group 3
PieCtrIRegs.PIECTRL.bit.ENPIE = 1; //enable the PIE

PIE Interrupt Vector Table

Default Interrupt Vector Table at Reset
Prio| Vector Offset
1 Reset 00 Default Vector Table
5 Int 1 02 Remapped when
6 Int 2 04 ENPIE =1
7| Int3 06 Memor
8 Int 4 08 Y
9| Int5 0A
10 | Int 6 oc
ﬁ Int 7 0E
13 Int 8 10
Int 9
14 12 PIE Vectors
15 Int 10 14 256w
16 Int 11 16 .,
17 Int 12 18
18 Int 13 1A
19 | Int14 ic BROM V. 0x3F FFCO
Dloglnt 1E Rl
4 | Rtosint 20 Ox3F FFFF
2 Emulnt 22
E ml\é” al gg PIE vector generated by config Tool
: Usgr 1-12 28-3E Used to initialize PIE vectors
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Interrupts

PIE Vector Mapping (ENPIE = 1)

Vector name |PIE vector address PIE vector Description
Not used 0x00 0D0O0 Reset Vector Never Fetched Here

—=— INT1 0x00 0D02 INT1 re-mapped below

fF re-mapped below

| INT12 0x00 0D18 INT12 re-mapped below

| INT13 0x00 OD1A XINT1 Interrupt Vector

| INT14 0x00 0D1C Timer2 — RTOS Vector

| Datalog 0x00 0D1D Data logging vector

| N R

| USER11 0x00 OD3E User defined TRAP

— - INT1.1 0x00 0D40 PIEINT1.1 interrupt vector
INT1.8 0x00 OD4E PIEINT1.8 interrupt vector
INT12.1 0x00 ODFO PIEINT12.1 interrupt vector
INT12.8 0x00 ODFE PIEINT12.8 interrupt vector
> PIE vector space - 0x00 0D00 — 256 Word memory in Data space
> RESET and INT1-INT12 vector locations are Re-mapped
» CPU vectors are remapped to 0x00 0DOO0 in Data space

F280x PIE Interrupt Assignment Table

INTx.8 INTX.7 INTx.6 | INTx.5 INTx.4 INTx.3 INTx.2 INTx.1

INT1 WAKEINT TINTO ADCINT XINT2 XINT1 SEQ2INT | SEQILINT

INT2 EPWM6 | EPWM5 | EPWM4 | EPWM3 | EPWM2 | EPWM1
"TZINT | _TZINT | _TZINT | _TZINT | _TZINT | _TZINT

EPWM6 | EPWM5 EPWM4 EPWM3 EPWM2 EPWM1

INT3 CINT CINT CINT CINT CINT CINT
N ECAP4 | ECAP3 | ECAP2 | ECAPL
CINT CINT CINT CINT
EQEP2 | EQEPL
INTS OINT OINT

INT6 [SPITXINTD|SPIRXINTD|SPITXINTCSPIRXINTC|SPITXINTB[SPIRXINTB[SPITXINTA|SPIRXINTA

INT7

INT8 I2CINT2A | I2CINT1A

ECAN1 ECANO ECAN1 ECANO
INT9 _INTB _INTB “INTA “INTA SCITXINTB|SCIRXINTB|SCITXINTA[SCIRXINTA

INT10

INT11

INT12
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Interrupts

Estimated Data Size: 824 Est. Min. Stack Size [Mals). 191

=1~ ™_ PIE INTERRUPTS 4| | Property Value
" PIE_INT1 1 comment defines function for the PIE_INT. ..
W PIE_INT1_2 functign ADCTHT TSR

Hardware Interrupts

PIE_INT1_E properties

M PIE_INTI 3 WAM PIE_INT1_6 Properties

" RIE_INTL 4 ta::;

U PIE_INT1 S z I

. BT i St U

M PIE_IMTL  what's This? Arg

W PIE_INTI Irkert I ’—
WPl Tz L e i

ity : functian:

U PIE_INTZ_ 3

M PIE_INTZ, F’V motikar Mothing hd
" PIE_INTZ.

U PIE_INTZ_ wsert Ob 2

" PIE_INTZ_

W opiE mrz. D L r j
U PIE_INT3. G ,—_|
Wy peration sdd[*a

:“:’ F IS, ® Propertyvalue view
I PIE_INT3.

U NEN  Froperties

M PIE_INT3, ak Cancel | 5ppl I Help
" PIE_INT3 2 LIe AR

W PIE_INT3_7

A Pe
i, v

Device Vector Mapping - Summary

RESET
<O0x3F FFCO0>

Reset Vector <0x3F FB50> = Boot Code
Flash Entry Point <Ox3F 7FF6 >=LB _c_int00
User Code Start < _c_int00 >

_c_int00:

CALL main(Q)

Initialization ()

}

main()
{ initialization(); Enable the PIEIER

EALLOW
Load PIE Vectors PIE Vector Table

256 Word RAM

Enable PIECTRL
Enable Core IER 0x00 0D0O0 — ODFF
Enable INTM

EDIS
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Interrupts

Interrupt Response and Latency

Interrupt Response - Hardware Sequence

CPU Action Description

Registers — stack 14 Register words auto saved

0 - IFR (bit) Clear corresponding IFR bit

0 - IER (bit) Clear corresponding IER bit

1— INTM/DBGM Disable global ints/debug events
Vector - PC Loads PC with int vector address
Clear other status bits | Clear LOOP, EALLOW, IDLESTAT

Note: some actions occur simultaneously, none are interruptible

T STO

AH AL

PH PL

AR1 ARO

DP ST1
DBSTAT| IER
PC(msw)| PC(lsw)

Interrupt Latency

e Latency
—— ext. Internal
interrupt interrupt Assumes ISR in
occurs ! occurs / internal RAM
here here
' >

I 4 cycles
e @ ® ©® ® ® |

Sync ext.  Recognition Getvector F1/F2/D1of Save D2/R1/R2 of R

signal delay (3), SP and place ISR return ISR g‘fetﬁfﬁgﬁn
alignment (1), inPC instruction  address instruction  gn next
. (ext. interrupt (3reg. (3 reg. pairs I
interrupt placed in pairs saved) i
only) pipeline saved)

Above is for PIE enabled or disabled

¢ Minimum latency (to when real work occurs in the ISR):
» Internal interrupts: 14 cycles

» External interrupts: 16 cycles

& Maximum latency: Depends on wait states, INTM, etc.
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System Initialization

Introduction

This module discusses the operation of the OSC/PLL-based clock module and watchdog timer.
Also, various low power modes, general-purpose digital 1/O ports, and the EALLOW protected
registers will be covered.

Learning Objectives

Learning Objectives

¢ OSC/PLL Clock Module

¢ Watchdog Timer

¢ Low Power Modes

¢ General Purpose Digital I/O

¢ EALLOW Protected Registers
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Module Topics

Module Topics

SYSEEM TNITIAIZATION.......ceieiiie bbb bbbt e e e e aas 5-1
T LU T=TN o ot PSS 5-2
OSCIlAtOr/PLL CIOCK MOTUIE ...ttt bbb 5-3
WALCRAOG TIMET ...ttt bbb bbbttt bbb b b ns 5-5
LOW POWEE IMOOES. ...ttt bbbt bbb ettt et 5-9
General-Purpose DIgItal /O ...t ettt se b nbenne 5-11
EALLOW ProteCted REGISIEIS. ... e iieeieieie ittt sttt sttt sb e bbbttt e s b e b e e 5-15
Lab 5: System INITIAIIZALION ......c.coviiiiie e e b 5-16
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Oscillator/PLL Clock Module

Oscillator/PLL Clock Module
C280x Oscillator / PLL Clock Module

SysCtrIRegs.PLLCR.bit.DIV (lab file: SysCtrl.c)

Watchdog
X1/ XCLKIN
Module CLKIN | c280x
8 Core
@ o] OSCCLK 2
-
= (PLL bypass) | . s SYSCLKOUT
X S or
X2 PLL VCOCLK 12 2
PLLCR.bitDIV ____q e : [Hspcp | [Lospce|
default = 0000b s i
PLLSTS.bit. CLKINDIV HSPCLK LSPCLK
default = /2 (ADC) (SCl/sPI)
(All other peripherals
DIV Clock Freguency (CLKIN) clocked by SYSCLKOUT)

0000 |OSCCLK/CLKINDIV  (PLL bypass)
0001 |OSCCLK x 1/CLKINDIV

0010 OSCCLK x 2 / CLKINDIV Input Clock Fail Detection
0011 |OSCCLK x 3/CLKINDIV PLL will issue a “limp mode”
0100 OSCCLK x 4/ CLKINDIV clock (1-4 MHz) if input clock
0101 OSCCLK x 5/ CLKINDIV is removed after clock has
0110 [OSCCLK x 6/CLKINDIV been present initially

0111 OSCCLK x 7/ CLKINDIV
1000 OSCCLK x 8/ CLKINDIV
1001 OSCCLK x 9/ CLKINDIV
1010 OSCCLK x 10/ CLKINDIV

The OSC/PLL clock module provides all the necessary clocking signals for C28x devices. The
PLL has a 4-bit ratio control to select different CPU clock rates. Two modes of operation are
supported — crystal operation, and external clock source operation. Crystal operation allows the
use of an external crystal/resonator to provide the time base to the device. External clock source
operation allows the internal oscillator to be bypassed, and the device clocks are generated from
an external clock source input on the X1/CLKIN pin. The watchdog receives a clock signal from
OSCCLK. The C28x core provides a SYSCLKOUT clock signal. This signal is prescaled to
provide a clock source for some of the on-chip peripherals through the high-speed and low-speed
peripheral clock prescalers. Other peripherals are clocked by SYSCLKOUT and use their own
clock prescalers for operation.
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Oscillator/PLL Clock Module

Peripheral Clock Control Registers

(lab file: SysCtrl.c)

SysCtrIRegs.PCLKCRO.bit.name
15 14 13-12 11 10 9 8
ECANB | ECANA [ . | SCIB SCIA SPIB SPIA
ENCLK | ENCLK ENCLK | ENCLK | ENCLK | ENCLK
7 6 5 4 3 2 1-0

SPID SPIC I2CA ADC | TBCLK
ENCLK | ENCLK | '€S€ved | ENClk | ENCLK | SYNC

reserved

SysCtrIRegs.PCLKCR1.bit.name
15 14 13-12 11 10 9 8

EQEP2 EQEP1 FEsERE ECAP4 | ECAP3 | ECAP2 | ECAP1
ENCLK | ENCLK ENCLK | ENCLK | ENCLK | ENCLK

7-6 5 4 3 2 1 0

reserved | EPWM6 | EPWMS | EPWM4 | EPWM3 | EPWM2 | EPWM1
ENCLK | ENCLK | ENCLK | ENCLK | ENCLK | ENCLK
N %
Module Enable Clock Bit
0 =disable
1 =enable

The peripheral clock control register allows individual peripheral clock signals to be enabled or
disabled. If a peripheral is not being used, its clock signal could be disabled, thus reducing power
consumption.

High / Low — Speed Peripheral Clock
Pl‘eSC8.|eI’ RegIStel‘S (lab file: SysCtrl.c)

SysCtrIRegs.HISPCP.all

15-3 2-0
reserved HSPCLK
ADC
SysCtrIRegs.LOSPCP.all
15-3 2-0
reserved LSPCLK
SCI/ SPI
H/ILSPCLK Peripheral Clock Frequency
000 SYSCLKOUT /1
001 SYSCLKOQUT / 2 (default HISPCP) NOTE:
010 SYSCLKOUT / 4 (default LOSPCP) :
011 SYSCLKOUT / 6 All Other
100 SYSCLKOUT /8 (thlarlpkh%raBls
101 SYSCLKOUT /10 ocked by
110 SYSCLKOUT/ 12 SYSCLKOUT
111 SYSCLKOUT / 14
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Watchdog Timer

Watchdog Timer

Watchdog Timer

¢ Resets the C28x if the CPU crashes
+ Watchdog counter runs independent of CPU

+ If counter overflows, reset or interrupt is
triggered

+ CPU must write correct data key sequence to
reset the counter before overflow

¢ Watchdog must be serviced (or disabled)
within ~6.55ms after reset (20 MHz
OSCCLK for 100 MHz device)

¢ This translates into 131,072 instructions!

The watchdog timer provides a safeguard against CPU crashes by automatically initiating a reset
if it is not serviced by the CPU at regular intervals. In motor control applications, this helps
protect the motor and drive electronics when control is lost due to a CPU lockup. Any CPU reset
will revert the PWM outputs to a high-impedance state, which should turn off the power
converters in a properly designed system.

The watchdog timer is running immediately after system power-up/reset, and must be dealt with
by software soon after. Specifically, you have 6.55 ms (for a 100 MHz device) after any reset
before a watchdog initiated reset will occur. This translates into 131,072 instruction cycles,
which is a seemingly tremendous amount! Indeed, this is plenty of time to get the watchdog
configured as desired and serviced. A failure of your software to properly handle the watchdog
after reset could cause an endless cycle of watchdog initiated resets to occur.
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Watchdog Timer

Watchdog Timer Module ga fie: sysctric)
Jo4 111
0SCCLK 6 - Bit 32 10 _© O—— WDOVERRIDE
O
Free - /16 101 o
/512 Running | /8 100 ~ (wocr .2-0]
Counter 721—81130 © i
(Cwocr.6 ]
551°,
l 000~
System _| WDFLAG
Reset ™ T 8 - Bit Watchdog WDCR . 7
Counter O“Sé(l:%/de :
CLR
WDRST
Output
Pulse |,
_,_ WDINT
Detector | Good Key WDENINT
1 Bad WDCR Key
Watchdog
Register

Watchdog Period Selection

WDPS FRC WD timeout period
Bits rollover @ 20 MHz OSCCLK
00x: 1 6.55 ms
010: 2 13.11 ms
011: 4 26.21 ms
100: 8 52.43 ms
101: 16 104.86 ms
110: 32 209.72 ms
111: 64 419.43 ms

¢ WDPS set to 000 after any CPU reset

¢ Watchdog starts counting immediately after reset
is released

(for OSCCLK = 20 MHz = (1/20 MHz) * (512*256) = 6.55 ms)
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Watchdog Timer

Watchdog Timer Control Register

SysCtrIRegs.WDCR (lab file: SysCtrl.c)

WD Flag Bit
Gets set when the WD causes areset
« Writing a 1 clears this bit
« Writing a 0 has no effect

15-8 7 6 5-3 2-0
reserved | WDFLAG | WDDIS WDCHK WDPS
Logic Check Bits WD Prescale

Write as 101 or reset Selection Bits

Watchdog Disable Bit immediately triggered
Write 1 to disable
(Functions only if WD OVERRIDE
bit in SCSR is equal to 1)

Resettin%the Watchdog

SysCtrIRegs.WDKEY (lab file: SysCtrl.c)

15-8 7-0

reserved WDKEY

¢ Allowable write values:
55h - counter enabled for reset on next AAh write

AAh - counter set to zero if reset enabled
¢ Writing any other value has no effect

¢ Watchdog should not be serviced solely in
an ISR

« If main code crashes, but interrupt continues to
execute, the watchdog will not catch the crash

« Could put the 55h WDKEY in the main code, and
the AAh WDKEY in an ISR; this catches main
code crashes and also ISR crashes
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Watchdog Timer

WDKEY Write Results

Sequential Value Written
Step to WDKEY  Result

1 AAh No action

2 AAh No action

3 55h WD counter enabled for reset on next AAh write
4 55h WD counter enabled for reset on next AAh write
5 55h WD counter enabled for reset on next AAh write
6 AAh WD counter is reset

7 AAh No action

8 55h WD counter enabled for reset on next AAh write
9 AAh WD counter is reset

10 55h WD counter enabled for reset on next AAh write
11 23h No effect

System Control and Status Register
SysCtrIRegs.SCSR (lab file: SysCtrl.c)

WD Override (protect bit)

Protects WD from being disabled

0 = WDDIS bit in WDCR has no effect (WD cannot be disabled)
1 =WDDIS bit in WDCR can disable the watchdog

* This bit is a clear-only bit (write 1 to clear)

» The reset default of this bitisa 1 \

15-3 2 1 0
reserved WDINTS |WDENINT |[WDOVERRIDE

WD Interrupt Status WD Enable Interrupt
(read only)

0 =WD generates a DSP reset
0 = active 1 =WD generates a WDINT interrupt
1 =not active
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Low Power Modes

Low Power Modes

Low Power Modes

Low Power |CPU Logic | Peripheral | Watchdog | PLL/
Mode Clock Logic Clock Clock OosC
Normal Run on on on on
IDLE off on on on
STANDBY off off on on
HALT off off off off

Low Power Mode Control Register O
SysCtrlIRegs.LPMCRO (lab file: SysCitrl.c)

Watchdog Interrupt

wake device from 000000 = 2 OSCCLKs

Qualify before waking

STANDBY 000001 = 3 OSCCLKs
. from STANDBY mode : : :
0 = disable (default) : . .
1=-enable \111111 =65 OSCCLKS (default)
15 14-8 7-2 1-0
WDINTE reserved QUALSTDBY LPMO

Low Power Mode Selection
00 = Idle (default)
01 = Standby
1x = Halt

Low Power Mode Entering

1. Set LPM bits

2. Enable desired exit interrupt(s)

3. Execute IDLE instruction

4. The Power down sequence of the hardware
depends on LP mode
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Low Power Modes

GPIO Low Power Wakeup Select

SysCtrIRegs.GPIOLPSEL

31 30 29 28 27 26 25 24
GPIO31|GPIO30|GPIO29|GPI028 |GPIO027 | GPIO26 | GPIO25| GP1024

23 22 21 20 19 18 17 16
GP1023|GP1022|GPIO21|GPIO020|GPIO19 |GPIO18|GPIO17|GPIO16

15 14 13 12 11 10 9 8
GPIO15|GPI014|GPIO13|GPIO12 |GPIO11|GPIO10| GPIO9 | GPIO8

7 6 5 4 3 2 1 0
GPIO7 | GPIO6 | GPIO5 | GPIO4 | GPIO3 | GPIO2 | GPIO1 | GPIOO

Wake device from
HALT and STANDBY mode
(GPIO Port A)

0 = disable (default)
1 =enable

Low Power Mode Exit

Exit
Interrupt | RESET Watchdog Any GPIO
or Interrupt Enabled | Port A
Low Power XNMI Interrupt | Signal
Mode
IDLE yes yes yes yes
STANDBY yes yes no yes
HALT yes no no yes
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General-Purpose Digital 1/0O

C280x GPIO Register Structure ga fie: cpio.c)

GPIO Pczrt A Muxl) o
«—> Register (GPAMUX1) |¢=—bp
[GPIO 0 to 15] . GPIO Port A i
Direction Register . |0
(GPADIR) g
_ GPIO Port A Mux2 [GPIO 0 to 31] =l
= |e=—b{ Register (GPAMUX2) (¢—p >
z GPIO 16 to 31]
53 —
= GPIO P(Ert B Muxl) o
o [e=—p Register (GPBMUX1) |¢=—b
GPIO 32 to 34] . GPIO Port B L
Direction Register . |0
(GPBDIR) > g
GPIO Port B Mux2 [GPIO 32 to 34] =]
«—p Register (GPBMUX2) (¢=—p w
[reserved]

F2808 GPIO Pin Assighment @ors)
GPAMUX1 (lab file: Gpio.c)
Bits | 0, O (default) 0,1 1,0 1,1
1-0 | GPIOO EPWM1A | reserved reserved
3-2 | GPIO1 EPWM1B | SPISIMO reserved
5-4 | GPIO2 EPWM2A | reserved reserved @o
7-6 | GPIO3 EPWM2B | SPISOMID reserved >,3‘2§
9-8 | GP104 EPWM3A | reserved reserved %5'
11-10 | GPIO5 EPWM3B | SPICLKD ECAP1 8F
13-12 | GPIO6 EPWM4A | EPWMSYNCI EPWMSYNCO
15-14 | GPIO7 EPWM4B | SPISTED ECAP2
17-16 | GPIO8 EPWM5A | CANTXB ADCSOCAO
19-18 | GPIO9 EPWM5B | SCITXB ECAP3
21-20 | GPIO10 EPWMG6A | CANRXB ADCSOCBO &CD@
23-22 | GP1011 EPWM6B | SCIRXB ECAP4 >,32%
25-24 | GPIO12 TZ1 CANTXB SPISIMOB %5!
27-26 | GPIO13 TZ2 CANRXB SPISOMIB 2
29-28 | GPIO14 TZ3 SCITXB SPICLKB
31-30 | GPIO15 TZ4 SCIRXB SPISTEB
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F2808 GPIO Pin Assignment o3

GPAMUX2 (lab file: Gpio.c)

Bits | 0, O (default) 0,1 1,0 1,1
1-0 | GPIO16 SPISIMOA | CANTXB TZ5 )
3-2 | GPIO17 SPISOMIA | CANRXB TZ6
5-4 | GPIO18 SPICLKA SCITXB reserved 'go
7-6 | GPIO19 SPISTEA SCIRXB reserved >,3_>£
9-8 | GPI020 EQEP1A SPISIMOC CANTXB %5!
11-10 | GPIO21 EQEP1B SPISOMIC CANRXB S
13-12 | GPIO22 EQEP1S SPICLKC SCITXB
15-14 | GPIO23 EQEP1I SPISTEC SCIRXB
17-16 | GPIO24 ECAP1 EQEP2A SPISIMOB )
19-18 | GPIO25 ECAP2 EQEP2B SPISOMIB
21-20 | GP1026 ECAP3 EQEP2I SPICLKB go
23-22 | GPIO27 ECAP4 EQEP2S SPISTEB >,32(;%
25-24 | GPIO28 SCIRXDA reserved TZ5 %;_u'
27-26 | GPI029 | SCITXDA | reserved TZ6 s
29-28 | GPIO30 CANRXA reserved reserved
31-30 | GPIO31 CANTXA reserved reserved

F2808 GPIO Pin Assignment @ots)

GPBMUX1 (lab file: Gpio.c)

Bits | 0, O default) 0,1 1,0 1,1

1-0 | GPIO32 SDAA EPWMSYNCI ADCSOCAO

3-2 | GPIO33 SCLA EPWMSYNCO |ADCSOCBO

5-4 | GPIO34 reserved | reserved reserved

0addivnod
74L09d9

TMS320C28x DSP Workshop - System Initialization



General-Purpose Digital I/O

GPXSET -
GPxCLEAR I/0 DIR Bit
GPXTOGGLE 0 = Input

1 = Output

C280x GPIO Functional Block Diagram

Peripheral
1

Peripheral Peripheral
2 3

GPxMUX1/2

7
GPBCTRL [ reserved [ QUALPRDO |

00h no qualification (SYNC to SYSCLKOUT)
01h QUALPRD = SYSCLKOUT/2
02h QUALPRD = SYSCLKOUT/4

FFh QUALPRD = SYSCLKOUT/510

GPxDAT
out ,\J o8 MUX Control Bit
/0 DAT | 00 Ny 1 g ggrligh eral
Bit (R/W) | |n | 10 = Peripheral
11 = Peripheral
| P
GPxPUD Internal
15-8 7-0 Pull-U
[ QUALPRD1 | QUALPRDO | _/._ 0 = enable P
GPACTRL 31-24 23-16 ) Ejd_efa;fn GPIO 12-31)
| QU'3°*1'-P§D3 | QUA'-PORDZ | l_(dlsefaau?t GPIO 0-11)

QO Pin

GPAQSEL1/ GPAQSEL2 / GPBQSEL1/ GPBQSEL2
00 = SYNC to SYSCLKOUT

01 = qual to 3 samples —time specified in GPXxCTRL
10 = qual to 6 samples — time specified in GPxCTRL
11 = no sync or qual (for peripheral; GPIO same as 00)

C280x GPIO Control Registers
GpioCtrIRegs.name (lab file: Gpio.c)

[Name T Descripion 1]
GPACTRL GPIO A Control Register [GPIO 0 — 31]
GPAQSEL1 GPIO A Qualifier Select 1 Register [GPIO 0 — 15]
GPAQSEL2 GPIO A Qualifier Select 2 Register [GPIO 16 — 31]
GPAMUX1 GPIO A Mux1 Register [GPIO 0 — 15]

GPAMUX2 GPIO A Mux2 Register [GPIO 16 — 31]

GPADIR GPIO A Direction Register [GPIO 0 — 31]
GPAPUD GPIO A Pull-Up Disable Register [GPIO 0 — 31]
GPBCTRL GPIO B Control Register [GPIO 32 — 34]
GPBQSEL1 GPIO B Qualifier Select 1 Register [GPIO 32 — 34]
GPBQSEL2 GPIO B Qualifier Select 2 Register [reserved]
GPBMUX1 GPIO B Mux1 Register [GPIO 32 — 34]

GPBMUX2 GPIO B Mux2 Register [reserved]

GPBDIR GPIO B Direction Register [GPIO 32 — 34]
GPBPUD GPIO B Pull-Up Disable Register [GPIO 32 — 34]
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C280x GPIO Data Registers

GpioDataRegs.name (lab file: Gpio.c)

GPADAT GPIO A Data Register [GPIO 0 — 31]
GPASET GPIO A Data Set Register [GPIO 0 — 31]
GPACLEAR GPIO A Data Clear Register [GPIO 0 — 31]
GPATOGGLE GPIO A Data Toggle [GPIO 0 — 31]
GPBDAT GPIO B Data Register [GPIO 32 — 34]
GPBSET GPIO B Data Set Register [GPIO 32 — 34]
GPBCLEAR GPIO B Data Clear Register [GPIO 32 — 34]
GPBTOGGLE GPIO B Data Toggle [GPIO 32 — 34]

External Interrupts

& There are 3 external interrupt signals: XINT1, XINT2, XNMI

¢ Any GPIO port A pin (GPIO0 — GPIO31) can be mapped to any
of fhese three interrupt signals

GpiolntRegs.name

Name Description

GPIOXINT1SEL | selects GPIOO — GPIO31 pin as XINT1 source
GPIOXINT2SEL | selects GPIOO — GPIO31 pin as XINT2 source
GPIOXNMISEL selects GPIOO0 — GPIO31 pin as XNMI source

XIntruptRegs.name

Name Description

XINT1CR enable / disable interrupt, polarity
XINT2CR enable / disable interrupt, polarity
XNMICR enable / disable interrupt, polarity

For each external interruEt, there is also a 16-bit counter (XINTLCTR, XINT2CTR, and XNMICTR)
that is reset to 00000 whenever an interrupt edge is detected. These counters can be used to
accurately time stamp an occurrence of the interrupt.

¢ Note that the eCAP pins can also be used as external
mtgr)r(tlj\ﬁ\t/lsl, and are completely independent on XINT1, XINTZ2,
an
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EALLOW Protected Registers

EALLOW Protected Registers

EALLOW Protected Registers
Register Name Address Range size (x16)
Device Emulation 0x00 0880 — 0x00 09FF 384
FLASH (also protected by cSM) | 0x00 OA80 — 0x00 OADF 96
PFO Code Security Module 0x00 OAEOQ — 0x00 OAEF 16
PIE Vector Table 0x00 0D0OO0 — 0x00 ODFF 256
eCANA 0x00 6000 — 0x00 60FF 256 (128x32)
eCANB 0x00 6200 — 0x00 62FF 256 (128x32)
PF1 ePWM1 - 6 0x00 6800 — 0x00 697F 384 (32x32)
GPIO Control 0x00 6F80 — 0x00 6FBF 128 (64x32)
GPIO Interrupt 0x00 6FEO — 0x00 6FFF 32 (16x32)
PF2 System Control 0x00 7010 — 0x00 702F 32
while(1) /I dummy loop - wait for an interrupt
{
asm(" EALLOW"); /I enable EALLOW protected register access
SysCtrIRegs.WDKEY=0x55; // watchdog enabled for reset on next OxAA write
asm(" EDIS"); /I disable EALLOW protected register access
}
Note: “SysCtrIRegs.WDKEY=0xAA" is located in an interrupt service routine

Lab 5: Procedure - System Initialization

¢ LABS files have been provided as a starting point
¢ Modify LABS files to:

Part 1
« Disable the watchdog — clear WD flag, disable watchdog, WD
prescale =1

« Setup the clock module — PLL = x10/2, HISPCP =/1, LOSPCP = /4,
low-power modes to default values, enable all module clocks

« Setup system control register — DO NOT clear WD OVERRIDE bit,
WD generate a DSP reset

« Setup shared /O pins — set all GPIO pins to GPIO function (e.g. a
“00” setting for GPIO function, and a “01”, 10", or “11” setting for a
peripheral function)

Part 2
« Initialize peripheral interrupt expansion (PIE) vectors

¢ Build, debug, and test your code using Code
Composer Studio

TMS320C28x DSP Workshop - System Initialization 5-15



Lab 5: System Initialization

Lab 5: System Initialization
» Objective

The objective of this lab is to perform the processor system initialization by applying the
techniques discussed in module 5. Additionally, the peripheral interrupt expansion (PIE) vectors
will be initialized and tested using the information discussed in the previous module. This
initialization process will be used again in the module 6 analog-to-digital converter lab, and the
module 7 control peripherals lab. The system initialization for this lab will consist of the
following:

e Disable the watchdog — clear WD flag, disable watchdog, WD prescale = 1

e  Setup the clock module — PLL = x10/2, HISPCP = /1, LOSPCP = /4, low-power modes to
default values, enable all module clocks

e  Setup system control register - DO NOT clear WD OVERRIDE bit, WD generate a DSP
reset

e Setup shared /O pins — set all GPIO pins to GPIO function (e.g. a "00" setting for GPIO
function, and a “01”, “10”, or “11” setting for a peripheral function.)

The first part of the lab exercise will setup the system initialization and test the watchdog
operation by having the watchdog cause a reset. In the second part of the lab exercise the PIE
vectors will be added and tested by using the watchdog to generate an interrupt. This lab will
make use of the DSP280x C-code header files to simplify the programming of the device, as well
as take care of the register definitions and addresses. Please review these files, and make use of
them in the future, as needed.

» Procedure
Create Project File
Note: LAB 5 files have been provided as a starting point for the lab and need to be
completed. DO NOT copy files from a previous lab.
1. Create a new project called Lab5.pjtin C:\C28x\Labs\Lab5 and add the
following files to it:
Main_5.c DSP280x_GlobalVariableDefs.c
Lab.cdb DSP280x_Headers_B10S.cmd
User_ 5 6_7.cmd CodeStartBranch.asm
SysCtrl.c Gpio.c
Note that include files, such as DSP280x_Device._.h and Lab_h, are automatically
added at project build time. (Also, the generated linker command file, Labcfg.cmd, is
automatically added with the configuration file).
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Project Build Options

2. We need to setup the search path to include the peripheral register header files. Click:
Project - Build Options..

Select the Compiler tab. In the Preprocessor Category, find the Include Search
Path (-1) box and enter:

. -\DSP280x_headers\include

This is the path for the header files. Then select OK to save the Build Options.

Modify Memory Configuration

3. Open and inspect the user linker command file User_5 6_7.cmd. Notice that the
section ““codestart” is being linked to a memory block named BEGIN_MO. The
codestart section contains code that branches to the code entry point of the project. The
bootloader must branch to the codestart section at the end of the boot process. Recall that
the "Boot to MO" bootloader mode branches to address 0x000000 upon bootloader
completion.

Modify the configuration file 1ab . cdb to create a new memory block named
BEGIN_MO: base = 0x000000, length = 0x0002, space = code. Uncheck the “create
a heap In memory” box. You will also need to modify the existing memory block
MOSARAM to avoid any overlaps with this new memory block.

Setup System Initialization

4. Modify SysCtrl . c to implement the system initialization as described in the objective
for this lab.

5. Open and inspect Gpio.c. Notice that the shared I/O pins have been set to the GPIO
function. (Note: In Main_5.c do not edit the “main loop” section. This section will be
used to test the watchdog operation.) Save your work.

Build and Load

6. Clickthe ““Build’ button and watch the tools run in the build window. The output
file should automatically load.

7. Under Debug on the menu bar click “Reset CPU™.

8. Under Debug on the menu bar click “Go Main”. You should now be at the start of
Main().
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Run the Code — Watchdog Reset

9. Place the cursor on the first line of code in main() and set a breakpoint by right
clicking the mouse key and select Toggle Software Breakpoint. Notice that
line is highlighted with a red dot indicating that the breakpoint has been set.

10. Single-step your code into the “main loop” section and watch the lines of code
execute. If you don’t want to see each line execute, place the cursor in the “main
loop™ section (on the asm(** NOP’”); instruction line) and right click the mouse key
and select Run To Cursor. This is the same as setting a breakpoint on the selected
line, running to that breakpoint, and then removing the breakpoint.

11. Run your code for a few seconds by using the <F5> key, or using the Run button on the
vertical toolbar, or using Debug - Run onthe menu bar. After a few seconds halt
your code by using Shift <F5>, or the Halt button on the vertical toolbar. Where did your
code stop? Are the results as expected? If things went as expected, your code should be
in the “main loop™.

12. Modify the InitSysCtr1() function to enable the watchdog (WDCR). This will
enable the watchdog to function and cause a reset. Save the file and click the “Bui 1d”
button. Then reset the DSP by clicking on Debug - Reset CPU. Under Debug on
the menu bar click ““Go Main”.

13. Single-step your code off of the breakpoint.

14. Run your code. Where did your code stop? Are the results as expected? If things went
as expected, your code should stop at the breakpoint.

Setup PIE Vector for Watchdog Interrupt

The first part of this lab exercise used the watchdog to generate a CPU reset. This was tested
using a breakpoint set at the beginning of main(). Next, we are going to use the watchdog
to generate an interrupt. This part will demonstrate the interrupt concepts learned in the
previous module.

15. Add the following files to the project:

PieCtrl 56 7 8 9.c

Defaultlsr 5 6 7.c

Check your files list to make sure the files are there.

16. In Main_5.c, add code to call the InitPieCtrl() function. There are no passed
parameters or return values, so the call code is simply:

InitPieCtri();

17. Using the “PIE Interrupt Assignment Table” shown in the previous module find the
location for the watchdog interrupt, “WAKEINT””.
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18. Modify main() to do the following:

enable the "WAKEINT" interrupt in the PIE (Hint: use the PieCtrlIRegs structure)
enable core INT1 (IER register)
enable global interrupts (INTM bit)

19. In SysCtr1 . c modify the system control and status register (SCSR) to cause the
watchdog to generate a WAKEINT rather than a reset.

20. Open and inspect Defaultlsr_5 6 7.c. This file contains interrupt service
routines. The ISR for WAKEINT has been trapped by an emulation breakpoint contained
in an inline assembly statement using “ESTOP0”. This gives the same results as placing
a breakpoint in the ISR. We will run the lab exercise as before, except this time the
watchdog will generate an interrupt. If the registers have been configured properly, the
code will be trapped in the ISR.

21. Modify the configuration file Lab . cdb to setup the PIE vector for the watchdog
interrupt. Click on the plus sign (+) to the left of Schedul ing and again on the plus
sign (+) to the left of HV1 — Hardware Interrupt Service Routine
Manager. Click the plus sign (+) to the left of PIE INTERRUPTS. Locate the
interrupt location for the watchdog. Right click, select Properties, and type
_WAKEINT_ISR (with a leading underscore) in the function field. Click OK and save
all updates.

Build and Load

22. Save all changes to the files and click the ““Bui 1d” button. Then reset the DSP, and
then “Go Main™.

Run the Code — Watchdog Interrupt

23. Place the cursor in the “main loop” section, right click the mouse key and select
Run To Cursor.

24. Run your code. Where did your code stop? Are the results as expected? If things went
as expected, your code should stop at the “ESTOPO” instruction in the WAKEINT ISR.

End of Exercise

Note: By default, the watchdog timer is enabled out of reset. Code in the file
CodeStartBranch.asm has been configured to disable the watchdog. This can be
important for large C code projects (ask your instructor if this has not already been
explained). During this lab exercise, the watchdog was actually re-enabled (or disabled
again) in the file SysCtrl _c.
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Analog-to-Digital Converter

Introduction

This module explains the operation of the analog-to-digital converter. The system consists of a
12-bit analog-to-digital converter with 16 analog input channels. The analog input channels have
a range from 0 to 3 volts. Two input analog multiplexers are used, each supporting 8 analog input
channels. Each multiplexer has its own dedicated sample and hold circuit. Therefore, sequential,
as well as simultaneous sampling is supported. Also, the ADC system features programmable
auto sequence conversions with 16 results registers. Start of conversion (SOC) can be performed
by an external trigger, software, or an ePWM event.

Learning Objectives

Learning Objectives

¢ Understand the operation of
Analog-to-Digital converter

¢ Show how to use the Analog-to-
Digital converter to perform data
acquisition
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Module Topics
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Analog-to-Digital Converter

ADC Module Block Diagram (cascaded mode)

Result MUX

Result
Select

—>{ RESULTO
RESULT1
RESULT?2

RESULT15

(GPIO/XINT2_ADCSOC)

Analog MUX
ADCINAQ —
ADCINAL—MuUX SIH
: A A
ADCINA7 —| : I\%JHX |, |12-bit A/D
ADCINBO —» Converter
ADCINB1 —*MUX
! 5 SH soc| |Eoc
- B
ADCINB7 —* Autosequencer
t I mAx convt
Ch Sel (CONV00)
Ch Sel (CONVO01)
Ch Sel (CONV02)
Software Ch Sel (CONV03)
ePWM_SOC_A ;
ePWM_SOC_B :
External Pin Ch Sel (CONV15)

Start Sequence
Trigger

ADC MOdUIe BIOCk Dlagl’am (Dual-Sequencer mode)

Analog MUX
ADCINAQ Result MUX —
ADCINAL—Mux|  [SH —{RESULTO]
: A 2 12-bit A/D RESLE
ADCINA7 — Result )
f SH || Converter .
MUX Select RESULT?
ADCINB0 = Sequencer T
ADCINB1 —MuUx S/H Arbiter i e
: B B soc1/ s0C2/ RESULT,
ADCINB7 ’ EOC1 EOC2 RESULT9
[i_‘& SEQ1L SEQ2 Result :
: Autosequencer | | Autosequencer | |Select . RESULTIS
el MAX_CONVL [1f| MAX_CONV2 |
Ch Sel (CONV00) Ch Sel (CONV08)
Ch Sel (CONVO01) Ch Sel (CONV09)
Ch Sel (CONVO02) || [ Ch Sel (CONV10)
Software . g Software
ePWM_SOC_A : : SPWM SOC B
External Pin Ch Sel (CONV07) Ch Sel (CONV15) - -
(GPIO/XINT2 Start Sequence Start Sequence
-ADCSOC) Trigger Trigger
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ADC Module

¢ 12-bit resolution ADC core
Sixteen analog inputs (range of 0 to 3V)
¢ Two analog input multiplexers
+ Up to 8 analog input channels each
¢ Two sample/hold units (for each input mux)
¢ Sequential and simultaneous sampling modes

¢ Autosequencing capability - up to 16
autoconversions

+ Two independent 8-state sequencers
+ “Dual-sequencer mode”
+ “Cascaded mode”

¢ Sixteen individually addressable result registers

& Multiple trigger sources for start-of-conversion
+ External trigger, S/W, and ePWM triggers

*

F2808 ADC Clocking Example

CLKIN PLLCR SYSCLKOUT HISPCP HSPCLK
20 MHz 100 MHz 100 MHz
( ) | DIV ( ) HSPCLK ( ),
bits |_, To CPU bits
1010b 000b

PCLKCRO.ADCENCLK =1 | 7%~_
¥

ADCTRL3 FCLK ADCTRL1 ADCCLK
ADCCLKPS | (12.5MHz
. . (125MHz) | ~bs i L ) , ToADC
b|ts pipeline
0100b Ob ADCTRL1 sampling
FCLK = HSPCLK/(2*ADCCLKPS) ADCCLK = ACQ_PS lﬂdgw
FCLK/(CPS+1) bits
0111b

sampling window = (ACQ_PS + 1)*(1/ADCCLK)

Note: ADCCLK can be a maximum of 12.5 MHz. See device data sheet
for more information.
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Analog-to-Digital Converter Registers

Analog-to-Digital Converter Registers
AdcRegs.name (lab file: Adc.c)

Register Description
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ADC Control Register 1

AdcRegs.ADCTRL1 (lab file: Adc.c)

Upper Register:

ADC Module Reset Acquisition Time Prescale (S/H)
Value = (binary+1)
* Time dependent on the “Conversion

0 =no effect
1 =reset (set back to 0

by ADC logic) Clock Prescale” bit (Bit 7 “CPS”)
15 14 13-12 11-8 7
reserved | RESET SUSMOD ACQ_PS CPS
Emulation Suspend Mode Conversion Prescale
00 = [Mode 0] free run (do not stop) 0: ADCCLK =FCLK /1
01 = [Mode 1] stop after current sequence 1: ADCCLK = FCLK / 2

10 = [Mode 2] stop after current conversion
11 = [Mode 3] stop immediately

ADC Control Register 1

AdcRegs.ADCTRL1 (lab file: Adc.c)

Lower Register:

Continuous Run Sequencer Mode
0 = stops after reaching 0 =dual mode
end of sequence 1 =cascaded mode

1 =continuous (starts all over
again from “initial state”)

6 5 4 3-0
CONT_RUN SEQ_OVRD SEQ_CASC reserved

Sequencer Override

(continuous run mode)

0 = sequencer pointer resets to “initial state”
at end of MAX_CONVn

1 =sequencer pointer resets to “initial state”
after “end state”
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ADC Control Register 2

AdcRegs.ADCTRL2 (lab file: Adc.c)

Upper Register:

ePWM SOC A

SEQ1 Mask Bit

0 = cannot be started
by ePWM trigger

1 =can be started

ePWM SOC B Start Conversion (SEQ1)
(cascaded mode only) 0 = clear pending SOC trigger

0 =no action 1 = software trigger-start SEQ1
1 = start by ePWM

signal by ePWM trigger
15 14 13 12 11 10 9 8
ePWM_SOCB INT_ENA | INT_MOD ePWM_SOCA
SEOQ RST_SEQ1 | SOC_SEQL1 |reserved SEO1 “SEQ1 reserved SEO1
Reset SEQ1 Interrupt Enable (SEQ1) Interrupt Mode (SEQ1)
0 =no action 0 = interrupt disable 0 = interrupt every EOS
1 =immediate reset 1 =interrupt enable 1 =interrupt every other EOS

SEQL1 to “initial state”

ADC Control Register 2

AdcRegs.ADCTRL2 (lab file: Adc.c)

Lower Register:

ePWM SOC B
SEQ2 Mask Bit

Start Conversion (SEQ2) 0 = cannot be started

(dual-sequencer mode only)

External SOC (SEQ1)

0 =no action 0 =clear pending SOC trigger 1= by ebPWIE/I ttrl%ger
1=start by signal from 1 = software trigger-start SEQ2 ~ can be starte
ADCSOC pin by ePWM trigger
7 6 5 4 3 2 1 0
EXT_SOC INT_ENA | INT_MOD ePWM_SOCB
"SEo1 RST_SEQ2 | SOC_SEQ2 |reserved SEQ2 SEQ2 reserved SEQ2
Reset SEQ2 Interrupt Enable (SEQ2) Interrupt Mode (SEQ2)
0 =no action 0 = interrupt disable 0 = interrupt every EOS
1 =immediate reset 1 =interrupt enable 1 =interrupt every other EOS

SEQ?2 to “initial state”
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ADC Control Register 3

AdcRegs.ADCTRL3 (lab file: Adc.c)

ADC Reference  ADC Bandgap ADC Power Down

Power Down Power Down (except Bandgap & Ref.)
0 =powered down 0=powered down 0 =powered down
1 =powered up 1 =powered up 1 =powered up
15-8 7 6 5 4-1 0

reserved |ADCBGRFDN1ADCBGRFDNO|ADCPWDN| ADCCLKPS |SMODE_SEL

ADC Clock Prescale Sampling Mode Select

0: FCLK = HSPCLK 0 = sequential sampling mode
1 to F: FCLK = HSPCLK / (2*ADCCLKPS) 1 = simultaneous sampling mode

Maximum Conversion Channels Register
AdcRegs.ADCMAXCONYV (lab file: Adc.c)

¢ Bit fields define the maximum number of autoconversions (binary+1)

Cascaded Mode

15-7 6 5 4 (3 2 1 0
eserved | MAXC MAX_ MAX_ MAX_ MAX_ MAX_ MAX_
CONV2 2 [CONV2 1 |CONV2 0 |CONV1 3 |CONV1I 2 |CONV1_1 |CONV1_O0

SEQZ —0u Dual Mode — SEQL

¢ Autoconversion session always starts with the “initial state”
and continues sequentially until the “end state”, if allowed

||| SEQ1 SEQ2 Cascaded
Initial state [ CONV0O CONVO08 CONVO00
End state CONVO07 CONV15 CONV15
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ADCCHSELSEQ1

ADCCHSELSEQ2

ADCCHSELSEQ3

ADCCHSELSEQ4

ADC Input Channel Select Sequencing
Control Reg

AdcRegs.ADCCHSELSEQXx.bit.C

ister

NVyy = (lab file: Adc.c)

Bits 15-12  Bits 11-8 Bits 7-4 Bits 3-0
CONVO03 |CONVO02 | CONVO1 | CONVOO
Bits 15-12  Bits 11-8 Bits 7-4 Bits 3-0
CONVO7 | CONVO6 | CONVO5 | CONVO4
Bits 15-12  Bits 11-8 Bits 7-4 Bits 3-0
CONV11 |CONV10 | CONV09 | CONV08
Bits 15-12  Bits 11-8 Bits 7-4 Bits 3-0
CONV15 |CONV14 | CONV13 | CONV12
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Example — Sequencer “ Start/Stop” Operation

Example - Sequencer “Start/Stop”
Operation

ePWM
Time Base
\Couter

ePWM
Output

|1, |2' |3 Vl' V2' V3 Il’ |2' I3 Vl’ V2' V3

System Requirements:
*Three autoconversions (I, 1,, I;) off trigger 1 (CTR = 0)
*Three autoconversions (V,, V,, V) off trigger 2 (CTR = PRD)

ePWM and SEQ1 are used for this example with sequential sampling mode

Example - Sequencer “Start/Stop”
Operation (continued)
* MAX_CONV1 is set to 2 and Channel Select Sequencing Control Registers are set to:

Bits » 15-12 11-8 7-4 3-0
V, [ I [, [1,] ADCCHSELSEQ1
X | X |V, |V,| ADCCHSELSEQ2

* Once reset and initialized, SEQ1 waits for a trigger

« First trigger three conversions performed: CONVOO (l;), CONVO1 (l,), CONVO02 (I5)

* MAX_CONV1 value is reset to 2 (unless changed by software)

* SEQ1 waits for second trigger

» Second trigger three conversions performed: CONVO03 (V,), CONV04 (V,), CONVO05 (V3)

* End of second auto conversion session, ADC Results registers have the following values:

RESULTO I, [| RESULT3 Vv,
RESULTI 1, [ RESULT4 V,
RESULT2 I, [ RESULTS V,

— User can reset SEQ1 by software to state CONVO0O and repeat same trigger 1, 2 session
* SEQ1 keeps “waiting” at current state for another trigger
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ADC Conversion Result Buffer Register

ADC Conversion Result Buffer Register

AdcRegs.ADCRESULTO through AdcRegs.ADCRESULT15
(lab file: Adc.c)
(Total of 16 Registers)

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
MSB LSB

With analog input OV to 3V, we have:

analog volts converted value RESUL Tx
3.0 FFFh 1111|2111]1111]0000
15 7FFh 0111]1111j2112]0000
0.00073 1lh 0000]0000|0001]|0000
0 Oh 0000]0000]0000]0000
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Numerical Format

How do we Read the Result?
Integer format

XXX XX IXIXIXIXIXIXTXT 0] 0] 0] 0] RESULTx

!

oloTolo IXIXIXIXIXIXIXIXIXIXIXIX] Data Mem

Example: read RESULTO register
#include ““DSP280x_Device.h”

void main(void)
{
uintl6é value; // unsigned

value = AdcRegs.ADCRESULTO >> 4;
¥

Note: The ADC result registers are dual mapped. The result registers that are located
in PF2 (have 2 wait states) are left justified, and the result registers located
in PFO (have 0 wait states) are right justified.

What About Signed Input Voltages?

Example: -1.5VLV, <+15V

in —

1) Add 1.5 volts to analog input:

2) Subtract “1.5” from digital result: ADCLO

#include “DSP280x_Device.h” GND

#define offset OxO07FF

void main(void)

{
intlé value; // signed

value = (AdcRegs.ADCRESULTO >> 4) — offset;

3
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Lab 6: Analog-to-Digital Converter
» Objective

The objective of this lab is to apply the techniques discussed in module 6 and to become familiar
with the programming and operation of the on-chip analog-to-digital converter. The DSP will be
setup to sample a single ADC input channel at a prescribed sampling rate and store the
conversion result in a buffer in the DSP memory. This buffer will operate in a circular fashion,
such that new conversion data continuously overwrites older results in the buffer.

Lab 6: Analog-to-Digital Converter @of2
Sampling

+3.3V Toggle
GND (GP1032) (GPIO33)

¢ ® data
ADC : memory
connector CPU copies result
i to buffer during
wire RESULTO ADC ISR _g
=
)
ADCINAO 2
. g
! . =
i ePWM2 triggering - 5
i ADC on period match E
i using SOC A trigger
: View ADC
| over 20Hs (S0kHD) e A
: Samples

Studio

Code Composer l

ePWM2

Recall that there are three basic ways to initiate an ADC start of conversion (SOC):
1. Using software
a. SOC_SEQ1/SOC_SEQ2 bhit in ADCTRL2 causes an SOC upon completion of the current
conversion (if the ADC is currently idle, an SOC occurs immediately)
2. Automatically triggered on user selectable ePWM conditions
a. ePWM underflow (CTR = 0)
b. ePWM period match (CTR = PRD)
c. ePWM compare match (CTRU/D = CMPA/B)
3. Externally triggered using a pin
a. ADCSOC pin

One or more of these methods may be applicable to a particular application. In this lab, we will
be using the ADC for data acquisition. Therefore, one of the ePWMs (ePWM2) will be
configured to automatically trigger an SOC A at the desired sampling rate (SOC method 2b
above). The ADC end-of-conversion interrupt will be used to prompt the CPU to copy the results
of the ADC conversion into a results buffer in memory. This buffer pointer will be managed in a
circular fashion, such that new conversion results will continuously overwrite older conversion
results in the buffer. In order to generate an interesting input signal, the code also alternately
toggles a GPIO pin (GP1033) high and low in the ADC interrupt service routine. The ADC ISR
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will also toggle LED DS2 on the eZdsp™ as a visual indication that the ISR is running. This pin
will be connected to the ADC input pin, and sampled. After taking some data, Code Composer
Studio will be used to plot the results. A flow chart of the code is shown in the following slide.

Lab 6: Code Flow Diagram of2)

CPU Initialization
« watchdog disable

* SCSR register ADC interrupt
* core interrupts l
« shared pins
* GPIO setup ADC ISR
! * context save
« read the ADC result

. %m on Main Loop | | write to result buffer
M . —> . « adjust the buffer pointer
ePWM2 period match loop: B loop| |. toggle the GPIO pin

+ send interrupt on - context restore

every conversion - re-enable interrupts
* setup a results buffer P

in memory o AT
{
ePWM2 Initialization return

« clear counter

« set period register

« set to trigger ADC on —
period match

« set the clock prescaler

« enable the timer

Notes

Program performs conversion on ADC channel A0 (ADCINAO pin)

ADC conversion is set at a 50kHz sampling rate

ePWM?2 is triggering the ADC on period match using SOC A trigger

Data is continuously stored in a circular buffer

GP1033 pin is also toggled in the ADC ISR

ADC ISR will also toggle the eZdsp™ LED DS2 as a visual indication that it is running

Procedure

Project File

Note: LABG files have been provided as a starting point for the lab and need to be

completed. DO NOT copy files from a previous lab.

1. A project named Lab6.pjt has been created for this lab. Open the project by clicking
onProject > Open.. andlook in C:\C28x\Labs\Lab6. All Build Options
have been configured like the previous lab. The files used in this lab are:
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Main_6.c Labcfg.cmd

Lab.cdb DSP280x_Headers_BI10S.cmd
User 5 6 _7.cmd CodeStartBranch.asm
SysCtrl.c Gpio.c
DSP280x_GlobalVariableDefs.c PieCtrl 5 6 7 8 9.c
Defaultlsr 5 6 7.c Adc.c

EPwm_6.cC DelayUs.asm

Setup ADC Initialization and Enable Core/PIE Interrupts

2.

In Main_6.c add code to call InitAdc() and InitEPwm() functions. The
InitEPwm() function is used to configure ePWM2 to trigger the ADC at a 50 kHz rate.
Details about the ePWM and control peripherals will be discussed in the next module.
Edit Adc.c to implement the ADC initialization as described above in the objective for
the lab by configuring the following registers: ADCTRL1, ADCTRL2, ADCMAXCONV
and ADCCHSELSEQ1. (Set ADC for cascaded sequencer mode, CPS = CLK/1, and
acquisition time prescale = 8 * (1/ADCCLK), ePWM2 triggering the ADC on period
match using SOC A trigger).

Using the “PIE Interrupt Assignment Table” find the location for the
ADC interrupt, “ADCINT”” and fill in the following information:

PIE group #: # within group:

This information will be used in the next step.

Modify the end of Adc.c to do the following:

enable the "ADCINT" interrupt in the PIE (Hint: use the PieCtrlIRegs structure)
enable core INT1 (IER register)

Open and inspect Defaultlsr_5 6 _7.c. This file contains the ADC interrupt
service routine.

Modify the configuration file Iab . cdb to setup the PIE vector for the ADC interrupt.
Click on the plus sign (+) to the left of Schedull ing and again on the plus sign (+) to
the left of HW1 — Hardware Interrupt Service Routine Manager. Click
the plus sign (+) to the left of PIE INTERRUPTS. Locate the interrupt location for the
ADC (use the information from step #4). Right click, select Properties, and type
_ADCINT_ISR (with a leading underscore) in the function field. Click OK and save all
updates.

Build and Load

8. Save all changes to the files and click the ““Build” button.

9. Reset the DSP, and then ““Go Main”.
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Run the Code

10. In Main_6.c place the cursor inthe “main loop” section, right click on the
mouse key and select Run To Cursor.

11. Open a memory window to view some of the contents of the ADC results buffer. The
address label for the ADC results buffer is AdcBuf.

Note: Exercise care when connecting any wires, as the power to the eZdsp™ is on, and we

do not want to damage the eZdsp™! Details of pin assignments can be found in
Appendix A.

12. Using a connector wire provided, connect the ADCINAO (pin # P9-2) to “GND” (pin #
P9-1) on the eZdsp™. Then run the code again, and halt it after a few seconds. Verify
that the ADC results buffer contains the expected value of 0x0000.

13. Adjust the connector wire to connect the ADCINAOQ (pin # P9-2) to “+3.3V” (pin # P8-
36) on the eZdsp™. (Note: pin # P8-36 / GPIO32 has been set to “1” in Gpio.c). Then
run the code again, and halt it after a few seconds. Verify that the ADC results buffer
contains the expected value of OXOFFF.

14. Adjust the connector wire to connect the ADCINAO (pin # P9-2) to GP1033 (pin # P8-
38) on the eZdsp™. Then run the code again, and halt it after a few seconds. Examine
the contents of the ADC results buffer (the contents should be alternating 0x0000 and
OXOFFF values). Are the contents what you expected?

15. Open and setup a graph to plot a 50-point window of the ADC results buffer.
Click: View > Graph -> Time/Frequency.. and setthe following values:

Start Address AdcBuf

Acquisition Buffer Size 50

Display Data Size 50

DSP Data Type 16-bit unsigned integer
Sampling Rate (Hz) 50000

Time Display Unit us

Select OK to save the graph options.

16. Recall that the code toggled the GPIO33 pin alternately high and low. (Also, the ADC
ISR is toggling the LED DS2 on the eZdsp™ as a visual indication that the ISR is
running). If you had an oscilloscope available to display GP1033, you would expect to
see a square-wave. Why does Code Composer Studio plot resemble a triangle wave?
What is the signal processing term for what is happening here?
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17. Recall that the program toggled the GP1033 pin at a 50 kHz rate. Therefore, a complete
cycle (toggle high, then toggle low) occurs at half this rate, or 25 kHz. We therefore
expect the period of the waveform to be 40 ps. Confirm this by measuring the period of
the triangle wave using the graph (you may want to enlarge the graph window using the
mouse). The measurement is best done with the mouse. The lower left-hand corner of
the graph window will display the X and Y axis values. Subtract the X-axis values taken
over a complete waveform period.

Using Real-time Emulation

Real-time emulation is a special emulation feature that offers two valuable capabilities:

1. Windows within Code Composer Studio can be updated at up to a 10 Hz rate while the
DSP is running. This not only allows graphs and watch windows to update, but also
allows the user to change values in watch or memory windows, and have those
changes affect the DSP behavior. This is very useful when tuning control law
parameters on-the-fly, for example.

2. It allows the user to halt the DSP and step through foreground tasks, while specified
interrupts continue to get serviced in the background. This is useful when debugging
portions of a realtime system (e.g., serial port receive code) while keeping critical
parts of your system operating (e.g., commutation and current loops in motor control).

We will only be utilizing capability #1 above during the workshop. Capability #2 is a
particularly advanced feature, and will not be covered in the workshop.

18. Reset the DSP, and then enable real-time mode by selecting:
Debug -> Real-time Mode

19. A message box will appear. Select YES to enable debug events. This will set bit 1
(DGBM bhit) of status register 1 (ST1) to a “0”. The DGBM is the debug enable mask bit.
When the DGBM bit is set to “0”, memory and register values can be passed to the host
processor for updating the debugger windows.

20. The memory and graph windows displaying AdcBuf should still be open. The connector
wire between ADCINADO (pin # P9-2) and GP1033 (pin # P8-38) should still be
connected. In real-time mode, we would like to have our window continuously refresh.
Click:

View - Real-time Refresh Options..

and check “Global Continuous Refresh™. Alternately, we could have right
clicked on each window individually and selected “Continuous Refresh”.
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21.

22.

23.

24,

Note: “Global Continuous Refresh” causes all open windows to refresh at the
refresh rate. This can be problematic when a large number of windows are open, as
bandwidth over the emulation link is limited. Updating too many windows can cause the
refresh frequency to bog down. In that case, either close some windows, or disable
global refresh and selectively enable “Continuous Refresh” for individual
windows of interest instead.

Run the code and watch the windows update in real-time mode. Are the values updating
as expected?

Fully halting the DSP when in real-time mode is a two-step process. First, halt the
processor with Debug - Halt. Then uncheck the ““Real-time mode” to take
the DSP out of real-time mode.

So far, we have seen data flowing from the DSP to the debugger in realtime. In this step,
we will flow data from the debugger to the DSP.

e Open and inspect Defaultlsr_5_6_7.c. Notice that the global variable
DEBUG_TOGGLE is used to control the toggling of the GP1033 pin. This is the pin
being read with the ADC.

¢ Highlight DEBUG_TOGGLE with the mouse, right click and select “Add to
Watch Window”. The global variable DEBUG_TOGGLE should now be in the
watch window with a value of “1”.

e Run the code in real-time mode and change the value to “0”. Are the results shown
in the memory and graph window as expected? Change the value back to “1”. As
you can see, we are modifying data memory contents while the processor is running
in real-time (i.e., we are not halting the DSP nor interfering with its operation in any
way)! When done, fully halt the DSP.

Code Composer Studio includes GEL (General Extension Language) functions which
automate entering and exiting real-time mode. Four functions are available:

e Run_Realtime_with_Reset (reset DSP, enter real-time mode, run DSP)

e Run_Realtime_with_Restart (restart DSP, enter real-time mode, run DSP)
o Full_Halt (exit real-time mode, halt DSP)

o Full_Halt with_Reset (exit real-time mode, halt DSP, reset DSP)

These GEL functions can be executed by clicking:

GEL - Realtime Emulation Control - GEL Function

In the remaining lab exercises we will be using the above GEL functions to run and halt
the code in real-time mode. If you would like, try repeating the previous step using the
following GEL functions:

GEL - Realtime Emulation Control -> Run_Realtime_with_Reset
GEL - Realtime Emulation Control -> Full_Halt

End of Exercise
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Control Peripherals

Introduction

This module explains how to generate PWM waveforms using the ePWM unit. Also, the eCAP
unit, and eQEP unit will be discussed.

Learning Objectives

Learning Objectives

*

Pulse Width Modulation (PWM) review

Generate PWM waveform with the Pulse
Width Modulator Module (ePWM)

¢ Use the Capture Module to measure the
width of a waveform (eCAP)

¢ Explain function of Quadrature Encoder
Pulse Module (eQEP)

*

Note: Up to 6 ePWM modules, 4 eCAP modules, and 2 eQEP modules are
available on the F280x devices. The lower case “e” used with
the module name refers to “enhanced”. For simplicity, the “e” has
been dropped in this slide set.
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Module Topics
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PWM Review

What is Pulse Width Modulation?

¢ PWMis ascheme to represent a
signal as a sequence of pulses

+ fixed carrier frequency
+ fixed pulse amplitude

+ pulse width proportional to
Instantaneous signhal amplitude

+ PWM energy =~ original signal energy

|‘—'||||||I/Ht

Original Signal PWM representation

Pulse width modulation (PWM) is a method for representing an analog signal with a digital
approximation. The PWM signal consists of a sequence of variable width, constant amplitude
pulses which contain the same total energy as the original analog signal. This property is
valuable in digital motor control as sinusoidal current (energy) can be delivered to the motor
using PWM signals applied to the power converter. Although energy is input to the motor in
discrete packets, the mechanical inertia of the rotor acts as a smoothing filter. Dynamic motor
motion is therefore similar to having applied the sinusoidal currents directly.
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Why use PWM with Power
Switching Devices?

¢ Desired output currents or voltages are known

¢ Power switching devices are transistors
+ Difficult to control in proportional region
+ Easy to control in saturated region

¢ PWMis adigital signal = easy for DSP to output

DC Supply DC Supply
P L
' _ PWM
Qesw:a:i PWM approx.
signal to of desired
Unknown Gate Signal Gate Signal Known with PWM
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ePWM

ePWM Block Diagram

(cMPA.15-0) [cmPB.15-0]

TBCTL .12 -7

Shadowed Shadowed
Clock Compare Compare
Prescaler Register Register
AQCTLA .11-0
[ ]
(AQcTLe.11-0]  [DBCTL.4-0)
BB Compare Action — Dead
Ul Efets Logic Qualifier ——| Band
Counter 9 —|
EPWMxSYNCI EPWMxSYNCO .
Period |
................. Register L - EPWMxA
PWM Trip
Shadowed Chopper Zone EM/IXB
SYSCLKOUT TBPRD .15-0 1 T7x

Note: x=1,2,3,4,5,0r6

PCCTL .10-0

TZSEL .15-0

ePWM Time-Base Module
ePWM Time-Base Module

(cMPA.15-0] [cmPB.15-0)

TBCTL .12-7

[ Shadowed [ Shadowed
. Clock Compare Compare
i |Prescaler Register Register
: AQCTLA .11-0
= | ]
i (AQcTLB.11-0]  [DBCTL.4-0]
Tinl16e-BBI;se | Compare Action Dead
: ) Logi lifier Ban
: Counter ogic Qualifie 2l —|
E EPWMxSYNCI EPWMxSYNCO N
: Period L
"L...........: Reqister |
: Srgdowed i Trip szmxg
: Chopper Zone —3"
SYSCLKOUT TBPRD .15-0 ) 7%

Note: x=1,2,3,4,5,0r6

PCCTL .10-0

TZSEL .15-0
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ePWM Time-Base Count Modes

TBCTR

TBPRD

Asymmetrical
Waveform

TBCTR

TBPRD

Cbunt Up Modé

Asymmetrical

Waveform
Count Down Mode
TBCTR
TBPRD
Symmetrical
Waveform

Count Up and Down Mode

ePWM Phase Synchronization

Ext Syncin
(optional)

Phase En _ Syncin

CTR=zero
CTR=CMPB—0_0\0_
X=—0
SyncOut

EPWM1A
e

EPWM1B
e e

Phase Ep  Syncin
6=120° 00

CTR=zero—o0 \
CTR=CMPB—0 O
X—0
SyncOut

EPWM2A

EPWM2B
e

Phase gn  Syncin
$=240° 0~ 0

CTR=zero—o A
CTR=CMPB=—0 O
X—0
SyncOut

EPWM3A
R s

EPWM3B
e

— ¢=240° —»
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ePWM Time-Base Module Registers

Name Description Structure

TBCTL Time-Base Control EPwmxRegs.TBCTL.all =
TBSTS Time-Base Status EPwmxRegs.TBSTS.all =
TBPHS Time-Base Phase EPwmxRegs.TBPHS =
TBCTR Time-Base Counter EPwmxRegs.TBCTR =
TBPRD Time-Base Period EPwmxRegs.TBPRD =

ePWM Time-Base Control Register
EPwmxRegs.TBCTL.bit.yyyy =
Upper Register:
Phase Direction TBCLK = SYSCLKOUT / (HSPCLKDIV * CLKDIV)
0 = count down after sync S~ —
1 = count up after sync /\
15-14 13 12-10 9-7
FREE_SOFT PHSDIR CLKDIV HSPCLKDIV
Emulation Halt Behavior TB Clock Prescale High Speed TB
00 = stop after next CTR inc/dec 000 =/1 (default) Clock Prescale
01 = stop when: 001=/2 000=/1
Up Mode — CTR = PRD 010=/4 001=/2 (default)
Down Mode —CTR =0 011 =1/8 010=/4
Up/Down Mode—-CTR=0 100=/16 011=1/6
1x = free run (do not stop) 101 =/32 100 =/8
110 =/64 101 =/10
111 =/128 110=/12
111 =/14
(HSPCLKDIV emulates HSPCLK in F281x device)
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ePWM Time-Base Control Register
EPwmxRegs. TBCTL.bit.yyyy =

Lower Register:
Counter Mode

00 = count up
Software Force Sync Pulse 01 = count down
0 =no action

10 = count up and down

1 =force one-time sync 11 = stop — freeze (default)
6 5-4 3 2 1-0
SWFSYNC SYNCOSEL PRDLD PHSEN CTRMODE
Sync Output Select Period Shadow Load Phase Reg. Enable
(source of EPWMxSYNCO signal) 0 =load on CTR=0 0 =disable
82 = CE:'T'\FIQVM)(()SYNCI 1 =load immediately 1=CTR=TBPHSon

EPWMxSYNCI signal
10 =CTR = CMPB

11 = disable SyncOut

ePWM Time-Base Status Register
EPwmxRegs. TBSTS.bit.yyyy =

Counter Max Latched Counter Direction

0 = max value not reached 0 = CTR counting down
1 =CTR = OXFFFF (write 1 to clear) 1 =CTR counting up

N

15-3 2 1 0
reserved CTRMAX SYNCI CTRDIR

External Input Sync Latched

0 =no sync event occurred
1 =sync has occurred (write 1 to clear)
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ePWM Compare Module

TBCTL .12-7

ePWM Compare Module

(cMPA.15-0] (cmPB.15-0)

Clock
Prescaler Register
AQCTLA . 11-0
— o ]
I_l (AQcTiB.11-0]  [DBCTL.4-0]
Tinlg-BBlat\se Compare |—»{ Action Dead
Counter LOA?IC » Qualifier ——s| Band _|
EPWMxSYNCI EPWMxSYNCI N
Period H
ransmnsnnann—— Register L - EPWMxA
PWM Trip ——
|Shadowed Chopper Zone EPWMxB
SYSCLKOUT

TBPRD . 15 - 0
PCCTL .10-0 s
TZSEL .15-0

Note: x=1,2,3,4,5,0r6

TBCTR

TBPRD

CMPA
CMPB

TBCTR

TBPRD

CMPA
CMPB

TBCTR

TBPRD

CMPA
CMPB

ePWM Compare Event Waveforms

| ® = compare events are fed to the Action Qualifier Module|

"""""""""""""""""""""""" Asymmetrical
---------------------------------------------- Waveform

Cbunt Up Modé

Asymmetrical
Waveform

Co urnt Down Mode

Symmetrical
Waveform

Count Up and Down Mode
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ePWM Compare Module Registers

Name Description Structure

CMPCTL Compare Control EPwmxRegs.CMPCTL.all =
CMPA Compare A EPwmxRegs.CMPA =
CMPB Compare B EPwmxRegs.CMPB =

ePWM Compare Control Register
EPwmxRegs.CMPCTL.bit.yyyy =

Upper Register:

15-10 9 8 7
reserved SHDWBFULL | SHDWAFULL reserved

CMPB / A Shadow Full Flag
(bit automatically clears on load)
0 = shadow not full

1 =shadow full
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ePWM Compare Control Register

EPwmxRegs.CMPCTL.bit.yyyy =

Lower Register:

6

Active CMPB and CMPA Shadow Load Mode

00=load on CTR =0

01 =load on CTR = PRD

10 =load on either CTR =0 or CTR = PRD
11 =freeze (no load possible)

5 4 3-2 1-0

SHDWBMODE

reserved

SHDWAMODE LOADBMODE LOADAMODE

CMPB and CMPA Operating Mode
0 = shadow mode; double buffer with

writes to shadow register

1 =immediate mode; only active register

used with writes directly to active register

ePWM Action Qualifier Module

ePWM Action Qualifier Module

TBCTL .12-7

(cMPA.15-0] [cmPB.15-0)

Note: x=1,2,3,4,5,0r 6

Shadowed Shadowed
Clock Compare Compare
Prescaler Register Register
AQCTLA .11-0
I — '
(AQcTiB.11-0 [DBCTL.4-0)
Tinlg-BBlat\se Compare Action » Dead
Counter Logic Qualifier »| Band _|
EPWMxSYNCI EPWMxSYNCO .
Period G
ransmnsnnann—— Register N - EPWMxA
PWM Trip ——
: Shadowed Chopper Zone EPWMxB
SYSCLKOUT TBPRD.15-0 1 T7x

PCCTL .10-0
TZSEL .15-0
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ePWM Action Qualifier Actions
for EPWMA and EPWMB

SW Time-Base Counter equals: EPWM
Force Ou@put
Zero CMPA CMPB TBPRD Actions
S)\<N >Z< C>'<A‘ CXB )F: Do Nothing
SlN f Cf‘ C¢B 5 Clear Low
S¥V % C,]ﬁo‘ CTB ? Set High
SW Z CA CB P
T T T T T Toggle

ePWM Count Up Asdymmetric Waveform
ulation on EPWMA / B

with Independent Mo

TBCTR

TBPRD

EPWMA I
Ilﬁ 5 llﬁ BHE

EPWMB l__ ' l
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ePWM Count U(P

with Indepen

Asymmetric Waveform
ent Modulation on EPWMA

TBCTR

TBPRD

EPWMA |
— : S

z z z

T T T

EPWMB | |

ePWM Count Up-Down Symmetric

Waveform

with Independent Modulation on EPWMA / B
TBCTR

TBPRD
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ePWM Count Up-Down Symmetric

Waveform
with Independent Modulation on EPWMA

TBCTR

TBPRD

EPWMA |
— :  —
Z P z p
J T \’ T

EPWMB |

ePWM Action Qualifier Module Registers

Name Description Structure

AQCTLA AQ Control Output A EPwmxRegs.AQCTLA.all =
AQCTLB AQ Control Output B EPwmxRegs.AQCTLB.all =
AQSFRC AQ S/W Force EPwmxRegs.AQSFRC.all =
AQCSFRC AQ Cont. S/W Force EPwmxRegs.AQCSFRC.all =
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ePWM Action Qualifier Control Register
EPwmxRegs.AQCTLz.bit.yyyy =

(z=AorB)
Action when Action when
CTR =CMPB CTR = CMPA Action when
on UP Count on UP Count CTR‘:O
15-12 11-10 9-8 7-6 5-4 3-2 1-0
reserved CBD CBU CAD CAU PRD ZRO
Action when Action when Action when
CTR = CMPB CTR = CMPA CTR =PRD

on DOWN Count on DOWN Count

00 = do nothing (action disabled)

01 =clear (low)

10 = set (high)

11 =toggle (low — high; high — low)

ePWM Action Qualifier S/W Force

Register
EPwmxRegs. AQSFRC.bit.yyyy =

One-Time S/W Force on Output B/ A
0 =no action
1 =single s/w force event

T

15-8 7-6 5 4-3 2 1-0
reserved RLDCSF OTSFB ACTSFB OTSFA ACTSFA
Shadow Reload Options Action on One-Time S/W Force B/ A
00 =load on event CTR =0 00 = do nothing (action disabled)
01 =load on event CTR = PRD 01 =clear (low)

10 =load on event CTR =0 or CTR=PRD 10 = set (high)
11 = load immediately (from active reg.) 11 =toggle (low — high; high — low)
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15-4

3-2

ePWM AQ Continuous S/W Force

Register
EPwmxRegs. AQCSFRC.bit.yyyy =

1-0

reserved

CSFB

CSFA

\/

Continuous S/W Force on Output B/ A

00 = forcing disabled
01 =force continuous low on output
10 =force continuous high on output
11 =forcing disabled

ePWM Dead-Band Module

(cMPA.15-0] [cmPB.15-0)

TBCTL . 12-7 ShadowedJ ShadowedJ

ePWM Dead-Band Module

Note: x=1,2,3,4,5,0r 6

PCCTL .10-0

Clock Compare Compare
Prescaler Register Register
AQCTLA . 11-0
I — '
(AQcTiB.11-0 [DBCTL.4-0)
Tinlg-BBlat\se Compare Action Dead
Counter Logic Qualifier Band |—
EPWMxSYNCI EPWMxSYNCO .
Period G
ransmnsnnann—— Register L - EPWMxA
i PWM Trip F——
Shadowed . Chopper Zone EPWMxB
SYSCLKOUT TBPRD.15-0 1 T7x

TZSEL .15-0
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Motivation for Dead-Band

supply rail

[l

Gate Signals are to motor phase

Complementary PWM H {

L

¢ Transistor gates turn on faster than they shut off
¢ Short circuit if both gates are on at same time!

Dead-band control provides a convenient means of combating current shoot-through problems in
a power converter. Shoot-through occurs when both the upper and lower gates in the same phase
of a power converter are open simultaneously. This condition shorts the power supply and results
in a large current draw. Shoot-through problems occur because transistors open faster than they
close, and because high-side and low-side power converter gates are typically switched in a
complimentary fashion. Although the duration of the shoot-through current path is finite during
PWM cycling, (i.e. the closing gate will eventually shut), even brief periods of a short circuit
condition can produce excessive heating and over stress in the power converter and power supply.
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ePWM Dead-Band Module Block Diagram
PWMXxA
] e i
1 0 sa i Delay
S o
P11 | (10-bit
: counter)
i , Falling
! i Edge
: 285 Delay
‘_i_(0—§—> In Out;
P11 | (10-bit
""" - counter)
IN-MODE POLSEL OUT-MODE
PWMxB

Two basic approaches exist for controlling shoot-through: modify the transistors, or modify the
PWM gate signals controlling the transistors. In the first case, the opening time of the transistor
gate must be increased so that it (slightly) exceeds the closing time. One way to accomplish this
is by adding a cluster of passive components such as resistors and diodes in series with the
transistor gate, as shown in the next figure.

by-pass diode

K
PWM
signal /\/\é\/\/

Shoot-through control via power circuit modification

The resistor acts to limit the current rise rate towards the gate during transistor opening, thus
increasing the opening time. When closing the transistor however, current flows unimpeded from
the gate via the by-pass diode and closing time is therefore not affected. While this passive
approach offers an inexpensive solution that is independent of the control microprocessor, it is
imprecise, the component parameters must be individually tailored to the power converter, and it
cannot adapt to changing system conditions.

The second approach to shoot-through control separates transitions on complimentary PWM
signals with a fixed period of time. This is called dead-band. While it is possible to perform
software implementation of dead-band, the C28x offers on-chip hardware for this purpose that
requires no additional CPU overhead. Compared to the passive approach, dead-band offers more
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precise control of gate timing requirements. In addition, the dead time is typically specified with
a single program variable that is easily changed for different power converters or adapted on-line.

ePWM Dead-Band Module Registers

Name

Description

Structure

DBCTL
DBRED
DBFED

Dead-Band Control
DB Rising Edge Delay
DB Falling Edge Delay

EPwmxRegs.DBCTL.all =
EPwmxRegs.DBRED =
EPwmxRegs.DBFED =

10-Bit Counter for Rising Edge and Falling Edge Delay

EPwmxRegs.DBCTL.b

ePWM Dead Band Control Register

it.yyyy =

Polarity Select

00 = active high

01 = active low complementary (RED)
10 = active high complementary (FED)
11 = active low

15-6 5-4

AN

3-2 1-0

reserved IN_MODE

POLSEL OUT_MODE

00 =
01=

10=
11 =

In-Mode Control

PWMXA is source for RED and FED
PWMXA is source for FED
PWMxB is source for RED
PWMxA is source for RED
PWMxB is source for FED
PWMxB is source for RED and FED

Out-Mode Control

00 = disabled (DBM bypass)
01 = PWMxA = no delay
PWMxB = FED
10 = PWMxA = RED
PWMxB = no delay
11 = RED and FED (DBM fully
enabled)
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ePWM PWM Chopper Module
ePWM PWM Chopper Module

(cMPA.15-0] (cmPB.15-0)

Shadowed Shadowed
Clock Compare Compare
Prescaler Register Register
AQCTLA .11-0
[ ]
(AQcTiB.11-0]  [DBCTL.4-0]
Tinlg-BBlat\se Compare Action Dead
Counter Logic Qualifier ——s| Band _|
EPWMxSYNCI EPWMxSYNCO .
Period G
ransmnsnnann—— Register L - EPWMxA
PWM » Trip —
Shadowed Chopper —| Zone EPWMxB
SYSCLKOUT TBPRD.15-0

PCCTL .10-0 s
TZSEL .15-0

Note: x=1,2,3,4,5,0r6

Purpose of PWM Chopper

¢ Allows a high frequency carrier
signal to modulate the PWM
waveform generated by the Action
Qualifier and Dead-Band modules

¢ Used with pulse transformer-based
gate drivers to control power
switching elements
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EPWMxB

CHPFREQ

EPWMxA

EPWMxB

ePWM Chopper Waveform

[_
.

%
%

OSHT

EPWMxA

—_— le—
t__! Programmable
Pulse Width
(OSHTWTH)

Sustaining
Pulses

e}

With One-Shot Pulse on EPWMxA and/or EPWMxB

ePWM-Chopper Module Registers

Name

Description Structure

PCCTL

PWM-Chopper Control EPwmxRegs.PCCTL.all =
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ePWM Chopp

er Control Register

EPwmxRegs.PCCTL.bit.yyyy =

Chopper Clk Duty Cycle

000 =1/8 §12.5%
001 = 2/8 (25.0%
010 = 3/8 (37.5%)
011 = 4/8 (50.0%)
100 =5/8 §62.5%
101 = 6/8 (75.0%
110 = 7/8 (87.5%)
111 =reserved

Chopper CIk Freq.

000 = sysclk/8 + 1
001 = sysclk/8 + 2
010 = sysclk/8 + 3
011 =sysclk/8 + 4
100 = sysclk/8 + 5
101 = sysclk/8 + 6
110 =sysclk/8 + 7
111 = sysclk/8 + 8

Chopper Enable
0 = disable (bypass)
1 =enable

/

15-11 10-8 7-5

N

4-1 0

reserved

CHPDUTY

CHPFREQ

OSHTWTH CHPEN

One-Shot Pulse Width

0000 =1 x sysclk/8 wide
0001 = 2 x sysclk/8 wide
0010 = 3 x sysclk/8 wide
0011 = 4 x sysclk/8 wide
0100 =5 x sysclk/8 wide
0101 = 6 x sysclk/8 wide
0110 =7 x sysclk/8 wide
0111 =8 x sysclk/8 wide

1000 =9 x sysclk/8 wide

1001 =10 x sysclk/8 wide
1010 =11 x sysclk/8 wide
1011 = 12 x sysclk/8 wide
1100 = 13 x sysclk/8 wide
1101 = 14 x sysclk/8 wide
1110 =15 x sysclk/8 wide
1111 = 16 x sysclk/8 wide

ePWM Trip-Zone Module

ePWM Trip-Zone Module
(cMPA.15-0] [cmPB.15-0)
Shadowed Shadowed
Clock Compare Compare
Prescaler Register Register
AQCTLA . 11-0
I — '
(AQcTiB.11-0 [DBCTL.4-0)
Tinlg-BBlat\se Compare Action Dead
Counter Logic Qualifier Band _|
EPWMxSYNCI EPWMxSYNCO .
Period |
ransmnsnnann—— Register L - EPWMxA
PWM Trip =
: Shadowed Chopper Zone EPWMxB
SYSCLKOUT TBPRD.15-0
Note: x=1,2,3,4,5,0r6
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the EPWMxA/B output pins

current conditions

DSP

CORE

Cycle-by-Cycle
Mode

One-Shot
Mode

EPWMXTZINT
3

>

Trip-Zone Module Features

+ Trip-Zone has afast, clock independent logic path to high-impedance
¢ Interrupt latency may not protect hardware when responding to over
current conditions or short-circuits through ISR software

+ Supports: #1) one-shot trip for major short circuits or over

#2) cycle-by-cycle trip for current limiting operation

EPWM1A
EPWM1B
EPWM2A
EPWM2B

=
EPWMS3A
—

EPWM3B
EPWM4A
EPWM4B

EPWM5A
——

EPWMSB
EPWMG6A

——»
EPWM6B
—

"wW-HCU-HCO Z=S7T

The power drive protection is a safety feature that is provided for the safe operation of systems

such as power converters and motor drives. It can be used to inform the monitoring program of
motor drive abnormalities such as overvoltage, over-current, and excessive temperature rise. If
the power drive protection interrupt is unmasked, the PWM output pins will be put in the high-

impedance state immediately after the pin is driven low. An interrupt will also be generated.
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ePWM Trip-Zone Module Registers

Name Description Structure

TZCTL Trip-Zone Control EPwmxRegs.TZCTL.all =
TZSEL Trip-Zone Select EPwmxRegs.TZSEL .all =
TZEINT Enable Interrupt EPwmxRegs.TZEINT.all =
TZFLG Trip-Zone Flag EPwmxRegs.TZFLG.all =
TZCLR Trip-Zone Clear EPwmxRegs.TZCLR.all =
TZFRC Trip-Zone Force EPwmxRegs.TZFRC.all =

ePWM Trip-Zone Control Register
EPwmxRegs.TZCTL.bit.yyyy =

15-4

3-2 1-0

reserved

TZB TZA

TZ1to TZ6 Action on EPWMxB / EPWMxA
00 = high impedance

01 =force high

10 = force low

11 = do nothing (disable)
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ePWM Trip-Zone Select Register
EPwmxRegs.TZSEL .bit.yyyy =

One-Shot Trip Zone
(event only cleared under S/W
control; remains latched)
0 = disable as trip source
1 =enable as trip source

A

15-14 /13 12 11 10 9

reserved OSHT6 OSHT5 OSHT4 OSHT3 OSHT2 OSHT1
7-6 5 4 3 2 1

reserved CBC6 CBC5 CBC4 CBC3 cBC2 | cBC1

N

Cycle-by-Cycle Trip Zone
(event cleared when CTR = 0;
i.e. cleared every PWM cycle)
0 = disable as trip source
1 =enable as trip source

ePWM Trip-Zone Enable Interrupt
Reglster

EPwmxRegs.TZEINT.bit.yyyy =
15-3 2 1 0
reserved OST CBC reserved
One-Shot Cycle-by-Cycle
Interrupt Enable Interrupt Enable
0 =disable 0 = disable
1 =enable 1 =-enable
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ePWM Event-Trigger Module
ePWM Event-Trigger Module

(cMPA.15-0] (cmPB.15-0)
TBCTL 12-7 ShadowedJ ShadowedJ

.| Clock Compare Compare
Prescaler Register Register

AQCTLA . 11-0
E— )
L (AQcTiB.11-0]  [DBCTL.4-0]

Tinlg-BBlat\se Compare Action Dead
Logic Qualifier ——s| Band

(tlountei —|

EPWMxSYNCI EPWMxSYNCO .
Period
................ . Reqister L - EPWMxA
: - PWM Trip —
H Shadowed EPWMxB
i Chopper Zone
SYSCLKOUT TBPRD . 15-0

PCCTL .10-0 s
TZSEL .15-0

Note: x=1,2,3,4,5,0r6

ePWM Event-Trigger Interrupts and SOC

CTRD = CMPA |

TBCTR
TBPRD ; :
CMPB A ' f i i
CMPA i ook
EPWMA | P P
i — L
EPWMB | |
ST N N N N S N O O
CTR = PRD| P f P ' P f P 5
CTRU = CMPA| f S ' f N '

CTRU = CMPB!|

S G I

CTRD = CMPB ! R f ; : P f i
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ePWM Event-Trigger Module Registers

Name Description Structure

ETSEL ET Selection EPwmxRegs.ETSEL.all =
ETPS ET Pre-Scale EPwmxRegs.ETPS.all =
ETFLG Event-Trigger Flag EPwmxRegs.ETFLG.all =
ETCLR Event-Trigger Clear EPwmxRegs.ETCLR.all =
ETFRC Event-Trigger Force EPwmxRegs.ETFRC.all =

15

ePWM Event-Trigger Selection Register

EPwmxRegs.ETSEL.bit.yyyy =

Enable SOCB / A

0 =disable
1 =enable

T~

14 -12 11

10-8

Enable EPWMXxINT

0 =disable
1 =enable

\

3 2-0

SOCBEN

SOCBSEL

SOCAEN

SOCASEL

reserved

INTEN | INTSEL

EPWMxSOCB / A Select

000 = reserved
001=CTR=0
010=CTR =PRD
011 =reserved

100 = CTRU = CMPA
101 = CTRD = CMPA
110 = CTRU = CMPB
111 = CTRD = CMPB

EPWMXINT Select

000 = reserved
001=CTR=0
010=CTR =PRD
011 = reserved

100 = CTRU = CMPA
101 = CTRD = CMPA
110 = CTRU = CMPB
111 = CTRD = CMPB
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ePWM Event-Trigger Prescale Register
EPwmxRegs.ETPS.bit.yyyy =

EPWMxSOCB / A Counter EPWMXINT Counter
(number of events have occurred) (number of events have occurred)
00 = no events 00 = no events
01 =1 event 01 =1 event
10 = 2 events 10 =2 events
11 =3 events 11 =3 events
15-14 13-12 11-10 9-8 7-4 2-3 1-0

SOCBCNT | SOCBPRD | SOCACNT | SOCAPRD | reserved [ INTCNT|INTPRD

EPWMxSOCB / A Period EPWMXINT Period
(number of events before SOC) (number of events before INT)
00 = disabled 00 = disabled

01 = SOC on first event 01 = INT on first event

10 = SOC on second event 10 = INT on second event
11 = SOC on third event 11 = INT on third event

Hi-Resolution PWM (HRPWM)
Hi-Resolution PWM (HRPWM)

B PWM Period -
Regular
Device Clock  mnnnUUUUUUUIUIUIIIIIIIIUUTUUUUUUUUULLT PWM Step

(e 100MH2) [T EEEEE LD L EEEEEEERET T Gee. 2ons)

HRPWM divides a clock ) Calibration Logic tracks the

caled icro Stepe. .~ meHmeHms—fmeHmsHne =" L
(Step Size ~= 150ps) | Calibration Logic | variations caused by

Temp/Volt/Process

| HRPWM
LEEEEETEEETERETERETTET | Micro Step (~150ps)

Significantly increases the resolution of conventionally derived digital PWM

Uses 8-bit extensions to Compare registers (CMPxHR) and Phase register
(TBPHSHR) for edge positioning control

Typically used when PWM resolution falls below ~9-10 bits which occurs at
frequencies greater than ~200 kHz (with system clock of 100 MHz)

Not all ePWM outputs support HRPWM feature (see device data manual)

* ¢ o
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Asymmetric and Symmetric Waveform Generation
using the ePWM

PWM switching frequency:

The PWM carrier frequency is determined by the value contained in the time-base period register,
and the frequency of the clocking signal. The value needed in the period register is:

Asymmetric PWM:  period register = (SW'tCh'”g pe”Odj 1

timer period

switching period

Symmetric PWM:  period register = —— )
2(timer period)

Notice that in the symmetric case, the period value is half that of the asymmetric case. This is
because for up/down counting, the actual timer period is twice that specified in the period register
(i.e. the timer counts up to the period register value, and then counts back down).

PWM resolution:

The PWM compare function resolution can be computed once the period register value is
determined. The largest power of 2 is determined that is less than (or close to) the period value.
As an example, if asymmetric was 1000, and symmetric was 500, then:

Asymmetric PWM: approx. 10 bit resolution since 2'° = 1024 ~ 1000

Symmetric PWM: approx. 9 bit resolution since 2° = 512 ~ 500

PWM duty cycle:

Duty cycle calculations are simple provided one remembers that the PWM signal is initially
inactive during any particular timer period, and becomes active after the (first) compare match
occurs. The timer compare register should be loaded with the value as follows:

Asymmetric PWM: TXCMPR = (100% - duty cycle) * TXPR

Symmetric PWM: TxXCMPR = (100% - duty cycle) * TXPR

Note that for symmetric PWM, the desired duty cycle is only achieved if the compare registers
contain the computed value for both the up-count compare and down-count compare portions of
the time-base period.
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ePWM Exercise

ePWM Exercise

Symmetric PWM is to be generated as follows:
¢ 50 kHz carrier frequency
e Timer counter clocked by 10 ns CPU clock
e 25% duty cycle initially

Determine the initialization values needed in the
TBPRD (period) and CMPA/B (compare) registers
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eCAP

Capture Units

@ ] L

Timer
\l( Trigger \-g

Timestamp
Values

¢ Capture module timestamps
transitions on capture input pin

& Four capture registers (?er capture
_modulef— assoclated with a capture
input pin

¢ Up to four capture modules per device

The capture units allow time-based logging of external TTL signal transitions on the capture input
pins. The C28x has up to four capture units.

Capture units can be configured to trigger an A/D conversion that is synchronized with an
external event. There are several potential advantages to using the capture for this function over
the ADCSOC pin associated with the ADC module. First, the ADCSOC pin is level triggered,
and therefore only low to high external signal transitions can start a conversion. The capture unit
does not suffer from this limitation since it is edge triggered and can be configured to start a
conversion on either rising edges, falling edges, or both. Second, if the ADCSOC pin is held high
longer than one conversion period, a second conversion will be immediately initiated upon
completion of the first. This unwanted second conversion could still be in progress when a
desired conversion is needed. In addition, if the end-of-conversion ADC interrupt is enabled, this
second conversion will trigger an unwanted interrupt upon its completion. These two problems
are not a concern with the capture unit. Finally, the capture unit can send an interrupt request to
the CPU while it simultaneously initiates the A/D conversion. This can yield a time savings
when computations are driven by an external event since the interrupt allows preliminary
calculations to begin at the start-of-conversion, rather than at the end-of-conversion using the
ADC end-of-conversion interrupt. The ADCSOC pin does not offer a start-of-conversion
interrupt. Rather, polling of the ADCSOC bit in the control register would need to be performed
to trap the externally initiated start of conversion.
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Some Uses for the Capture Units

¢ Measure the time width of a pulse
¢ Low speed velocity estimation from incr. encoder:

Problem: At low speeds, calculation of speed

based on a measured position change at v, zM
fixed time intervals produces large estimate At
errors

Alternative: Estimate the speed using a measured time interval
at fixed position intervals

Signal from one
L quadrature

to -t encoder channel
}-— AX —-{

Vi &

eCAP Block Diagram

(Capture Mode)

CAP1POL
ECCTL .0

CAP1.31-0

_,| Capture 1 |__| | __| Polarity |_

Register Select 1
CAP2POL
|| Capture2 || | __| Polarity | | PRESCALE
Register =) Select 2
i o
2l - CAP3POL Event | _ECAPX
y e : | Prescale [~
i Counter S
|| Capture 3 w Polarity |_|
............... y e “— Select 3
SYSCLKOUT CAPAPOL
Capture 4 Polarity o
Register Select 4

Note: x=1,2,3,0r4
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eCAP Block Diagram

(APWM Mode)

| Shadowed

Period || CAP3.31-0

Period Register shadow
immediate Register (CAP 3) mode
mode (Capture 1)
. 32-Bit PWM APWMXx
- Time-Stamp Compare
i Counter Logic
SYSCLKOUT
Compare
immediate Register |Compare
mode

Note: x=1,2,3,0r 4

(Capture 2)

[ Shadowed

Register
(CAP 4)

shadow
mode

eCAP Module Registers

Name Description Structure

ECCTL1 Capture Control 1 ECapxRegs.ECCTL1.all =
ECCTL2 Capture Control 2 ECapxRegs.ECCTL2.all =
TSCTR Time-Stamp Counter ECapxRegs.TSCTR =
CTRPHS | Counter Phase Offset ECapxRegs.CTRPHS =
CAP1 Capture 1 ECapxRegs.CAP1 =
CAP2 Capture 2 ECapxRegs.CAP2 =
CAP3 Capture 3 ECapxRegs.CAP3 =
CAP4 Capture 4 ECapxRegs.CAP4 =
ECEINT Enable Interrupt ECapxRegs.ECEINT.all =
ECFLG Interrupt Flag ECapxRegs.ECFLG.all =
ECCLR Interrupt Clear ECapxRegs.ECCLR.all =
ECFRC Interrupt Force ECapxRegs.ECFRC.all =
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eCAP Control Register 1
ECapxRegs.ECCTL1.bit.yyyy =

Upper Register:

CAP1 -4 Load
on Capture Event
0 = disable
1= enaﬁ
15-14 13-9 8
FREE_SOFT PRESCALE CAPLDEN
Emulation Control Event Filter Prescale Counter
00 = TSCTR stops immediately 00000 = divide by 1 (bypass)
01 = TSCTR runs until equals 0 00001 = divide by 2
1X = free run (do not stop) 00010 = divide by 4

00011 =divide by 6
00100 =divide by 8
LN )

L )

11110 = divide by 60
11111 = divide by 62

eCAP Control Register 1
ECapxRegs.ECCTL1.bit.yyyy =

Lower Register:

Counter Reset on Capture Event

0 = no reset (absolute time stamp mode)
1 =reset after capture (difference mode)

7 6 5 4 3 2 1 0
CTRRST4|CAP4POL [CTRRST3 [CAP3POL |CTRRST2|CAP2POL |CTRRST1 [CAP1POL

T\ =

Capture Event Polarity
0 =trigger on rising edge
1 =trigger on falling edge
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eCAP Control Register 2
ECapxRegs.ECCTL2.bit.yyyy =

Upper Register:

Capture / APWM mode

0 = capture mode
1=APWM mode

15-11 10 9 8
reserved APWMPOL | CAP_APWM | SWSYNC

APWM Output Polarity Software Force

(valid only in APWM mode) Counter Synchronization
0 = active high output 0 = no effect
1 = active low output 1=TSCTR load of current

module and other modules
if SYNCO_SEL bits = 00

eCAP Control Register 2
ECapxRegs.ECCTL2.bit.yyyy =

Lower Register:

Re-arm Continuous/One-Shot
Couqter Sync-In (capture mode only) (capture mode only)
0 =disable 0 = no effect 0 = continuous mode
1 =-enable 1=arm sequence 1 =one-shot mode
7-6 5 4 3 2-1 0

SYNCO_SEL | SYNCI_EN | TSCTRSTOP | REARM | STOP_WRAP | CONT_ONESHT

Sync-Out Select Time Stamp  Stop Value for One-Shot Mode/
00 = sync-in to sync-out Counter Stop Wrap Value for Continuous Mode
01 = CTR = PRD event 0 =stop (capture mode only)

generates sync-out 1=run 00 = stop/wrap after capture event 1
1X =disable 01 = stop/wrap after capture event 2

10 = stop/wrap after capture event 3
11 = stop/wrap after capture event 4
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The capture unit interrupts offer immediate CPU notification of externally captured events. In
situations where this is not required, the interrupts can be masked and flag testing/polling can be
used instead. This offers increased flexibility for resource management. For example, consider a
servo application where a capture unit is being used for low-speed velocity estimation via a
pulsing sensor. The velocity estimate is not used until the next control law calculation is made,
which is driven in real-time using a timer interrupt. Upon entering the timer interrupt service
routine, software can test the capture interrupt flag bit. If sufficient servo motion has occurred
since the last control law calculation, the capture interrupt flag will be set and software can
proceed to compute a new velocity estimate. If the flag is not set, then sufficient motion has not
occurred and some alternate action would be taken for updating the velocity estimate. As a
second example, consider the case where two successive captures are needed before a
computation proceeds (e.g. measuring the width of a pulse). If the width of the pulse is needed as
soon as the pulse ends, then the capture interrupt is the best option. However, the capture
interrupt will occur after each of the two captures, the first of which will waste a small number of
cycles while the CPU is interrupted and then determines that it is indeed only the first capture. If
the width of the pulse is not needed as soon as the pulse ends, the CPU can check, as needed, the
capture registers to see if two captures have occurred, and proceed from there.

eCAP Interrupt Enable Register
ECapxRegs.ECEINT.bit.yyyy =

CTR =CMP CTR = Overflow Capture Event 3  Capture Event 1
Interrupt Enable  Interrupt Enable Interrupt Enable Interrupt Enable

N N \ /

15-8 7 6 5 4 3 2 1 0
reserved| CTR=CMP |CTR=PRD |CTROVF [CEVT4 |CEVT3 |CEVT2 |CEVT1 [reserved

CTR = PRD Capture Event 4 Capture Event 2
Interrupt Enable Interrupt Enable Interrupt Enable

0 = disable as interrupt source
1 =enable as interrupt source
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eQEP

What is an Incremental Quadrature
Encoder?

A digital (angular) position sensor

slots spaced 0 deg. apart

T photo sensors spaced 0/4 deg. apart
) ;
light source (LED .
~0 " (LED) :

Q— ~ Q"

shaft rotation

Incremental Optical Encoder Quadrature Output from Photo Sensors

The eQEP circuit, when enabled, decodes and counts the quadrature encoded input pulses. The
QEP circuit can be used to interface with an optical encoder to get position and speed information
from a rotating machine.

How is Position Determined from
Quadrature Signals?

Position resolution is 0/4 degrees
increment decrement

_  (00) (11)
A,B) =
(A,B) i(llo)i(o,l) counter counter

I

|

' Quadrature

| | Decoder @
] i State Machine
|
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eQEP Block Diagram

Measure the elapsed time
between the unit position events —
used for low speed measurement

__,|  Quadrature
Generate periodic Capture —
interrupts for velocity Quadrature - | | Direction -
calculations clock mode ) count mode
IVIIonli(tors_ tlae quadrature
clock to indicate proper
operatlion of the motﬁ)n w
; ; control system
w{ 32-Bit Unit| | EQEPXB/XDIR
i |Time-Base OEP Quadrature[*
i Decoder EQEPXI
CA— . Watchdog —EQEPX]
i EQEPXS
SYSCLKOUT
|, |Position/Counter
Compare
Generate the direction and

clock for the position counter
in quadrature count mode

Generate a sync output
and/or interrupt on a
position compare match

Note: up to two quadrature encoder interfaces on F280x device

eQEP Connections

Ch. A
Quadrature h.B U
> Capture - c L
EQEPXAIXCLK
opl 32-Bit Unit |_|
el Time-Base QEP || Quadrature - nd
i Decoder ndex
Romecomomn Watchdog EQEPX|
EQEPXS Strobe .
SYSCLKOUT from homing sensor
Position/Counter
=>  Compare [T
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Lab 7: Control Peripherals

» Objective

The objective of this lab is to apply the techniques discussed in module 7 and become familiar
with the programming and operation of the control peripherals and its interrupts. ePWMZ1A will
be setup to generate a 2 kHz, 25% duty cycle symmetric PWM waveform. The waveform will
then be sampled with the on-chip analog-to-digital converter and displayed using the graphing

feature of Code Composer Studio. Next, eCAP1 will be setup to detect the rising and falling

edges of the waveform. This information will be used to determine the width of the pulse and

duty cycle of the waveform. The results of this step will be viewed numerically in a memory

window.

Lab 7: Control Peripherals

ePWM1
TB Counter
Compare
Action Qualifier

eCAP1

_.

ePWM2 triggering ADC on
period match using SOC A
trigger every 20 ps (50 kHz)

connector

ADC

CPU copies
result to

wire

RESULTO

._

ADC-
INAO

buffer during
ADC ISR
—

data
memory

pointer rewind

—

1l

View ADC
buffer PWM
Samples

Studio

Code Composer l

» Procedure

Project File

Note:

completed. DO NOT copy files from a previous lab.

LABY files have been provided as a starting point for the lab and need to be

1. Aproject named Lab7.pjt has been created for this lab. Open the project by clicking
onProject > Open.. and look in C:\C28x\Labs\Lab7. All Build Options
have been configured like the previous lab. The files used in this lab are:
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Main_7.c Labcfg.cmd

Lab.cdb DSP280x_Headers_BI10S.cmd
User 5 6 _7.cmd CodeStartBranch.asm
SysCtrl.c Gpio.c
DSP280x_GlobalVariableDefs.c PieCtrl 5 6 7 8 9.c
Defaultlsr 5 6 7.c Adc.c

EPwm_7 8 9 10.c DelayUs.asm

Setup Shared I/O and ePWM1

2.
3.

Edit Gpio.c and adjust the shared 1/0 pin in GPIOO0 for the PWM1A function.

InEPwm_7_8_ 9 10.c, setup ePWML1 to implement the PWM waveform as described
in the objective for this lab. The following registers need to be modified: TBCTL (set
clock prescales to divide-by-1, no software force, sync and phase disabled), TBPRD,
CMPA, CMPCTL (load on 0 or PRD), and AQCTLA (set on up count and clear on down
count for output A). Software force, deadband, PWM chopper and trip action has been
disabled. (Hint — notice the last steps enable the timer count mode and enble the clock to
the ePWM module). Make use of the global variable names and values that have been set
using #define in the beginning of EPwm_7 8 9 10.c file. Notice that ePWM2 has

been initialized earlier in the code for the ADC lab. Save your work.

Build and Load

4.

Save all changes to the files and click the ““Bui 1d”” button to build and load the project.

Run the Code — PWM Waveform

5.

Open a memory window to view some of the contents of the ADC results buffer. The
address label for the ADC results buffer is AdcBuf. We will be running our code in real-
time mode, and will have our window continuously refresh.

Using a connector wire provided, connect the PWMZ1A (pin # P8-9) to ADCINAO (pin #
P9-2) on the eZdsp™.

Run the code (real-time mode) using the GEL function: GEL - Realtime
Emulation Control - Run_Realtime_with_Reset. Watch the window
update. Verify that the ADC result buffer contains the updated values.

Open and setup a graph to plot a 50-point window of the ADC results buffer.
Click: View > Graph -> Time/Frequency.. and set the following values:
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Start Address AdcBuf

Acquisition Buffer Size 50

Display Data Size 50

DSP Data Type 16-bit unsigned integer
Sampling Rate (Hz) 50000

Time Display Unit us

Select OK to save the graph options.

9. The graphical display should show the generated 2 kHz, 25% duty cycle symmetric
PWM waveform. The period of a 2 kHz signal is 500 pus. You can confirm this by
measuring the period of the waveform using the graph (you may want to enlarge the
graph window using the mouse). The measurement is best done with the mouse. The
lower left-hand corner of the graph window will display the X and Y-axis values.
Subtract the X-axis values taken over a complete waveform period (you can use the PC
calculator program found in Microsoft Windows to do this).

Frequency Domain Graphing Feature of Code Composer Studio

10. Code Composer Studio also has the ability to make frequency domain plots. It does this
by using the PC to perform a Fast Fourier Transform (FFT) of the DSP data. Let's make
a frequency domain plot of the contents in the ADC results buffer (i.e. the PWM
waveform).

Click: View > Graph -> Time/Frequency.. and set the following values:

Display Type FFT Magnitude

Start Address AdcBuf

Acquisition Buffer Size 50

FFT Framesize 50
DSP Data Type 16-bit unsigned integer
Sampling Rate (Hz) 50000

Select OK to save the graph options.

11. On the plot window, left-click the mouse to move the vertical marker line and observe the
frequencies of the different magnitude peaks. Do the peaks occur at the expected
frequencies?
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12.

Fully halt the DSP (real-time mode) by using the GEL function: GEL - Realtime
Emulation Control -> Full_Halt.

Setup eCAP1 to Measure Width of Pulse

The first part of this lab exercise generated a 2 kHz, 25% duty cycle symmetric PWM
waveform which was sampled with the on-chip analog-to-digital converter and displayed
using the graphing feature of Code Composer Studio. Next, eCAP1 will be setup to detect
the rising and falling edges of the waveform. This information will be used to determine the
width of the pulse and duty cycle of the waveform. The results of this step will be viewed
numerically in a memory window and can be compared to the results obtained using the
graphing features of Code Composer Studio.

13.

14.

15.
16.

17.

18.

19.

20.

Add the following file to the project:
ECap_7 8 9 10.c
Check your files list to make sure the file is there.

InMain_7.c, add code to call the InitECap() function. There are no passed
parameters or return values, so the call code is simply:

IniteCap(Q);
Edit Gpio.c and adjust the shared 1/O pin in GPIO5 for the ECAP1 function.

Open and inspect the eCAP1 interrupt service routine (ECAPL_INT_ISR) in the file
Defaultlsr_5 6 7.c. Notice that PWM_duty is calculated by CAP2 — CAP1
(rising to falling edge) and that PWM_period is calculated by CAP3 — CAP1 (rising to
rising edge).

INnECap_7_8 9 10.c, setup eCAPL1 to calculate PWM_duty and PWM_period. The
following registers need to be modified: ECCTL2 (continuous mode, re-arm disable, and
sync disable), ECCTL1 (set prescale to divide-by-1, configure capture event polarity
without reseting the counter), and ECEINT (enable desired eCAP interrupt).

Using the “PIE Interrupt Assignment Table” find the location for the
eCAPL interrupt, “ECAP1_INT” and fill in the following information:

PIE group #: # within group:
This information will be used in the next step.

Modify the end of ECap_7 8 9 10.c to do the following:

enable the “ECAPL_INT” interrupt in the PIE (Hint: use the PieCtrlIRegs structure)
enable core INT4 (IER register)

Modify the configuration file Iab . cdb to setup the PIE vector for the ECAPL interrupt.
Click on the plus sign (+) to the left of Schedull ing and again on the plus sign (+) to
the left of HW1 — Hardware Interrupt Service Routine Manager. Click
the plus sign (+) to the left of PIE INTERRUPTS. Locate the interrupt location for the
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ECAP1_INT (use the information from step #18). Right click, select Properties, and
type _ECAP1_INT_ ISR (with aleading underscore) in the function field. Click OK
and save all updates.

Build and Load

21. Save all changes to the files and click the ““Bui 1d”” button.

Run the Code — Pulse Width Measurement

22. Open a memory window to view the address label PWM_duty. (Type &PWM_duty in
the address box). The address label PWM_period (address &PWM_period) should
appear in the same memory window.

23. Set the memory window properties format to “32-Bit UnSigned Int”. Click OK.

24. Using the connector wire provided, connect the PWMZ1A (pin # P8-9) to ECAP1 (pin #
P8-14) on the eZdsp™.

25. Run the code (real-time mode) by using the GEL function: GEL -> Realtime
Emulation Control -> Run_Realtime_with_Reset. Notice the values for
PWM_duty and PWM_period.

26. Fully halt the DSP (real-time mode) by using the GEL function: GEL - Realtime
Emulation Control -> Full_Halt.

Questions:

e How do the captured values for PWM_duty and PWM_period relate to the compare
register CMPA and time-base period TBPRD settings for ePWM1A?

e What is the value of PWM_duty in memory?
e What is the value of PWM_period in memory?
e How does it compare with the expected value?

End of Exercise
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ePWM Exercise Solution

ePWM Exercise Solution

TBPRD = 1 carrier period _1 20 ps

= 1000 = 3E8h
2 timer period 2 10ns

CMPA/B = (100% - duty cycle)*TBPRD = 0.75¥1000 = 750 = 2EEh

4 TPWM
50 kHz = 20 ps

CPU clock =10 ns

Compare

Counter

Qutput Pin
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Numerical Concepts & IQmath

Introduction

In this module, numerical concepts will be explored. One of the first considerations concerns
multiplication — how does the user store the results of a multiplication, when the process of mul-
tiplication creates results larger than the inputs. A similar concern arises when considering accu-
mulation — especially when long summations are performed. Then, IQmath will be described as a
technique for implementing a “virtual floating-point” system to simplify the design process.

The IQmath Library is a collection of highly optimized and high precision mathematical
functions used to seamlessly port floating-point algorithms into fixed-point code. These C/C++
routines are typically used in computationally intensive real-time applications where optimal
execution speed and high accuracy is needed. By using these routines a user can achieve
execution speeds considerable faster than equivalent code written in standard ANSI C language.
In addition, by incorporating the ready-to-use high precision functions, the IQmath library can
shorten significantly a DSP application development time. (The IQmath user's guide is included
in the application zip file, and can be found in the /docs folder once the file is extracted and
installed).

Learning Objectives

Learning Objectives

¢ Compare/contrast integer and
fractional operations

¢ Discuss fixed-point math
development limitations

¢ Compare/contrast floating-point and
IQ representation

¢ Describe the IQmath approach and
the problem it solves
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Numbering System Basics

Given the ability to perform arithmetic processes (addition and multiplication) with the C28x, it is
important to understand the underlying mathematical issues which come into play. Therefore, we
shall examine the numerical concepts which apply to the C28x and, to a large degree, most
processors.

Binary Numbers

The binary numbering system is the simplest numbering scheme used in computers, and is the
basis for other schemes. Some details about this system are:

e Ituses only two values: 1 and 0

e Each binary digit, commonly referred to as a bit, is one “place” in a binary number
and represents an increasing power of 2.

e The least significant bit (LSB) is to the right and has the value of 1.
o Values are represented by setting the appropriate 1's in the binary number.
e The number of bits used determines how large a number may be represented.

Examples:

0110, = (0 * 8) + (1 *4) + (1 * 2) + (0 * 1) = 64
11110, = (L * 16) + (L * 8) + (1 * 4) + (1 * 2) + (0 * 1) = 304

Two's Complement Numbers

Notice that binary numbers can only represent positive numbers. Often it is desirable to be able to
represent both positive and negative numbers. The two's complement numbering system modifies
the binary system to include negative numbers by making the most significant bit (MSB)
negative. Thus, two's complement numbers:

o Follow the binary progression of simple binary except that the MSB is negative — in
addition to its magnitude

e Can have any number of bits — more bits allow larger numbers to be represented

Examples:

0110, = (0 * -8) + (1 * 4) + (L * 2) + (0 * 1) = 6y
11110, = (A * -16) + (1 *8) + (A *4) + (A *2) + (0 * 1) = -2

The same binary values are used in these examples for two's complement as were used above for
binary. Notice that the decimal value is the same when the MSB is 0, but the decimal value is
quite different when the MSB is 1.

Two operations are useful in working with two's complement numbers:
e The ability to obtain an additive inverse of a value
e The ability to load small numbers into larger registers (by sign extending)

TMS320C28x DSP Workshop - Numerical Concepts & IQmath 8-3



Numbering System Basics

To load small two's complement numbers into larger
registers:

The MSB of the original number must carry to the MSB of the number when represented in the
larger register.

1. Load the small number “right justified” into the larger register.

2. Copy the sign bit (the MSB) of the original number to all unfilled bits to the left in the
register (sign extension).

Consider our two previous values, copied into an 8-bit register:

Examples:

Original No. 0110, | =64 11110, | =-2p

1. Load low 0110 11110

2. Sign Extend 00000110 |=4+2=6 11111110 |[=-128+64+..+2=-2
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Sign Extension Mode

The C28x can operate on either unsigned binary or two's complement operands. The “Sign
Extension Mode” (SXM) bit, present within a status register of the C28x, identifies whether or
not the sign extension process is used when a value is brought into the accumulator. It is good
programming practice to always select the desired SXM at the beginning of a module to assure
the proper mode.

What is Sign Extension?

¢ When moving a value from a narrowed width location
to a wider width location, the sign bit is extended to fill
the width of the destination

Sign extension applies to signed numbers only
It keeps negative numbers negative!

¢ Sign extension controlled by SXM bit in STO register;
When SXM =1, sign extension happens automatically

L R 4

4 bit Example: Load a memory value into the ACC

memory |1101 | =-23+22+20=-3

l Load and sign extend
<

ACC (11111101 |=-27+264+25+24+23+22+ 20
=-128+64+32+16+8+4+1
=-3

TMS320C28x DSP Workshop - Numerical Concepts & IQmath 8-5



Binary Multiplication

Binary Multiplication

Now that you understand two's complement numbers, consider the process of multiplying two
two's complement values. As with “long hand” decimal multiplication, we can perform binary
multiplication one “place” at a time, and sum the results together at the end to obtain the total

product.
Note: This is not the method the C28x uses in multiplying numbers — it is merely a way of observing
how binary numbers work in arithmetic processes.
The C28x uses 16-bit operands and a 32-bit accumulator. For the sake of clarity, consider the
example below where we shall investigate the use of 4-bit values and an 8-bit accumulation:
Four-Bit Integer Multiplication
0100 4
x 1101 x -3
0100
0000
0100
1100
1110100 -12
Accumulator | 11110100 l
Data Memory ? l
Is there a better numbering system?
In this example, consider the following:
e What are the two input values, and the expected result?
e Why are the “partial products” shifted left as the calculation continues?
e Why is the final partial product “different” than the others?
e What is the result obtained when adding the partial products?
e How shall this result be loaded into the accumulator?
o How shall we fill the remaining bit? Is this value still the expected one?
e How can the result be stored back to memory? What problems arise?
8-6 TMS320C28x DSP Workshop - Numerical Concepts & IQmath




Binary Multiplication

Note: With two’s complement multiplication, the leading “1” in the second multiplicand is a
sign bit. If the sign bit is “1”, then take the 2’s complement of the first multiplicand.
Additionally, each partial product must be sign-extended for correct computation.

Note: All of the above questions except the final one are addressed in this module. The last
guestion may have several answers:

e  Store the lower accumulator to memory. What problem is apparent using this
method in this example?

e Store the upper accumulator back to memory. Wouldn't this create a loss of
precision, and a problem in how to interpret the results later?

e Store both the upper and lower accumulator to memory. This solves the above
problems, but creates some new ones:

— Extra code space, memory space, and cycle time are used

— How can the result be used as the input to a subsequent calculation? Is such a
condition likely (consider any “feedback” system)?

From this analysis, it is clear that integers do not behave well when multiplied. Might some other
type of number system behave better? Is there a number system where the results of a
multiplication are bounded?

TMS320C28x DSP Workshop - Numerical Concepts & IQmath 8-7



Binary Fractions

Binary Fractions

Given the problems associated with integers and multiplication, consider the possibilities of using
fractional values. Fractions do not grow when multiplied, therefore, they remain representable
within a given word size and solve the problem. Given the benefit of fractional multiplication,
consider the issues involved with using fractions:

e How are fractions represented in two's complement?
e What issues are involved when multiplying two fractions?

Representing Fractions in Binary

In order to represent both positive and negative values, the two's complement process will again
be used. However, in the case of fractions, we will not set the LSB to 1 (as was the case for
integers). When one considers that the range of fractions is from -1 to ~+1, and that the only bit
which conveys negative information is the MSB, it seems that the MSB must be the “negative
ones position.” Since binary representation is based on powers of two, it follows that the next bit
would be the “one-halves” position, and that each following bit would have half the magnitude
again. Considering, as before, a 4-bit model, we have the representation shown in the following
example.

1 ({.]0 1 1 |=-1+14+1/8=-5/8

-1 12 1/4 1/8
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Multiplying Binary Fractions

When the C28x performs multiplication, the process is identical for all operands, integers or

fractions. Therefore, the user must determine how to interpret the results. As before, consider the

4-bit multiply example:

Four-Bit Multiplication

0100 1/2
x 1101 x - 3/8
0100
0000
0100
1100 _—
1110100 -3/16

Accumulator lKl.ll()Q_OO l

Data Memory | l_llOI -1/4

As before, consider the following:
e What are the two input values and the expected result?
o As before, “partial products” are shifted left and the final is negative.

e How is the

result (obtained when adding the partial products) read?

o How shall this result be loaded into the accumulator?
o How shall we fill the remaining bit? Is this value still the expected one?
e How can the result be stored back to memory? What problems arise?

To “read” the result of the fractional multiply, it is necessary to locate the binary point (the base 2
equivalent of the base 10 decimal point). Start by identifying the location of the binary point in
the input values. The MSB is an integer and the next bit is 1/2, therefore, the binary point would
be located between them. In our example, therefore, we would have three bits to the right of the
binary point in each input value. For ease of description, we can refer to these as “Q3” numbers,
where Q refers to the number of places to the right of the point.

When multiplying numbers, the Q values add. Thus, we would (mentally) place a binary point
above the sixth LSB. We can now calculate the “Q6” result more readily.
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As with integers, the results are loaded low, and the MSB is a sign extension of the seventh bit. If
this value were loaded into the accumulator, we could store the results back to memory in a
variety of ways:

e Store both low and high accumulator values back to memory. This offers maximum
detail, but has the same problems as with integer multiply.

e Store only the high (or low) accumulator back to memory. This creates a potential for
a memory littered with varying Q-types.

e Store the upper accumulator shifted to the left by 1. This would store values back to
memory in the same Q format as the input values, and with equal precision to the
inputs. How shall the left shift be performed? Here’s three methods:

— Explicit shift (C or assembly code)
— Shift on store (assembly code)
— Use Product Mode shifter (assembly code)

Correcting Redundant Sign Bit

Correcting Redundant Sign Bit

Accumulator 1 1 1 1 O 1 O OI
;Y_/

Redundant
Sign Bit

¢ Correcting Redundant Sign Bit
+ IQmath: automatically handled (next topic)
+ Q math in “C”, shift in software:
int x,y,z;

z = ((long)x * (long)y) >> 15;
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Fraction Coding

Although COFF tools recognize values in integer, hex, binary, and other forms, they understand
only integer, or non-fractional values. To use fractions within the C28x, it is necessary to describe
them as though they were integers. This turns out to be a very simple trick. Consider the
following number lines:

How is a fraction coded?

~1 = ~ 32K 7FFF ==

Yo == 16K - 4000 =~

0 =~ 9 0000 =
*32768

Yo =+ -16K =+ C000 =+

-] == 32K 8000 ==

Fractions Integers Hex

¢ Example: represent the fraction number 0.707
void main(void) {
int coef = 32768 * 707 / 1000;

}

By multiplying a fraction by 32K (32768), a normalized fraction is created, which can be passed
through the COFF tools as an integer. Once in the C28x, the normalized fraction looks and
behaves exactly as a fraction. Thus, when using fractional constants in a C28x program, the coder
first multiplies the fraction by 32768, and uses the resulting integer (rounded to the nearest whole
value) to represent the fraction.

The following is a simple, but effective method for getting fractions past the assembler:
1. Express the fraction as a decimal number (drop the decimal point).
2. Multiply by 32768.
3. Divide by the proper multiple of 10 to restore the decimal position.
» Examples:

e Torepresent 0.62: 32768 X 62 / 100
e To represent 0.1405: 32768 x 1405 / 10000

This method produces a valid number accurate to 16 bits. You will not need to do the math
yourself, and changing values in your code becomes rather simple.
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Fractional vs. Integer Representation

Fractional vs. Integer

¢ Range

+ Integers have a maximum range
determined by the number of bits

+ Fractions have a maximum range of =1
¢ Precision
+ Integers have a maximum precision of 1

+ Fractional precision is determined by
the number of bits

The C28x accumulator, a 32-bit register, adds extra range to integer calculations, but this
becomes a problem in storing the results back to 16-bit memory.

Conversely, when using fractions, the extra accumulator bits increase precision, which helps
minimize accumulative errors. Since any number is accurate (at best) to + one-half of a LSB,
summing two of these values together would yield a worst case result of 1 LSB error. Four
summations produce two LSBs of error. By 256 summations, eight LSBs are “noisy.” Since the
accumulator holds 32 bits of information, and fractional results are stored from the high
accumulator, the extra range of the accumulator is a major benefit in noise reduction for long
sum-of-products type calculations.
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Implementing complex digital control algorithms on a Digital Signal Processor (DSP), or any
other DSP capable processor, typically come across the following issues:

e Algorithms are typically developed using floating-point math

e Floating-point devices are more expensive than fixed-point devices

o Converting floating-point algorithms to a fixed-point device is very time consuming

e Conversion process is one way and therefore backward simulation is not always possible

The diagram below illustrates a typical development scenario in use today:

So how do we really use all this fraction stuff?
The Fix-Point Development Dilemma

Natural development
starts with simulation in
floating-point

Simulation
Platform
(i.e. MatLab)

Takes many days/weeks
to convert (one way
process)

Can be easily ported
to floating-point
device

Fixed-Point
Algorithm
(ASM, C, C++)

Floating-Point
Algorithm
(C or C++)

Floating-Point DSP

Fix-Point DSP

The design may initially start with a simulation (i.e. MatLab) of a control algorithm, which
typically would be written in floating-point math (C or C++). This algorithm can be easily ported
to a floating-point device, however because of cost reasons, most likely a 16-bit or 32-bit fixed-
point device would be used in many target systems.

The effort and skill involved in converting a floating-point algorithm to function using a 16-bit or
32-bit fixed-point device is quite significant. A great deal of time (many days or weeks) would
be needed for reformatting, scaling and coding the problem. Additionally, the final
implementation typically has little resemblance to the original algorithm. Debugging is not an
easy task and the code is not easy to maintain or document.
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Floating-Point Representation

|IEEE Std. 754 Single Precision
Floating-Point

31 30 23 22 0
| s| eeceeeee | FFFFFFFFFFFFFFFFFFFFFFF
1 bit sign 8 bit exponent 23 bit mantissa (fraction)

Casel: ife=255andf#0, thenv=NaN

Case 2: ife=255andf=0, thenv =[(-1)5]*infinity

Case 3:if 0 < e < 255, then v = [(-1)s]*[2€120]*(1.f)
Case 4:ife=0and f #0, then v = [(-1)5]*[2(120)]*(0.f)
Case5: ife=0andf=0, then v = [(-1)°]*0

Advantage = Exponent gives large dynamic range
Disadvantage = Precision of a number depends on its exponent

Floating-Point does not Solve
Everything!

Example: x=10.0 (0x41200000)
+ y= 0.000000238 (0x347F8CF1)

z=10.000000238  WRONG!

You cannot represent 10.000000238 with
single-precision floating point

0x412000000 = 10.000000000
10.000000238 « can't represent!
0x412000001 = 10.000000950

So z gets rounded down to 10.000000000
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IQ Fractional Representation

A new approach to fixed-point algorithm development, termed “IQmath”, can greatly simplify the
design development task. This approach can also be termed “virtual floating-point” since it looks
like floating-point, but it is implemented using fixed-point techniques.

IQ Fractional Representation

31 0
S 1IN0, FRFFFFFFFFFFFFFFFFFFFFT]

32 bit mantissa

20+ 2+ L+ 20+ 20, 204224+ 420

Advantage = Precision same for all numbers in an 1Q format
Disadvantage = Limited dynamic range compared to floating point

The IQmath approach enables the seamless portability of code between fixed and floating-point
devices. This approach is applicable to many problems that do not require a large dynamic range,
such as motor or digital control applications.
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IQmath Can Solve the Problem!

18Q24 Example: x =10.0 (OXOA000000)
+ y= 0.000000238 (0x00000004)

z =10.000000238 (OxOA000004)

Exact Result (this example)
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Traditional “Q” Math Approach

Traditional 16-bit “Q” Math Approach

y=mx+bhb
Se Q15 | M
— ss, Q30
se Q15 | X
[ sssssssssssss, Q15 |j¢——————s_ Q15 |B
Align Binary
Point For Add
B SS, Q30 |
sly Q30 |
Align Binary
Point For Store
[ ssssssssssssl, Q156 j}———————s, Q15 |Y
in C:|Y = ((i32) M * (i32) X + (i32) B << Q) >> Q; |

Traditional 32-bit “Q” Math Approach

y=mx+bhb
18, Q24 M
—{ 116, Q48
18, Q24 X
[ 18, Q24 +————18, Qo4
@ Align Decimal
Point for Add
o ssss18, Q48 |
116 Q48 |
Align Decimal
@ Point for Store
116, Q24 18, Q24 Y

in C:| Y = ((i64) M * (i64) X + (i64) B << Q) >> Q;|

Note: Requires support for 64-bit integer data type in compiler
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The traditional approach to performing math operations, using fixed-point numerical techniques
can be demonstrated using a simple linear equation example. The floating-point code for a linear
equation would be:

float Y, M, X, B;

Y=M*X+B;

For the fixed-point implementation, assume all data is 32-bits, and that the "Q" value, or location
of the binary point, is set to 24 fractional bits (Q24). The numerical range and resolution for a
32-bit Q24 number is as follows:

Q value Min Value Max Value Resolution

Q24 | -2%29=_128.000 000 00 | 22 _ (15)** = 127.999 999 94 | (%2)** = 0.000 000 06

The C code implementation of the linear equation is:

int32 'Y, M, X, B; // numbers are all Q24
Y = ((int64) M * (int64) X + (int64) B << 24) >> 24;

Compared to the floating-point representation, it looks quite cumbersome and has little resem-
blance to the floating-point equation. It is obvious why programmers prefer using floating-point
math.

The slide shows the implementation of the equation on a processor containing hardware that can
perform a 32x32 bit multiplication, 64-bit addition and 64-bit shifts (logical and arithmetic) effi-
ciently.

The basic approach in traditional fixed-point "Q" math is to align the binary point of the operands
that get added to or subtracted from the multiplication result. As shown in the slide, the multipli-
cation of M and X (two Q24 numbers) results in a Q48 value that is stored in a 64-bit register.
The value B (Q24) needs to be scaled to a Q48 number before addition to the M*X value (low
order bits zero filled, high order bits sign extended). The final result is then scaled back to a Q24
number (arithmetic shift right) before storing into Y (Q24). Many programmers may be familiar
with 16-bit fixed-point "Q" math that is in common use. The same example using 16-bit numbers
with 15 fractional bits (Q15) would be coded as follows:

intlé Y, M, X, B; // numbers are all Q15
Y = ((int32) M * (int32) X + (int32) B << 15) >> 15;

In both cases, the principal methodology is the same. The binary point of the operands that get
added to or subtracted from the multiplication result must be aligned.
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IQmath Approach
32-bit IQmath Approach

y=mx+bhb

18, Q24 M
[116 Q48

18 24
Align Decimall . O X
Point Of Multiply

[ sssssssssssssssssl16, Q24 |

. Q24 B

18 Q24 118, Q24 Y

in C: |Y = ((i64) M * (i64) X) > Q + B;

In the "IQmath™ approach, rather then scaling the operands, which get added to or subtracted
from the multiplication result, we do the reverse. The multiplication result binary point is scaled
back such that it aligns to the operands, which are added to or subtracted from it. The C code
implementation of this is given by linear equation below:

int32 Y, M, X, B;
Y = ((int64) M * (int64) X) >> 24 + B;

The slide shows the implementation of the equation on a processor containing hardware that can
perform a 32x32 bit multiply, 32-bit addition/subtraction and 64-bit logical and arithmetic shifts
efficiently.

The key advantage of this approach is shown by what can then be done with the C and C++ com-
piler to simplify the coding of the linear equation example.

Lets take an additional step and create a multiply function in C that performs the following opera-
tion:

int32 _1Q24mpy(int32 M, int32 X) { return ((int64) M * (int64) X) >> 24; }
The linear equation can then be written as follows:
Y = _1Q24mpy(M , X) + B;

Already we can see a marked improvement in the readability of the linear equation.
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Using the operator overloading features of C++, we can overload the multiplication operand "*"
such that when a particular data type is encountered, it will automatically implement the scaled
multiply operation. Lets define a data type called "ig" and assign the linear variables to this data

type:

iq Y, M, X, B// numbers are all Q24

The overloading of the multiply operand in C++ can be defined as follows:

ig operator * (const iq &M, const iq &X) { return ((int64) M * (int64) X) >> 24; }

Then the linear equation, in C++, becomes:

Y=M*X+B,;

This final equation looks identical to the floating-point representation. It looks "natural”. The
four approaches are summarized in the table below:

Math Implementations

Linear Equation Code

32-bit floating-point math in C Y=M*X+B;

32-bit fixed-point "Q" math in C Y = ((int64) M * (int64) X) + (int64) B << 24) >> 24;

32-bit IQmath in C

Y = _1Q24mpy(M, X) + B;

32-bit IQmath in C++

Y=M*X+B,;

Essentially, the mathematical approach of scaling the multiplier operand enables a cleaner and a
more "natural” approach to coding fixed-point problems. For want of a better term, we call this
approach "1Qmath" or can also be described as "virtual floating-point".
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IQmath Approach
Multiply Operation

| Y = ((i64) M * (i64) X) >> Q + B; |
Redefine the multiply operation as follows:
| _1Qmpy(M,X) == ((i64) M * (i64) X) >> Q |
This simplifies the equation as follows:
| Y = _1Qmpy(M,X) + B; |

C28x compiler supports “_1Qmpy” intrinsic; assembly code generated:

MOVL XT,@M
IMPYL P,XT,@X ; P = low 32-bits of M*X
QMPYL  ACC,XT,@X ; ACC = high 32-bits of M*X
LSL64  ACC:P,#(32-Q) ; ACC = ACC:P << 32-Q

; (same as P = ACC:P >> Q)

ADDL ACC,@B ; Add B
MOVL @Y,ACC ; Result = Y = _IQmpy(M*X) + B
; 7 Cycles

IQmath Approach
It looks like floating-point!

. . float Y, M, X, B;
Floating-Point

Y=M=*X + B;
long Y, M, X, B;

Traditional
Fix-Point Q v = ((i64) M * (i64) X + (i64) B << Q)) >> Q;
uIQmathn _iq Y, M, X, B;
InC Y = _1Qmpy(M, X) + B;
uIQmath” iq Y, M, X, B;
In C++

Y =M* X+ B;

Taking advantage of operator overloading feature in C++,
“IQmath” looks like floating-point math (looks natural!)
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IQmath Approach
GLOBAL_Q simplification

User selects “Global Q" value for the whole application
GLOBAL_Q

[ )
based on the required dynamic range or resolution, for example:
GLOBAL_Q Max Val Min Val Resolution
28 7.999 999 996 -8.000 000 000 | 0.000 000 004
24 127.999 999 94 -128.000 000 00 |0.000 000 06
20 2047.999 999 -2048.000 000 0.000 001

#define GLOBAL Q 18 // set in “IQmathLib.h” file
_iqg Y, M, X, B;
Y = _1Qmpy(M,X) + B; // all values are in Q = 18

The user can also explicitly specify the Q value to use:
_ig20 Y, M, X, B;

Y = _1Q20mpy(M,X) + B; // all values are in Q = 20

The basic "IQmath" approach was adopted in the creation of a standard math library for the Texas
Instruments TMS320C28x DSP fixed-point processor. This processor contains efficient hardware
for performing 32x32 bit multiply, 64-bit shifts (logical and arithmetic) and 32-bit add/subtract
operations, which are ideally suited for 32 bit "IQmath".

Some enhancements were made to the basic "IQmath" approach to improve flexibility. They are:

Setting Of GLOBAL_Q Parameter Value: Depending on the application, the amount of nu-
merical resolution or dynamic range required may vary. In the linear equation example, we used
a Q value of 24 (Q24). There is no reason why any value of Q can't be used. In the "IQmath”
library, the user can set a GLOBAL_Q parameter, with a range of 1 to 30 (Q1 to Q30). All func-
tions used in the program will use this GLOBAL_Q value. For example:

#define GLOBAL_Q 18
Y = _1Qmpy(M, X) + B; // all values use GLOBAL_Q =18

If, for some reason a particular function or equation requires a different resolution, then the user
has the option to implicitly specify the Q value for the operation. For example:

Y = _1Q23mpy(M,X) + B; // all values use Q23, including B and Y

The Q value must be consistent for all expressions in the same line of code.
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IQmath Approach

Targeting Fixed-Point or Floating-Point device

Y = _1Qmpy(M, X) + B;

User selects target math type
< (in “IQmathLib.h” file)

#if MATH_TYPE == 1Q_MATH #1F MATH_TYPE == FLOAT_MATH

U

Y = (float)M * (float)X + (float)B;

Compile & Run
using “IQmath” on
C28x

Compile & Run
using floating-point math on
C3x, C67x,C28x (RTS), PC,..

All “1Qmath” operations have an equivalent floating-point operation

Selecting FLOAT_MATH Or IQ_MATH Mode: As was highlighted in the introduction, we
would ideally like to be able to have a single source code that can execute on a floating-point or
fixed-point target device simply by recompiling the code. The "1Qmath" library supports this by
setting a mode, which selects either IQ_MATH or FLOAT_MATH. This operation is performed
by simply redefining the function in a header file. For example:

#if MATH_TYPE == 1IQ_MATH

#define _1Qmpy(M , X) _IQmpy(M , X)
#elseif MATH_TYPE == FLOAT_MATH
#define _1Qmpy(M , X) (float) M * (float) X
#endif

Essentially, the programmer writes the code using the "1Qmath" library functions and the code
can be compiled for floating-point or "IQmath" operations.
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IQmath Library

IQmath Library: math & trig functions (v1.4)
Operation Floating-Point “IQmath” in C “IQmath” in C++
type float A, B; _ig A, B; iq A, B;
constant A =1.2345 A = _1Q(1.2345) A =1Q(1.2345)
multiply A*B _lIQmpy(A , B) A*B
divide A/B _lQdiv (A, B) A/B
add A+B A+B A+B
substract A-B A-B A-B
boolean > >= < <=, ==, |:, &&, || > >= <, <=, ==, |=, &&, || > >= <, <=, ==, |=, &&, ||
trig sin(A),cos(A) _1Qsin(A), _IQcos(A) 1Qsin(A),IQcos(A)
functions sin(A*2pi),cos(A*2pi) |_IQsinPU(A), _IQcosPU(A) [1QsinPU(A),IQcosPU(A)
atan(A),atan2(A,B) | _IQatan(A), _lQatan2(A,B) | IQatan(A),IQatan2(A,B)
atan2(A,B)/2pi _lQatan2PU(A,B) IQatan2PU(A,B)
sqrt(A),1/sqrt(A) _lQsqrt(A), _IQisqrt(A) 1Qsqrt(A),IQisqrt(A)
sqrt(A*A + B*B) _IQmag(A,B) IQmag(A,B)
saturation if(A > Pos) A = Pos _IQsat(A,Pos,Neg) IQsat(A,Pos,Neg)
if(A < Neg) A = Neg
Accuracy of functions/operations approx ~28 to ~31 bits

Fourier Transforms (FFT & IFFT).

Additionally, the "IQmath” library contains DSP library modules for filters (FIR & IIR) and Fast

IQmath Library: Conversion Functions (v1.4)

Operation Floating-Point “IQmath” in C “IQmath” in C++
ig to igN A _IQtoIQN(A) IQtolQN(A)
igN to iqg A _IQNtolQ(A) IQNtolQ(A)

integer(iq) (long) A _lQint(A) 1Qint(A)

fraction(iq) A —(long) A _IQfrac(A) IQfrac(A)

ig =ig*long A * (float) B _lQmpyI32(A,B) 1Qmpyl32(A,B)

integer(ig*long)

(long) (A * (float) B)

_lQmpyl32int(A,B)

IQmpyl32int(A,B)

fraction(ig*long)

A - (long) (A * (float) B)

_IQmpyl32frac(A,B)

IQmpyl32frac(A,B)

gNtoiq A _QNtolQ(A) QNtolQ(A)
iq to gN A _|IQtoQN(A) IQtoQN(A)
string to iq atof(char) _atolQ(char) atolQ(char)
IQ to float A _IQtoF(A) IQtoF(A)
IQmath.lib > contains library of math functions
IQmathLib.h > C header file
IQmathCPP.h > C++ header file
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16-Bit vs. 32-Bit

The "IQmath" approach could also be used on 16 bit sized numbers and for many problems, this
is sufficient resolution. However, in many control cases, the user needs to use many different
"Q" values to accommodate the limited resolution of a 16-bit number.

With DSP devices like the TMS320C28x processor, which can perform 16 bit and 32 bit sized
math with equal efficiency, the choice becomes more of productivity (time to market). Why
bother spending a whole lot of time trying to code using 16 bit numbers when you can simply use
32 bit numbers, pick one value of "Q" that will accommodate all cases and not worry about
spending too much time optimizing.

Of course there is a concern on data RAM usage if numbers that could be represented in 16 bits
all use 32 bits. This is becoming less of an issue in today's processors because of the finer tech-
nology used and the amount of RAM that can be cheaply integrated. However, in many cases,
this problem can be mitigated by performing intermediate calculations using 32 bit numbers and
converting the input from 16 bit to 32 bit and converting the output from 32 to 16 bit before stor-
ing the final results. In many problems, it is the intermediate calculations that require additional
accuracy to avoid quantization problems.
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AC Induction Motor Example

AC Induction Motor Example
One of the more complex motor control algorithms

AC INDUCTION MOTOR
T FORWARD CONTROL MODEL
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FEEDBACK CONTROL . . % E! [!

Alpha.fis Stator Current Plot

Figure &

¢ Sensorless, ACl induction machine direct rotor flux control
& Goal: motor speed estimation & alpha-axis stator current estimation

The "IQmath" approach is ideally suited for applications where a large numerical dynamic range
is not required. Motor control is an example of such an application (audio and communication
algorithms are other applications). As an example, the IQmath approach has been applied to the
sensor-less direct field control of an AC induction motor. This is probably one of the most chal-
lenging motor control problems and as will be shown later, requires numerical accuracy greater
then 16-bits in the control calculations.

The above slide is a block diagram representation of the key control blocks and their interconnec-
tions. Essentially this system implements a "Forward Control™ block for controlling the d-g axis
motor current using PID controllers and a "Feedback Control” block using back emf's integration
with compensated voltage from current model for estimating rotor flux based on current and volt-
age measurements. The motor speed is simply estimated from rotor flux differentiation and open-
loop slip computation. The system was initially implemented on a "Simulator Test Bench" which
uses a simulation of an "AC Induction Motor Model” in place of a real motor. Once working, the
system was then tested using a real motor on an appropriate hardware platform.

Each individual block shown in the slide exists as a stand-alone C/C++ module, which can be
interconnected to form the complete control system. This modular approach allows reusability
and portability of the code.
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The next few slides shows the coding of one particular block, PARK Transform, using floating-
point and "IQmath" approaches in C and C++:

AC Induction Motor Example
Park Transform - floating-point C code

#include “math.h”
#define TWO_PI 6.28318530717959
void park_calc(PARK *v)

{
float cos_ang , sin_ang;
sin_ang = sin(TWO_PI * v->ang);
cos_ang = cos(TWO_P1 * v->ang);
v->de = (v->ds * cos_ang) + (v->gs * sin_ang);
v->qe = (v->gs * cos_ang) - (v->ds * sin_ang);
3

AC Induction Motor Example
Park Transform - converting to “1Qmath” C code

#include “math.h”
#include “IQmathLib.h”

#define TWO_PI _1Q(6.28318530717959)
void park_calc(PARK *v)
{
_iq cos_ang , sin_ang;
sin_ang = _1Qsin(_1Qmpy(TWO_P1 , v->ang));
cos_ang = _1Qcos(_I1Qmpy(TWO_PI , v->ang));
v->de = _1Qmpy(v->ds , cos_ang) + _I1Qmpy(v->gs , sin_ang);
v->ge = _lQmpy(v->gs , cos_ang) - _IQmpy(v->ds , sin_ang);
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AC Induction Motor Example
Park Transform - converting to “1Qmath” C++ code

#include “math_h”

extern “C” { #include “lIQmathLib.h” }
#include “1QmathCPP_h”

#define TWO_|
void park_calc(PARK *v)

{
iq cos_ang , sin_ang;
sin_ang = 1Qsin(TWO_PI1 * v->ang);
cos_ang = 1Qcos(TWO_P1 * v->ang);
v->de = (v->ds * cos_ang) + (v->Qs * sin_ang);
v->ge = (v->Qs * cos_ang) - (v->ds * sin_ang);
3

pI  1Q(6.28318530717959)

As can be seen, the floating-point C and "1Qmath" C++ code looks almost identical. It is quite a
simple and fast procedure to take any floating-point algorithm and convert it to an "IQmath™ algo-

rithm.

The complete system was coded using "IQmath”. Based on analysis of coefficients in the system,
the largest coefficient had a value of 33.3333. This indicated that a minimum dynamic range of 7
bits (+/-64 range) was required. Therefore, this translated to a GLOBAL_Q value of 32-7 = 25
(Q25). Just to be safe, the initial simulation runs were conducted with GLOBAL_Q = 24 (Q24)

value.
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The code was compiled and run on the Texas Instruments TMS320C28x fixed-point DSP device
(IQ_MATH mode) and on the TMS320C3x floating-point DSP device (FLOAT_MATH mode).
The plots of speed and stator current for both devices matched and are shown below.

The plots start from a step change in reference speed from 0.0 to 0.5 and 1024 samples are taken.
The speed eventually settles to the desired reference value and the stator current exhibits a clean
and stable oscillation. The block diagram slide shows at which points in the control system the

plots are taken from.

AC Induction Motor Exam
GLOBAL_Q = 24, system stable
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AC Induction Motor Example

AC Induction Motor Examp

p———

le
GLOBAL_Q =27, system unstable

[ [=]x]

Dl Blit Yiew freied Dsbug Poofiler QR Opten Dide Suvkes tisls

| | IQmath: speed

L1} = ) W [

£ £ W 1 e =
i

) LN

‘ [I n fI"|||I| || M| I'IIr
‘ |} I|I l‘f‘l/whf || .| ||J\U “f \ |'|J|I |II \f \Jlll ll ||'|||
J

| || ||.|

Illluf\ "l'“ |

V| ||" I '.' " '} \,

IQmath: current

"\ AAAAAAA {r
f

AC Induction Motor Example

GLOBAL_Q =16, system unstable

IQmath current

Win T
Il'ﬁ"_ e MH Ty

TMS320C28x DSP Workshop - Numerical Concepts & IQmath




AC Induction Motor Example

With the ability to select the GLOBAL_Q value for all calculations in the "IQmath", an experi-
ment was conducted to see what maximum and minimum Q value the system could tolerate be-
fore it became unstable. The results are tabulated in the slide below:

AC Induction Motor Example
Q stability range

Q range Stability Range
Unstable
Q31 to Q27 (not enough dynamic range)
Q26 to Q19 Stable
Q18 to Q0 Unstable

(not enough resolution, quantization problems)

The developer must pick the right GLOBAL_Q value!

The above indicates that, the AC induction motor system that we simulated requires a minimum
of 7 bits of dynamic range (+/-64) and requires a minimum of 19 bits of numerical resolution (+/-
0.000002). This confirms our initial analysis that the largest coefficient value being 33.33333
required a minimum dynamic range of 7 bits. As a general guideline, users using 1Qmath should
examine the largest coefficient used in the equations and this would be a good starting point for
setting the initial GLOBAL_Q value. Then, through simulation or experimentation, the user can
reduce the GLOBAL_Q until the system resolution starts to cause instability or performance deg-
radation. The user then has a maximum and minimum limit and a safe approach is to pick a mid-
point.

What the above analysis also confirms is that this particular problem does require some calcula-
tions to be performed using greater then 16 bit precision. The above example requires a mini-
mum of 7 + 19 = 26 bits of numerical accuracy for some parts of the calculations. Hence, if one
were implementing the AC induction motor control algorithm using a 16 bit fixed-point DSP, it
would require the implementation of higher precision math for certain portions. This would take
more cycles and programming effort.

The great benefit of using GLOBAL_Q is that the user does not necessarily need to go into de-
tails to assign an individual Q for each variable in a whole system, as is typically done in conven-
tional fixed-point programming. This is time consuming work. By using 32-bit resolution and the
"IQmath" approach, the user can easily evaluate the overall resolution and quickly implement a
typical digital motor control application without quantization problems.
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AC Induction Motor Example

Using the profiling capabilities of the respective DSP tools, the table above summarizes the num-

AC Induction Motor Example
Performance comparisons

(20kHz control loop)

C28x C C3x C C67x C C67x C
IQmath (-g) | float (-g) | float (-g) |float (no —g)
Benchmark (150MHz) | (75MHz) | (167MHz) | (167MHz)

B1: Forward control cycles 482 308 627 432
B2: ACI model cycles 564 215 321 183
B3: Feedback control cycles 1081 829 1295 973
Key benchmark cycles (B1+B3) 1563 1137 1922 1405

% of available MHz used 20.9% 30.3% 23.0% 16.8%

Notes: C28x compiled on CGT V3.03, V1.4c IQmath Lib (debug enabled (-g), max opt).

C3x compiled on CGT V5.12, RTS30R Lib (debug enabled (-g), max opt).

C67x compiled on CGT V4.20, RTSFast Lib (debug enabled (-g)/disabled, max opt).
On C67x, when debug is enabled (-g), parallel execution of operations are limited.
On C28x & C3x, turning off debug (no —g) has minimal impact on performance.

ber of cycles and code size of the forward and feedback control blocks.

The MIPS used is based on a system sampling frequency of 20kHz, which is typical of such sys-

tems.
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IQmath Appications and Summary
Where Is IQmath Applicable?

Anywhere a large dynamic range is not required

Motor Control (PID, State Estimator, Kalman,...)
Servo Control
Modems
Audio (MP3, etc.)
Imaging (JPEG, etc.)
Any application using 16/32-bit fixed-point Q math

Where it is not applicable

Graphical applications (3D rotation, etc.)

When trying to squeeze every last cycle

IQmath Approach Summary

“IQmath” + fixed-point processor with 32-bit capabilities =

& Seamless portability of code between fixed and floating-
point devices

+ User selects target math type in “IQmathLib.h” file
+ #if MATH_TYPE == IQ_MATH
+ #if MATH_TYPE == FLOAT_MATH
¢ One source code set for simulation vs. target device

¢ Numerical resolution adjustability based on application
requirement

« Setin “IQmathLib.h” file
.+ #define GLOBAL_Q 18
« Explicitly specify Q value
« _iq20 X,Y, Z;
Numerical accuracy without sacrificing time and cycles
¢ Rapid conversion/porting and implementation of algorithms

*

IQmath library is freeware - available from Tl DSP website
http://www.ti.com/c2000
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IQmath Appications and Summary

The 1Qmath approach, matched to a fixed-point processor with 32x32 bit capabilities enables the
following:

Seamless portability of code between fixed and floating-point devices
Maintenance and support of one source code set from simulation to target device
Adjustability of numerical resolution (Q value) based on application requirement
Implementation of systems that may otherwise require floating-point device
Rapid conversion/porting and implementation of algorithms
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Converting ADC Results into 1Q Format

Converting ADC Results into 1Q Format

As you may recall, the converted values of the ADC are placed in the upper 12 bit of the
RESULTO register. Before these values are filtered using the IQmath library, they need to to be
put into the 1Q format as a 32-bit long.

Getting the ADC Result into IQ Format

XIXIXIXIXIXIXIXIXIXIXIX] O] 0] 0] 0] RESULTx

Do not sign extendl

31 15 0
olofofofolojo]ofo]o]ofolofo]ofoixIxIxIXIxIXIX[XIXIXIX|X[0[0]0[0] 32-bitlong

Notice that the 32-bit long is already in 116Q16 format!

#define AdcFsVoltage _1Q(3.0) // ADC full scale voltage
_iq Result, temp; // ADC result
void main(void)
{
// convert the unsigned 16-bit result to unsigned 32-bit
// temp = AdcRegs.-ADCRESULTO;
// convert resulting 1016 to 1Q format
// temp = _1Q16tolQ(temp);
// scale by ADC full-scale range (optional)
// Result = _1Qmpy(AdcFsVoltage, temp);
Result = _1Qmpy(AdcFsVoltage, _1Q16tolQ( (_ig)AdcRegs.ADCRESULTO));

}

For uni-polar ADC inputs (i.e., 0 to 3 V inputs), a conversion to global 1Q format can be achieved
with:

IQresult_unipolar = _1Qmpy(_1Q(3.0),_1Q16tolQ((_iq) AdcRegs.ADCRESULTO0));

How can we modify the above to recover bi-polar inputs, for example +-1.5 volts? One could do
the following to offset the +1.5V analog biasing applied to the ADC input:

IQresult_bipolar =
_1Qmpy(_1Q(3.0),_1Q16tolQ((_ig) AdcRegs. ADCRESULTO0)) - _1Q(1.5);

However, one can see that the largest intermediate value the equation above could reach is 3.0.
This means that it cannot be used with an 1Q data type of 1Q30 (1Q30 range is -2 < x < ~2). Since
the IQmath library supports 1Q types from 1Q1 to 1Q30, this could be an issue in some applica-
tions.

The following clever approach supports 1Q types from 1Q1 to 1Q30:

IQresult_bipolar =
_1Qmpy(_1Q(1.5),_1Q15tolQ((_iq) ((int16) (AdcRegs. ADCRESULTO ” 0x8000))));

The largest intermediate value that this equation could reach is 1.5. Therefore, 1Q30 is easily
supported.
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Lab 8: IQmath FIR Filter

Lab 8: IQmath FIR Filter
» Objective

The objective of this lab is to apply the techniques discussed in module 8 and to become familiar
with 1Qmath programming. In the previous lab, ePWM1A was setup to generate a 2 kHz, 25%
duty cycle symmetric PWM waveform. The waveform was then sampled with the on-chip
analog-to-digital converter. In this lab the sampled waveform will be passed through an IQmath
FIR filter and displayed using the graphing feature of Code Composer Studio.

Lab 8: IQmath FIR Filter

ePWM1 ADC
TB Counter ADCINAO | RESULTO |Qmath
Compare > .
Action Qualifier FIR Filter
connector ¥
wire h

ePWM2 triggering ADC on

period match using SOC A @ data

trigger every 20 ps (50 kHz) memory

ePWM 2
o
£
= CPU copies
o result to
- buffer during
[} - ADC ISR
= :
s \l==
Display
using CCS

> Procedure

Project File

Note: LABS files have been provided as a starting point for the lab and need to be
completed. DO NOT copy files from a previous lab.

1. Aproject named Lab8.pjt has been created for this lab. Open the project by clicking
onProject - Open.. and look in C:\C28x\Labs\Lab8. All Build Options
have been configured like the previous lab. The files used in this lab are:
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Lab 8: IQmath FIR Filter

Main_8.c Labcfg.cmd

Lab.cdb DSP280x_Headers_BI10S.cmd
User 8 9.cmd CodeStartBranch.asm
SysCtrl.c Gpio.c
DSP280x_GlobalVariableDefs.c PieCtrl 5 6 7 8 9.c
Defaultlsr_8.c Adc.c

EPwm_7_8 9 10.c ECap_7_8 9 10.c

Filter.c DelayUs.asm

Project Build Options

2. Setup the include search path to include the IQmath header file. Open the Build
Options and select the Compiler tab. In the Preprocessor Category, find the Include
Search Path (-i) box and add to the end of the line (preceeded with a semicolon to
append this directory to the existing search path):

;eo\tides\c28\1Qmath\clQmath\include

3. Setup the library search path to include the IQmath library. Open the Build Options
and select the linker tab.

a. In the Basic Category, find the Library Search Path (-1) boxand enter:
c:\tidcs\c28\I1Qmath\clQmath\lib
b. Inthe Include Libraries (-1) boxenter: IQmath.lib

Then select OK to save the Bui ld Options.

Include IQmathLib.h

4. Open Lab.h and uncomment the line that includes the 1QmathLib.h header file.
Next, in the Function Prototypes section, uncomment the function prototype for 1Qssfir(),
the 1Q math single-sample FIR filter function.

Inspect User_8 9.cmd

5. Open and inspect User_8_ 9.cmd. First, notice that a section called ““1Qmath’ is
being linked to HOSARAM. The IQmath section contains the IQmath library functions
(code). Second, notice that a section called “IgmathTables™ is being linked to the
BOOTROM with a TYPE = NOLOAD modifier after its allocation. The 1Qmath tables are
used by the 1Qmath library functions. The NOLOAD modifier allows the linker to
resolve all addresses in the section, but the section is not actually placed into the .out
file. This is done because the section is already present in the device ROM (you cannot
load data into ROM after the device is manufactured!). The tables were put in the ROM
by TI when the device was manufactured. All we need to do is link the section to the
addresses where it is known to already reside (the tables are the very first thing in the
BOOT ROM, starting at address 0x3FF000).
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Lab 8: IQmath FIR Filter

Select a Global 1Q value

6.

Open the file cz\tidcs\c28\I1Qmath\clQmath\include\lQmathLib_h.
Confirm that the GLOBAL_Q type (near beginning of file) is set to a value of 24. If it is
not, modify as necessary:

#define GLOBAL_Q 24

Recall that this Q type will provide 8 integer bits and 24 fractional bits. Dynamic range
is therefore -128 < x < +128, which is sufficient for our purposes in the workshop.

IQmath Single-Sample FIR Filter

7.

Open and inspect Defaultlsr_8.c. Notice that the ADCINT_ISR calls the IQmath
single-sample FIR filter function, 1Qssfir(). The filter coefficients have been defined in
the beginning of the file. Now open and inspect the 1Qssfir() function in Filter.c.
This is a simple, unoptimized coding of a basic IQmath single-sample FIR filter.

Build and Load

8.

Click the ““Bui 1d”’ button to build and load the project.

Run the Code — Filtered Waveform

9.

Open a memory window to view some of the contents of the filtered ADC results buffer.
The address label for the filtered ADC results buffer is AdcBufFiltered. Set the Q-Value
to 24 (which matches the 1Q format being used for this variable) and the Format to 32-Bit
Signed Int. We will be running our code in real-time mode, and will have our window
continuously refresh.

Note:

For the next step, check to be sure that the jumper wire connecting PWMZ1A (pin # P8-9)
to ADCINAO (pin # P9-2) is in place on the eZdsp™.

10.

11.

Run the code in real-time mode using the GEL function: GEL - Realtime
Emulation Control - Run_Realtime_with_Reset, and watch the memory
window update. Verify that the ADC result buffer contains updated values.

Open and setup a dual time graph to plot a 50-point window of the filtered and unfiltered
ADC results buffer. Click: View -> Graph -> Time/Frequency.. and set the

following values:
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Display Type

Dual Time

Start Address — upper display

AdcBufFiltered

Start Address — lower display | AdcBuf
Acquisition Buffer Size 50
Display Data Size 50

DSP Data Type

32-bit signed integer

Q-value 24
Sampling Rate (Hz) 50000
Time Display Unit us

Select OK to save the graph options.

12.

13.

The graphical display should show the generated IQmath FIR filtered 2 kHz, 25% duty
cycle symmetric PWM waveform in the upper display and the unfiltered waveform
generated in the previous lab exercise in the lower display. Notice the shape and phase
differences between the waveform plots (the filtered curve has rounded edges, and lags
the unfiltered plot by several samples). The amplitudes of both plots should run from 0

to 3.0.

Open and setup two (2) frequency domain plots — one for the filtered and another for the
unfiltered ADC results buffer. Click: View -> Graph -> Time/Frequency..

and set the following values:

GRAPH #1 GRAPH #2
Display Type FFT Magnitude FFT Magnitude
Start Address AdcBuf AdcBufFiltered
Acquisition Buffer Size 50 50
FFT Framesize 50 50

DSP Data Type

32-bit signed integer

32-bit signed integer

Q-value

24

24

Sampling Rate (Hz)

50000

50000

Select OK to save the graph options.
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Lab 8: IQmath FIR Filter

14. The graphical displays should show the frequency components of the filtered and
unfiltered 2 kHz, 25% duty cycle symmetric PWM waveforms. Notice that the higher
frequency components are reduced using the Low-Pass IQmath FIR filter in the filtered
graph as compared to the unfiltered graph.

15. Fully halt the DSP (real-time mode) by using the GEL function: GEL - Realtime
Emulation Control -> Full _Halt.

End of Exercise
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Lab 8 Reference: IQmath FIR Filter

Bode Plot of Digital Low Pass Filter
Coefficients: [1/16, 4/16, 6/16, 4/16, 1/16]

Sample Rate: 50 kHz
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Using DSP/BIOS

Introduction

This module discusses the basic features of using DSP/BIOS in a system. Scheduling threads,
periodic functions, and the use of real-time analysis tools will be demonstrated.

Learning Objectives

Learning Objectives

¢ Introduction to DSP/BIOS

¢ Scheduling DSP/BIOS threads
¢ Periodic Functions

¢ Real-time Analysis Tools

¢ DSP/BIOS API modules and summary
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Module Topics
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INtroduction t0 DSP/BIOS .......c.oiuiiiiiii bbb bbb et e s 9-3
Scheduling DSP/BIOS TRIEAUS........cuiiiitirieieite ettt bbb sbe et sbeneere 9-5
PEITOAIC FUNCHIONS ..ottt ettt bbb bbbttt b et st nnne 9-10
ReaI-TIME ANAIYSIS TOOIS. ......iitiiiiiieiee ettt b e bbbt e e e e et e b e 9-11
DSP/BIOS API Module and SUMMAKY ........coiiiiiiiiieie ittt et st see b 9-12
L0 92 DSP/BIOS ...ttt bttt h e e bbbt bRtk e e bRt bbb ebe et et e b e 9-13

9-2 TMS320C28x DSP Workshop - Using DSP/BIOS



Introduction to DSP/BIOS

Introduction to DSP/BIOS
Introduction to DSP/BIOS

What is DSP/BIOS?

¢ A full-featured, scalable real-time kernel
+ System configuration tools
+ Preemptive multi-threading scheduler
+ Real-time analysis tools

Why use DSP/BIOS?

¢ Helps manage complex system resources

¢ Integrated with Code Composer Studio IDE
« Requires no runtime license fees

« Fully supported by Tl and is a key component of TlI's
eXpressDSP™ real-time software technology

¢ Uses minimal MIPS and memory (2-8Kw)

DSP/BIOS Configuration Tool ile .cab)

Estimated Data Size: 948 Est. Min. Stack Size [Malls): 272

[ ®§ Global Settings SyStEm Setup TOOIS

*
+ MEM - Memaory Section Manager . .
Eh,',' Tt ko e Handles memory configuration
SH5 - System Settings S — (builds .cmd file), run-time support
&, HOOK - Module Hoak Manager libraries, interrupt vectors, system
=1 Instrumentation setup and reset, etc.

+-[ LOG - Event Log Manager . A
+ STS - Statistics Object Manager Real —TI me An aI yS IS TO (0] I S

*
= QE Scheduling . .
+1-{5 CLK - Clock Manager Allows application to run

+-§8 PRD - Periodic Function Manager uninterrupted while d|sp|ay|ng
+ |||L HWI - Hardware Interrupt Service Routing Manager debug data

+ g SWI - Software Interrupt Manager
-4 TK - Task Manager ¢ Real-Time Scheduler
+ (:] I0L - Idle Function Manager
- g ;;nchmnization X Preemptive tread manager kernel
SEM - Semaphore Manager .
¢ Real-Time l/O

% ME - Mailbox: Manager
":.. QUE - Atornic Queue Manager
&) LK - Resource Lotk Manager — Allows two way communication
= (@ mputjoutpu: _ between threads or between
¢ RTD¥ - Real-Time Data Exchange Settings tal’get and PC hOSt
+- B3 H5T - Host Channel Manager
:'&, PIP - Buffered Pipe Manager

:3_: SI0 - Stream Input and Output Manager
+ @ Device Drivers
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Introduction to DSP/BIOS

Priority

DSP/BIOS Thread Types

HWI & Used to implement ‘urgent’ part of real-time event
& Triggered by hardware interrupt
Hardware Interrupts | ¢ Hwi priorities fixed in hardware

SWI ¢ Use SWI to perform HWI ‘follow-up’ activity
¢ SWI's are ‘posted’ by software
Software Interrupts | o Multiple SWis at each of 15 priority levels

TSK ¢ Use TSK to run different programs concurrently
under separate contexts

Tasks & TSK's enabled by posting ‘semaphore’ (a signal)
IDL & Runs when no service routines are pending
& Runs as an infinite loop, like traditional while loop
Background « All BIOS data transfers to host occur here
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Scheduling DSP/BIOS Threads

*
*

Enabling BIOS — Return from main()

Must delete the endless while() loop
main() returns to BIOS and goes to IDLE thread,

allowing BIOS to schedule events, transfer
information to the host, etc.

BIOS to activate

An endless while() loop in main() will not allow

void main(void)

{

/*** Initialization ***/

/*** Enable global interrupts ***/

// DSP/BIOS will enable global interrupts
/*** Main Loop ***/

// while() loop removed to enable DSP/BIOS

function:

maotitar

Using Hardware

PIE_INT1_6 Properties

General ] Dispatcher |

Mathing -

oK I Cancel |

Help

Interrupts - HWI

HWI manages hardware interrupts

Configuration Tool used to assign
interrupt vectors

DSP/BIOS HWI Dispatcher
performs context save/restore and
BIOS housekeeping

Nested interrupts allow hardware
interrupts to preempt each other

Number of HWI are determined by
the DSP architecture (PIE vector
table)

Interrupt priority fixed by
architecture

Dispatcher allows the use of BIOS functionality in the ISR
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HWI Dispatcher for ISRs

& For non-BIOS code, use the interrupt keyword to declare an ISR
> tells the compiler to perform context save/restore
interrupt void MyHwi(void)
{
}

¢ For DSP/BIOS code, use the Dispatcher to perform the save/restore

> Remove the interrupt keyword from the MyHwi()
> Check the “Use Dispatcher” box when you configure the interrupt
vector in the DSP/BIOS configuration tool
PIE_INT1_6 Properties X

General  Dispatcher I

¥ Use Dispatcher

Aig 000000000
Intermipt Mask IERQO self -

(1] Cancel Help

Using Software Interrupts - SWI

¢ Make each algorithm an independent

Estimated Data Size: 348 Est. Min. Stack Size software interru pt

@ s & SWI scheduling is handled by DSP/BIOS
2 g?.ihed”"“g ¢ HWI function triggered by hardware
+-iE CLK - Clock Manager
+ @ PRD - Periodic Function Manager ¢ SW| fU nction triggered by Software

+- M, HWI - Hardware Interrupt Service

e.g. acall to SWI_post()
B KNL_swi ¢ Why use a SWI?
B PRD_swi . . .
H @EK_Tasmanager # No limitation on number of SWis, and
+§9 10L - Tdie Function Manager priorities for SWis are user-defined
+ g Synchronization
+l-{@] Input/Cutput ¢ SWI can be scheduled by hardware or

software event(s)
¢ Defer processing from HWI to SWI

9-6 TMS320C28x DSP Workshop - Using DSP/BIOS



Scheduling DSP/BIOS Threads

SWI Properties

ADC_swi Properties

B Lab.cdb

b ] Reneral ]
Estimated Data Size: 948 Est. Min. Stack Size [MAL 5] 272
+ @ Syskem comment; (el ke N
< (2 Instrumfentation i I_Adc:va—
—-13® Scheduling

+1-£8 CLK - Clock Manager priciity 1 -
@ PRD - Periodic Function Manager
+1- M HWI - Hardware ™ LS om ot inager rnailboz: 0
3 SWL- Software | ‘What's This?
e agl |000000000
E KML_swi argl: (=00000000
B PRD_swi Cut

7
& TSK - TaskMana  Copy

+- 3 10L - Idle Functic ok, | Cancel | | Help
+ Synchronization
+ InpukiCutput |

Delete

F

+

Rename

#® Propertyvalue view

Managing SWI Priority

¢ Drag and Drop SWiIs to change
priority

¢ Equal priority SWIs run in the

Ord er th at th ey are pOSted Sl - Software Interrupt M anager objects by priority
[0 Priority 14 {Highest)
+ F Instrurnentation Cl Priority 13
=138 scheduling (20 Priority 12
[#-£8 CLK - Clock Manager (21 Priority 11
[+ &’) PRI - Periodic Function Manager D Priority 10
[+ |||I, HWI - Hardware Interrupt Service Routing Manager D Priority 9
- - Software Interrupt Manager [ Priority &
& aDC_swi [ Priority 7
B ML _swi (21 Priority &
B PRD_swi (21 Priority &
#-&2 T5K - Task Manager (21 Priority 4
I+ ﬁ] I0L - Idle Function Manager [Z0 Priority 3
+ E@ Synchronization Cl Priority 2
+ [E InputfCutput =1L Priority 1
B PRD_swi
BE ADC_swi
=[] Priority 0 {Reserved when T5K is enabled)
B KML_swi
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Priority Based Thread Scheduling

post3 rtn

HWI 2 LIV T
(highest) SWI_post(&swi?2);

post2 rtn
HWI 1 N[

p0§t1 rtn
EELEEEE

SWI 3

int2 rtn
. I

SWI1 2

rtn

SWI1 [TTTTTTTITTTT

rtn
MAIN o

intl
IDLE (TS T T T T T T T T T T T T T T TP TI I I I I I T IITTITT T T T T T T
(lowest)

User sets the priority...BIOS does the scheduling

Using Tasks - TSK

¢ DSP/BIOS tasks (TSK) are similar to
SWI, but offer additional flexibility

+ SWIs must run to completion
+ TSKs can be terminated by software

¢ Tradeoffs
+ SWI context switch is faster than TSK
+ TSK module requires more code space
+ TSKs have their own stack

¢ User preference and system needs
usually dictates choice —easy to
use both
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Scheduling DSP/BIOS Threads

SWiIs and TSKs Compared

SWI SWI_post TSK SEM_post

start —
SEM_pend Pause
“run to (blocked
completion” start state)

¢ Similar to hardware interrupt, + SEM_post() readies the TSK

but triggered by SWI_post() which pends on an event
+ All SWI's share system + The event triggers the TSK
software stack to run once and pend

¢ Each TSK has its own stack,
which allows them to pause
(or be terminated)
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Periodic Functions

Using Periodic Functions - PRD

tick
DSP/BIOS e
CLK

period |_| |_| |_|

LED LED LED
¢ Periodic functions are a special type of SWI that are triggered by
DSP/BIOS

¢ Periodic functions run at a user specified rate:
- e.g. LED blink requires 0.5 Hz

¢ Use the CLK Manager to specify the DSP/BIOS CLK rate in
microseconds per “tick”

¢ Use the PRD Manager to specify the period (for the function) in ticks

¢ Allows multiple periodic functions with different rates

Creating a Periodic Function

DSP/BIOS I

period |_| |_| |_|

fur;cl fuﬁcl fuﬁcl

= B¥ Lab.cdb —
eneral |
T8 General ]
Estimated Data Size: 948 Est. Min. Stack Siz
Dbiect Memary:
st I
P [+ @ webem comment

¥ % Instrument ation

: |500
W 1se high resalution time far intemal timings —-(3® scheduling IDB”Ud[“CkS]- | l

Micrasecands/Int[1000.0000 + -5 CLK - Clock Manager mads |continuaus |
v

g Manager | functon: [ Ledeink |

I Directly configure on-chip timer registers

= - M frupt Service aglt |00

, =TTE
+-18F SWI - Software Interrupt Manage
argl: 000000000

+ @ TSK - Task Manager

¥ [:] 0L - Idle Function Manager
+ g Synchronization
+ InputfOutput
PUtOuEp oK | Cancel | |
0K Cancel ‘ |
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Real-time Analysis Tools

Built-in Real-Time Analysis Tools

Gather data on target (3-10 CPU cycles)
Send data during BIOS IDL (100s of cycles)
Format data on host (1000s of cycles)

Data gathering does NOT stop target CPU

M Execution Graph Q@gl

* 6 o o

Vet prD = AT Execution Graph
PRD _swi .
S L + Software logic analyzer
o g e i i =~ & Debug event timing
e and priority

g

CPU Load Graph

& Shows amount of CPU
horsepower being
consumed

Last: 49.90% +0.0 Peak: 71.92%

Built-in Real-Time Analysis Tools

I Statistics View A=E Statistics View

5TS Count Total Max Average

LedBlink_PRO 127 -0.50548e+010 -3 2768:+007 -6.69723e+008 H H

F';D:zww_ 16107 EE1D4SED+3 inst 2?233 inst 2;!;5 73 ’ PrOfI I e ro Utl n eS W/O
ADC_swi 4 83244 4635134184 inst 3300 inst 95917 H

TSK::;?Q i a a ::zl -2147483648 :::I 0.0o h al tl n g t h e C P U
IDL_buswObj 50429 -1.95756e+007 109 -388.181

Bl Message Log Q@E] Message LOG

Log Mame: |trace

26636 AdoSwi count = 50464 ~ & Send debug msgs to host

2697 AdcSwi_ count = 59465 ,

50898 Aot oot = £345E ¢ Doesn’t halt the DSP

2EB33 AdcSwi_count = BI4E7 .. .

26700 AdcSwi_oount = 59458 & Deterministic, low DSP

26701 AdcSwi_count = B3469

26702 AdcSwi_count = 53470 cycle count

e fietent th
ICoWL_Count =

21830 Achwi:count=120134 ¢ More € ICIent t an

21831 AdeSwicount = 120135 e ;

21832 Adﬁsﬂtiﬁﬂﬂt:umas = traditional printf()

LOG_printf(&trace, "AdcSwi_count = %u", AdcSwi_count++);
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DSP/BIOS APl Module and Summary
DSP/BIOS - API Modules

TSK Communication/Synchronization

Instrumentation/Real-Time Analysis

SEM | Semaphores manager
LOG | Message log manager MBX | Mailboxes manager
STS | Statistics accumulator manager LCK | Resource lock manager

TRC | Trace manager
RTDX| Real-Time Data eXchange manager

Device-Independent Input/Output

PIP Data pipe manager

HST | Host input/output manager
HWI Hardware interrupt manager SIO Stream /0 manager

SWI | Software interrupt manager DEV | Device driver interface
TSK | Multi-tasking manager

IDL Idle function & process loop manager

Thread Types

Memory and Low-Level Primitives

MEM | Memory manager

SYS | System services manager
CLK | System clock manager QUE | Queue manager

PRD | Periodic function manager ATM | Atomic functions

GBL | Global setting manager

Clock and Periodic Functions

Summary and Benefits of DSP/BIOS

¢ Fast time to market
+ no need to develop or maintain a “home-brew” kernel
¢ Efficient debugging of real-time applications
+ Real-Time Analysis
¢ Create robust applications
«+ industry proven kernel technology
¢ Reduce cost of software maintenance
» code reuse and standardized software
¢ Standardized APIs
» enable rapid migration across C28x TMS320 DSPs
¢ Small footprint (2-8Kw)
+ easily fits in limited memory space
¢ Set of library functions (scalable)
+ use only what is needed to minimize code and data size
¢ Full featured kernel (extensible)
« allows additional OS functions in future
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Lab 9: DSP/BIOS
» Objective
The objective of this lab is to apply the techniques discussed in module 9 and to become familiar
with DSP/BIOS. In this lab exercise, we are going to change the ADCINT_ISR HWI to a SWI.

Then, we will replace the LED blink routine with a Periodic Function. Also, some features of the
real-time analysis tools will be demonstrated.

Lab 9: DSP/BIOS

ePWM1 ADC
TB Counter ADCINAO RESULTO
Action Qualifier

IQmath
FIR Filter

connector f
wire f
e | (”) data
trigger every 20 ps (50 kHz) memory
ePWM2
2
Ob|ect|ve: g ge%tgnc?iés
& Change ADCINT_ISR g - AbCisk
HWI to SWI 5 -
¢ Replace LED blink Episplay
routine with a using CCS

Periodic Function

It will be interesting to investigate the DSP computational burden of the various parts of our
application, as well as the different pieces of DSP/BIOS that we will be using in this lab.

The ‘CPU Load Graph’ feature of DSP/BIOS will provide a quick and easy method for doing
this. We will be tabulating these results in the table that follows at various steps throughout the
remainder of this lab.
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Table 9-1: CPU Computational Burden Results

Case # Description CPU Load %

1 ADC processing handled in HWI. Filter inactive.

2 Case #1 + filter active.

3 ADC processing handled in SWI. Filter active.
LED blink handled in HWI.
RTA Global Host Enable disabled.

4 Case #3 + LED blink handled in PRD.

5 Case #4 + LOG_printf in SWI.

6 Case #5 + RTA SWI Logging enabled.

7 Case #6 + RTA SWI Accumulators enabled.
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Lab 9: DSP/BIOS

» Procedure

Project File

Note: LABO9 files have been provided as a starting point for the lab and need to be
completed. DO NOT copy files from a previous lab.

1. A project named Lab9.pjt has been created for this lab. Open the project by clicking
onProject > Open.. and look in C:\C28x\Labs\Lab9. All Build Options
have been configured like the previous lab. The files used in this lab are:

Main_9.c Labcfg.cmd

Lab.cdb DSP280x_Headers_B10S.cmd
User 8 9.cmd CodeStartBranch.asm
SysCtrl.c Gpio.c
DSP280x_GlobalVariableDefs.c PieCtrl 5 6 7 8 9.c
Defaultlsr_9.c Adc.c

EPwm_7_8 9 10.c ECap_7_8 9 10.c

Filter.c DelayUs.asm

Configuring DSP/BIOS Global Settings

2. Open the configuration file Lab . cdb and click on the plus sign (+) to the left of
System. Rightclick on Global Settings andselect Properties. Change
the “DSP Speed in MHz (CLKOUT)” field to 100 so that it matches the processor
speed. Click OK to save the value and close the configuration window and select YES to
save the change to Lab.cdb. This value is used by the CLK manager to calculate the
register settings for the on-chip timers and provide the proper time-base for executing
CLK functions.

Prepare main() for DSP/BIOS

3. Open Main_9.c and delete the inline assembly code from main() that is used to enable
global interrupts. DSP/BIOS will enable global interrupts after main().

4. InMain_9.c, remove the endless while() loop from the end of main(). When using
DSP/BIOS, you must return from main(). In all DSP/BIOS programs, the main()
function should contain all one-time user-defined initialization functions. DSP/BIOS will
then take-over control of the software execution.

Build and Load
5. Click the “Bui 1d” button to build and load the project.
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Run the Code — HWI() Implementation

At this point, we have modified the code so that DSP/BIOS will take control after main()
completes. However, we have not made any other changes to the code since the previous lab.
Therefore, the computations we want performed in the ADCINT_ISR() (e.g., reading the ADC
result, running the filter) are still taking place in the hardware ISR, or to use DSP/BIOS
terminology, the HWI.

6. We will be running our code in real-time mode, and will have our window continuously
refresh. Run in Real-time Mode using the GEL function: GEL - Realtime
Emulation Control 2> Run_Realtime with_ Reset.

Note: For the next step, check to be sure that the jumper wire connecting PWMZ1A (pin # P8-9)
to ADCINAQO (pin # P9-2) is still in place on the eZdsp™.

7. Open and setup a dual time graph to plot a 50-point window of the filtered and unfiltered
ADC results buffer. Click: View - Graph - Time/Frequency.. and set the
following values:

Display Type Dual Time
Start Address — upper display | AdcBufFiltered
Start Address — lower display | AdcBuf
Acquisition Buffer Size 50
Display Data Size 50
DSP Data Type 32-bit signed integer
Q-value 24
Sampling Rate (Hz) 50000
Time Display Unit us
Select OK to save the graph options.

8. The graphical display should show the generated IQmath FIR filtered 2 kHz, 25% duty
cycle symmetric PWM waveform in the upper display and the unfiltered waveform
generated in the previous lab exercise in the lower display. The results should be the
same as the previous lab.

Fully halt the DSP (real-time mode) by using the GEL function: GEL - Realtime
Emulation Control -> Full _Halt.
9. Open the RTA Control Panel by clicking DSP/BIOS -> RTA Control Panel.

Uncheck ALL of the boxes. This disables most of the realtime analysis tools. We will
selectively enable them later in the lab.

TMS320C28x DSP Workshop - Using DSP/BIOS



Lab 9: DSP/BIOS

10.

11.

12.

13.

14.

15.
16.

Open the CPU Load Graph by clicking DSP/BIOS - CPU Load Graph. The CPU
load graph displays the percentage of available CPU computing horsepower that the
application is consuming. The CPU may be running ISRs, software interrupts, periodic
functions, performing 1/0O with the host, or running any user routine. When the CPU is
not executing user code, it will be idle (in the DSP/BIOS idle thread).

Run the code (real-time mode) by using the GEL function: GEL -> Realtime
Emulation Control - Run_Realtime_with_Reset.

This graph should start updating, showing the percentage load on the DSP CPU. Keep
the DSP running to complete steps 11 through 14.

Open and inspect Defaultlsr_9._c. Notice that the global variable DEBUG_FILTER
is used to control the FIR filter in ADCINT _ISR(). If DEBUG_FILTER =1, the FIR
filter is called and the AdcBufFilter array is filled with the filtered data. On the other
hand, if DEBUG_FILTER = O, the filter is not called and the AdcBufFilter array is
filled with the unfiltered data.

Open the watch window and add the variable DEBUG_FILTER to it. Change its value
to “0” to turn off the FIR filtering. Notice the decrease in the CPU Load Graph.

Record the value shown in the CPU Load Graph under “Case #1” in Table 9-1.

Change the value of DEBUG_FILTER back to “1” in the watch window in order to bring
the FIR filter back online. Notice the jump in the CPU Load Graph.

Record the value shown in the CPU Load Graph under “Case #2” in Table 9-1.

Fully halt the DSP (real-time mode) by using the GEL function: GEL - Realtime
Emulation Control -> Full _Halt.

Create a SWI

17.

18.

Open Main_9.c and notice that space has been added at the end of main() for two new
functions which will be used in this module — AdcSwi() and LedBlink(). In the next few
steps, we will move part of the ADCINT_ISR() routine from Defaultlsr_9.c to this
space in Main_9.c.

Open Defaultlsr_9.c and locate the ADCINT _ISR() routine. Move the entire
contents of the ADCINT_ISR() routine to the AdcSwi() function in Main_9 . c with the
following exceptions:

DO NOT MOVE:

e The instruction used to acknowledge the PIE group interrupt.
e The GPIO pin toggle code.

e The LED toggle code.
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19.

20.

Be sure to move the static local variable declaration at the top of ADCINT_ISR() that is
used to index into the ADC buffers.

Comment: In almost all appplications, the PIE group acknowledge code is left in the HWI
(rather than move it to a SWI). This allows other interrupts to occur on that PIE group
even if the SWI has not yet executed. On the other hand, we are leaving the GPIO and
LED toggle code in the HWI just as an example. It illustrates that you can post a SWI
and also do additional operations in the HWI. DSP/BIOS is extremely flexible!

Open Defaultlsr_9.c and locate the section header comment:
/*** Global variables used by ADC ISR() ***/.

Move the entire section contents that follow (e.g., all of the global variables, constant
definitions, and filter coefficients) to the space provided in Main_9.c, with the
following exception:

DO NOT MOVE:

e The variable definition for DEBUG_TOGGLE.

Delete the interrupt key word from the ADCINT _ISR. The interrupt keyword is not
used when a HWI is under DSP/BIOS control. A HWI is under DSP/BIOS control when
it uses any DSP/BIOS functionality, such as posting a SWI, or calling any DSP/BIOS
function or macro.

Post a SWiI

21.

In Defaultlsr_9.c add the following SWI_post to the ADCINT _ISR(), just after the
structure used to acknowledge the PIE group:

SWI1_post(&ADC_swi); // post a SWI

This posts a SWI that will execute the ADC_swi() code you populated a few steps back
in the lab. In other words, the ADC interrupt still executes the same code as before.
However, most of that code is now in a posted SWI that DSP/BIOS will execute
according to the specified scheduling priorities.

Add the SWI to the CDB File

22.

23.

In the configuration file Lab . cdb we need to add and setup the AdcSwi() SWI. Open
Lab.cdb and click on the plus sign (+) to the left of Schedul ing and again on the
plus sign (+) to the left of SWI — Software Interrupt Manager.

Right click on SWI — Software Interrupt Manager and select Insert SWI.
SWI0 will be added. Right-click on it, and rename it to ADC_swi. This is just an
arbitrary name. We want to differentiate the AdcSwi() function itself (which is nothing
but an ordinary C function) from the DSP/BIOS SWI object which we are calling
ADC_swi.
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24. Select the Properties for ADC_swi and type _AdcSwi (with a leading underscore)
in the function field. Click OK. This tells DSP/BIOS that it should run the function
AdcSwi() when it executes the ADC_swi SWI.

25. We need to have the PIE for the ADC interrupt use the dispatcher. The dispatcher will
automatically perform the context save and restore, and allow the DSP/BIOS scheduler to
have insight into the ISR. You may recall from an earlier lab that the ADC interrupt is
located at PIE_INT1_6.

Click on the plus sign (+) to the left of HWI — Hardware Interrupt Service
Routine Manager. Click the plus sign (+) to the left of PIE INTERRUPTS. Locate
the interrupt location for the ADC: PIE_INT1_6. Right click, select Properties, and
select the Dispatcher tab.

Now check the “Use Dispatcher” box and select OK. Close the configuration file
and click YES to save changes.

Build and Load
26. Click the “Bui 1d”” button to rebuild and load the project.

Run the Code — AdcSwi()

27. Run the code (real-time mode) by using the GEL function: GEL - Realtime
Emulation Control 2> Run_Realtime with Reset.

28. Confirm that the graphical display is showing the correct results. The results should be
the same as before (i.e., filtered PWM in the upper graph, unfiltered PWM in the lower

graph).
29. Record the value shown in the CPU Load Graph under “Case #3” in Table 9-1.

30. Fully halt the DSP (real-time mode) by using the GEL function: GEL -> Realtime
Emulation Control > Full Halt.

Add a Periodic Function

Recall that an instruction was used in the ADCINT _ISR to toggle the LED on the eZdsp™. This
instruction will be moved into a periodic function that will toggle the LED at the same rate.

31. Open Defaultlsr_9.c and locate the ADCINT _ISR routine. Move the instruction
used to toggle the LED to the LedBlink() function in Main_9.c:

GpioDataRegs.GPBTOGGLE .bit.GPI1034 = 1; // Toggle the pin

Now delete from the ADCINT _ISR() the code used to implement the interval counter for
the LED toggle (i.e., the GP1034_count++ loop), and also delete the declaration of the
GP1034_count itself from the beginning of ADCINT _ISR(). These are no longer
needed, as DSP/BIOS will implement the interval counter for us in the periodic function
configuration (next step in the lab).
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32. In the configuration file Lab . cdb we need to add and setup the LedBlink_PRD. Open
Lab.cdb and click on the plus sign (+) to the left of Schedul ing. Right click on
PRD — Periodic Function Manger and select Insert PRD. PRDO will be
added. Right-click on it and rename it to LedBl ink_PRD.

Select the Properties for LedBlink_PRD and type _LedBlink (with a leading
underscore) in the function field. This tells DSP/BIOS to run the LedBlink() function
when it executes the LedBlink_PRD periodic function object.

Next, in the period (ticks) field type 500. The default DSP/BIOS system timer
increments every 1 millisecond, so what we are doing is telling the DSP/BIOS scheduler
to schedule the LedBlink() function to execute every 500 milliseconds. A PRD object is
just a special type of SWI which gets scheduled periodically and runs in the context of
the SW1 level at a specified SWI priority. Click OK. Close the configuration file and
click YES to save changes.

Build and Load
33. Click the ““Bui 1d” button to rebuild and load the project.

Run the Code — LedBlink_PRD

34. Run the code (real-time mode) by using the GEL function: GEL -> Realtime
Emulation Control -> Run_Realtime_with_Reset, and check to see if the
LED on the eZdsp™ is blinking.

35. Record the value shown in the CPU Load Graph under “Case #4” in Table 9-1.

36. When done, fully halt the DSP (real-time mode) by using the GEL function: GEL -
Realtime Emulation Control - Full_Halt. If youwould like, experiment
with different period (tick) values and notice that the blink rate changes.

DSP/BIOS — Real-time Analysis Tools

The DSP/BIOS analysis tools complement the CCS environment by enabling real-time program
analysis of a DSP/BIOS application. You can visually monitor a DSP application as it runs with
essentially no impact on the application’s real-time performance. In CCS, the DSP/BIOS realt-
time analysis (RTA) tools are found on the DSP/BIOS menu. Unlike traditional debugging,
which is external to the executing program, DSP/BIOS program analysis requires that the target
program be instrumented with analysis code. By using DSP/BIOS APIs and objects, developers
automatically instrument the target for capturing and uploading real-time information to CCS
using these tools.

We have actually been already using one piece of the RTA tools in this lab: the CPU Load Graph.
We will now utilize two other basic items from the RTA toolbox.

37. In the next few steps the Log Event Manager will be setup to capture an event in real-
time while the program executes. We will be using LOG_printf() to write to a log
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buffer. The LOG_printf() function is a very efficient means of sending a message
from the code to the CCS display. Unlike an ordinary C-language printf(), which can
consume several hundred DSP cycles to format the data on the DSP before transmission
to the CCS host PC, a LOG_printf() transmits the raw data to the host. The host then
formats the data and displays it in CCS. This consumes only 10’s of cycles rather than
100’s of cycles.

Add the following to Main_9.c just after the static local variable declaration in
AdcSwi():

static Uint32 AdcSwi_count=0; // used for LOG printf
/*** Using LOG_printf() to write to a log buffer ***/

LOG_printf(&trace, "AdcSwi_count = %u', AdcSwi_count++);

38. In the configuration file Lab . cdb we need to add and setup the trace buffer. Open
Lab.cdb and click on the plus sign (+) to the left of Instrumentation and again on
the plus sign (+) to the left of LOG — Event Log Manager.

39. Right click on LOG — Event Log Manager and select Insert LOG. LOGO will
be added. Right-click on it and rename it to trace.

40. Select the Properties for trace and set the logtype to circular and the datatype to
printf. Click OK. Close the configuration file and click YES to save changes.

41. Since the configuration file was modified, we need to rebuild the project. Click the
“Bui 1d” button.
Run the Code — Realtime Analysis Tools

42. Run the code (real-time mode) by using the GEL function: GEL -> Realtime
Emulation Control > Run_Realtime with Reset.

43. Open the Message Log. On the menu bar, click:
DSP/BI0S > Message Log

The message log dialog box is displaying the commanded LOG_printf() output, i.e. the
number of times (count value) that the AdcSwi() has executed.

44. Verify that all the check boxes in the RTA Control Panel window are still unchecked
(from step 9). Then, check the box marked “Global Host Enable.” This is the main
control switch for most of the RTA tools. We will be selectively enabling the rest of the
check boxes in this portion of the exercise.

45. Record the value shown in the CPU Load Graph under “Case #5” in Table 9-1.

46. Open the Execution Graph. On the menu bar, click:
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47.

48.

49.

50.

51.

DSP/BIOS - Execution Graph

Presently, the execution graph is not displaying anything. This is because we have it
disabled in the RTA Control Panel.

In the RTA Control Panel, check the top four boxes to enable logging of all event types to
the execution graph. Notice that the Execution Graph is now displaying information
about the execution threads being taken by your software. This graph is not based on
time, but the activity of events (i.e. when an event happens, such as a SWI or periodic
function begins execution). Notice that the execution graph simply records DSP/BIOS
CLK events along with other system events (the DSP/BIOS clock periodically triggers
the DSP/BIOS scheduler). As a result, the time scale on the execution graph is not linear.

The logging of events to the execution graph consumes CPU cycles, which is why the
CPU Load Graph jumped as you enabled logging.

Record the value shown in the CPU Load Graph under “Case #6” in Table 9-1.
Open the Statistics View window. On the menu bar, click:
DSP/BI0OS - Statistics View

Presently, the statistics view window is not changing with the exception of the statistics
for the IDL_busyObj row (i.e., the idle loop). This is because we have it disabled in the
RTA Control Panel.

In the RTA Control Panel, check the next five boxes (i.e., those with the word
“Accumulator” in their description) to enable logging of statistics to the statistics view
window. The logging of statistics consumes CPU cycles, which is why the CPU Load
Graph jumped as you enabled logging.

Record the value shown in the CPU Load Graph under “Case #7” in Table 9-1.

Table 9-1 should now be completely filled in. Think about the results. Your instructor
will discuss them when the lecture starts again.

Fully halt the DSP (real-time mode) by using the GEL function: GEL - Realtime
Emulation Control -> Full_Halt.

Note:

In this module only the basic features of DSP/BIOS and the real-time analysis tools have
been used. For more information and details, please refer to the DSP/BIOS user’s
manuals and other DSP/BIOS related training.

End of Exercise
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Table 9-2: CPU Computational Burden Results (Solution)

Case # Description CPU Load %
1 ADC processing handled in HWI. Filter inactive. 8
2 Case #1 + filter active. 21
3 ADC processing handled in SWI. Filter active. 46

LED blink handled in HWI.
RTA Global Host Enable disabled.

4 Case #3 + LED blink handled in PRD. 46
5 Case #4 + LOG_printf in SWI. 49
6 Case #5 + RTA SWI Logging enabled. 60
7 Case #6 + RTA SWI Accumulators enabled. 71
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System Design

Introduction

This module discusses various aspects of system design. Details of the emulation and analysis
block along with JTAG will be explored. Flash memory programming and the Code Security
Module will be described.

Learning Objectives

Learning Objectives

¢ Emulation and Analysis Block

¢ Flash Configuration and
Memory Performance

¢ Flash Programming

¢ Code Security Module (CSM)
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Module Topics
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Emulation and Analysis Block

Emulation and Analysis Block

JTAG Emulation System
(based on IEEE 1149.1 Standard)

System Under Test

SCAN IN

Emulator
Pod

Texas Instrumants

Some Available Emulators

Sighum System JTAGjet-TMS-C2000
Spectrum Digital XDS510PP+
Spectrum Digital XDS510USB
Spectrum Digital PCI

BlackHawk USB ) b
DSP Research PCI/ USB / PCMCIA SCAN OUT

v

MO >mI

Taxos Instrumants

Connections Between Emulator and
v Target
Vcc

JTAG Device % % % Emulator Header

EMUO| e 13 EMUO PD >

14
EMU1 EMU1

- 2| —— 4
TRST TRST GND

TMS—< s GND |2

8
I _4 3] 1pi GND

10
TDO ’ I oo GND
11 12
TCK ’ TCK GND
9 v
L’ TCK_RET
GND
-: If distance between device and header is greater than 6 inches
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Emulation and Analysis Block

Multiprocessor Connections

JTAG Device JTAG Device
—t TDO TDI [—] TDO TDI
uxl533 |wvl;SS
=0l 2= =0 ==
FF|F Wi = Wwuw

(C

P

«

7

Vcc
Vcc
Emulator Header
'|> 13 | Emuo PD 2
~_ 14
> EMU1
2 | —— 4
TRST GND
1 6
<,‘ T™S GND
8
<,‘ SHENY GND
7 10
> TDO  GND
o 11 12
< TCK GND
9 | TCcK_RET GND

On-Chip Emulation Analysis Block:
Capabilities

Two hardware analysis units can be configured to provide
any one of the following advanced debug features:

Analysis Configuration

Debug Activity

2 Hardware Breakpoints —> Halton aspecified instruction
(for debugging in Flash)

2 Address Watchpoints —> A memory location is getting
corrupted. Halt the processor when
any value is written to this location

1 Address Watchpoint with Data ——» Halt program execution after a
specific value is written to a variable

1 Pair Chained Breakpoints —> Halt on a specified instruction only

after some other specific routine has
executed

10-4
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On-Chip Emulation Analysis Block:
Hardware Breakpoints

Instuction Breakpoint | Bus Address Moritor | 132 Bit Counter | 216 Bit Counlers | Action | /_ Sy mbolic or
numeric address

Instruction breakpaoints and don't cares

Mask value for
Frogram address or expression: | ADCINT_ISA ifvi
% Enable AT breakpaint / specitying
Eit rumber 213 15 il 2 30 address ranges
Binary representation 11 11101001 0011 1101 1111
Dont cares R

Chained breakpoints
[ Chain breakpoints (will enable AU2 breakpaint)
[ Clear mark tag

Start address (U2} |9

End address [AU1). _ADCINT_ISR \

[——~—— Chained

breakpoint
selection

1] Cancel Help

On-Chip Emulation Analysis Block:
Watchpoints

Insttuction Brsakpoint  Bus Adsress Moritor | 132 Bit Counter | 216 Bit Counters | Acton | /_ Symbolic or
numeric address

Manitar

Bus address and don't cares

/_ Mask value for
Bus address or expression; |_AdcBuf . .
specifying

Bit number. 2118 15 11 7 3 o

Binary reprasentation 00 0000 0000 0100 11000000 address ranges
Dt csres Frr I I I rrrrrrrr
whatch for

C Daemenoyiends @ Deamenoputes @ et Bus selection

" Progiam memory reads ¢ Program memary wiites

I™ Watch for bus data contents (requires AL12) (\

[ Address with Data
selection

0K Cancel Help

TMS320C28x DSP Workshop - System Design 10-5



Emulation and Analysis Block

On-Chip Emulation Analysis Block:
Online Stack Overflow Detection

¢ Emulation analysis registers are accessible to code as well!

¢ Configure a watchpoint to monitor for writes near the end of
the stack

¢ Watchpoint triggers maskable RTOSINT interrupt

¢ Works with DSP/BIOS and non-DSP/BIOS
« See Tl application report SPRA820 for implementation details

Region of Stack grows
memory towards higher
occupied memory
by the addresses
stack Monitor for data

writes in region near
the end of the stack

Data Memory
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Flash Configuration and Memory Performance

Flash Configuration and Memory Performance

Basic Flash Operation

¢ Flashis arranged in pages of 2048 bits

¢ Wait states are specified for consecutive accesses within a page,
and random accesses across pages

¢ OTP has random access only

¢ Must specify the number of SYSCLKOUT wait-states;
Reset defaults are maximum values

¢ Flash configuration code should not be run from the Flash memory

15 12 11 8 7 4 3 0

FlashRegs.FBANKWAIT reserved PAGEWAIT reserved RANDWAIT

15 4 3 0

FlashRegs.FOTPWAIT reserved OTPWAIT

*** Refer to the F280x datasheet for detailed numbers ***
For 100 MHz, PAGEWAIT = 3, RANDWAIT = 3, OTPWAIT =5

Speeding Up Code Execution in Flash:

Flash Pipelining (for code fetch only)

l«— 16—

16 or 32
le—— 64—l (ispatched
64 C28x Core
decoder unit
Aligned 2-level deep
64-bit fetch buffer
fetch

Flash Pipeline Enable
0 = disable (default)

1 =enable
FlashRegs.FOPT.bit.ENPIPE = 1;
15 1 0
reserved ENPIPE

TMS320C28x DSP Workshop - System Design
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Flash Configuration and Memory Performance

L 4

Defaults for these registers are often sufficient — See “TMS320F28x DSP
System Control and Interrupts Reference Guide,” SPRUQ78, for more information

Other Flash Configuration Registers
FlashRegs.name

Address | Name Description

0x00 OA80 | FOPT Flash option register

0x00 0A82 | FPWR Flash power modes registers

0x00 OA83 | FSTATUS Flash status register

0x00 0A84 | FSTDBYWAIT | Flash sleep to standby wait register

0x00 0A85| FACTIVEWAIT | Flash standby to active wait register
0x00 0A86 | FBANKWAIT Flash read access wait state register
0x00 0A87 | FOTPWAIT OTP read access wait state register

FPWR: Save power by putting Flash/OTP to ‘Sleep’ or ‘Standby’
mode; Flash will automatically enter active mode if a Flash/OTP

access is made

FSTATUS: Various status bits (e.g. PWR mode)
FSTDBYWAIT: Specify number of cycles to wait during wake-up

from sleep to standby

FACTIVEWAIT: Specify number of cycles to wait during wake-up

from standby to active

Code Execution Performance

¢ Assume 100 MHz SYSCLKOUT, 16-bit instructions

(80% of instructions are 16 bits wide — Rest are 32 bits)

Internal RAM: 100 MIPS

Fetch up to 32-bits every cycle = 1 instruction/cycle * 100 MHz = 100 MIPS

Flash (w/ pipelining): 100 MIPS

RANDWAIT =3

Fetch 64 bits every 4 cycles = 4 instructions/4 cycles * 100 MHz = 100 MIPS
RPT will increase this; PC discontinuities and 32 bit instructions will degrade this
Benchmarking in control applications has shown actual performance of about 85 MIPS

10-8
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Data Access Performance

¢ Assume 100 MHz SYSCLKOUT (CPU clock)

Memory 16-bit access 32-bit access Notes
(words/cycle) | (words/cycle)
Internal RAM 1 1
Flash 0.25 0.25 RANDWAIT =3
Flash is read only!

¢ Flash performance usually sufficient for most constants and tables
¢ Useinternal RAM for time-critical constants

¢ The performance executing from Flash (as discussed on the
pervious slide) will be reduced when that code accesses data
located in Flash
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Flash Programming

Flash Programming

Flash Programming Basics

¢ The DSP CPU itself performs the flash programming
¢ The CPU executes Flash utility code from RAM that reads the
Flash data and writes it into the Flash
¢ We need to get the Flash utility code and the Flash data into RAM
FLASH (&= CPU
————->|Emulator |—-> JTAG |— ———————— > ST
—————— >Rs232 |- > sCI [-- .
------------ > SPI F--> )
s 8 Ry
———————————— > 12C I—---> S % ---
------------ > eCAN i—---) @
A
>E' F280x DSP
Flash Programming Basics
& Sequence of steps for Flash programming:
Algorithm Function
1. Erase - Set all bits to zero, then to one
2. Program - Program selected bits with zero
3. Verify - Verify flash contents
¢ Minimum Erase size is a sector (4AKw/8Kw/16Kw)
¢ Minimum Program size is a bit!
¢ Important not to lose power during erase step:
If CSM passwords hapPen to be all zeros, the
CSM will be permanently locked!
L 4

Chance of this happeningbis quite small! (Erase
step is performed sector by sector)

10-10
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Flash Programming

Flash Programming Utilities

Code Composer Studio Plug-in (uses JTAG)
Third-party JTAG utilities

+ SDFlash JTAG from Spectrum Digital (requires SD emulator)
+ Signum System Flash utilities (requires Sighum emulator)
SDFlash Serial utility (uses SCI boot)
Gang Programmers (use GPIO boot)

+ BP Micro programmer

+ Data /O programmer
Build your own custom utility

+ Use a different ROM bootloader method than SCI

« Embed flash programming into your application
« Flash APl algorithms provided by TI

* Tl web has links to all utilities (http://www.ti.com/c2000)

DSCCLK (Mhz):

PLLCR “alue:

Key 4 (IwAE4]
Ky 3 (AE 3}
Key 2 [IwAE 2}
Key 1 (4E1)
Key O (0x4E0}

ek |

Key 7 (D48E 7]
Key B (44E6)
Key 5 (04E5}

Clock Configuration

20.000

m -

SYSCLKOUT (MHZ): [100.0000

Code Securty Password

FFF

E] D E =
o | 71| A 3@ T A
.| Al 7 A A T A
=i A A A A A A

Lock

Program Password

Flash Programmer Settings... ‘

Code Composer Studio Flash Plug-In

0On-Chip Flash Programmer

Erase Sector Selection -
v Sector A: (3F4000-3F7FFF)
W SectorB: (3F0000-3F3FFF)
W Sector C: [3ECO00-3EFFFF)
W Sector D: [3EB000-3EBFFF)
5

=
=
=
e
e

Operation
Flease specify the COFF file to ProgramAferify:

C:AC28:ALABS Labl 0MDebughLabl0.out

Browse...

* Erase, Program, Verfy  © Depletion Recovery

" Erase Only " Frequency Test
" Program, Yerify Fegister: l—_|
" Program Only Pin: ’—4|
© erity Only
Flash Randam Wait State: |15 7| ¢ Caleulate Checksums
Flash Page \Wait State: ﬂ Flash:
OTP '/ ait State: EI. 4 aTe:
" Load Rabd Only Flash+0TP:
Execute Operation Help |

o
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Code Security Module (CSM)

Code Security Module (CSM)

¢ Data reads and writes from restricted memory

Code Security Module (CSM)

¢ Access to the following on-chip memory is
restricted:

0x00 8000| LO SARAM (4Kw)
0x00 9000 |1 SARAM (4Kw)

0x00 A000

0x00 C000 reserved

0x3D 7800 OTP (1Kw) >_ Dual
0x3D 7C00 reserved Mapped

Ox3E 8000|  FLASH (64Kw)

0x3F 7FF8 128-Bit Password
0x3F 8000 O SARAM (4Kw)

Ox3F 9000 |1 SARAM (4Kw)

are only allowed for code running from
restricted memory
¢ All other data read/write accesses are blocked:

JTAG emulator/debugger, ROM bootloader, code running in
external memory or unrestricted internal memory

CSM Password

0x3E 8000

FLASH (64Kw) CSM Password
Locations (PWL)
"""""""""""" Ox3F 7FF8 - Ox3F 7FFF

Ox3F 7FF8| 128.Bjt Password

& 128-bit user defined password is stored in Flash

¢ 128-bit Key Register used to lock and unlock the
device
+ Mapped in memory space 0x00 OAEO — 0x00 OAE7

+ Register “EALLOW” protected

10-12
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Code Security Module (CSM)

CSM Regqisters
Key Registers — accessible by user; EALLOW protected
Address Name Reset Value Description
0x00 OAEO|KEYO OxFFFF Low word of 128-bit Key register
0x00 OAE1|KEY1 OxFFFF 2nd word of 128-bit Key register
0x00 OAE2|KEY2 OxFFFF 3rd word of 128-bit Key register
0x00 OAE3|KEY3 OxFFFF 4t word of 128-bit Key register
0x00 OAE4|KEY4 OxFFFF 5th word of 128-bit Key register
0x00 OAE5|KEY5 OxFFFF 6th word of 128-bit Key register
0x00 OAE6|KEY6 OxFFFF 7th word of 128-bit Key register
0x00 OAE7 |KEY7 OxFFFF High word of 128-bit Key register
0x00 OAEF| CSMSCR | OxFFFF CSM status and control register
PWL in memory — reserved for passwords only
Address Name Reset Value Description
Ox3F 7FF8 | PWLO user defined Low word of 128-bit password
Ox3F 7FF9 | PWL1 user defined 2nd word of 128-bit password
0x3F 7FFA| PWL2 user defined 3rd word of 128-bit password
0x3F 7FFB| PWL3 user defined 4th word of 128-bit password
Ox3F 7FFC| PWL4 user defined 5t word of 128-bit password
O0x3F 7FFD| PWL5 user defined 6th word of 128-bit password
0x3F 7FFE| PWL6 user defined 7th word of 128-bit password
0x3F 7FFF |PWL7 user defined High word of 128-bit password

Locking and Unlocking the CSM

¢ The CSMis locked at power-up and reset

¢ To unlock the CSM:

+ Perform a dummy read of each password in
the Flash

+ Write the correct passwords to the key
registers

¢ New Flash Devices (PWL are all OXFFFF):

+ When all passwords are OxFFFF — only a
read of the PWL is required to bring the
device into unlocked mode
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Code Security Module (CSM)

CSM Caveats

¢ Never program all the PWL’s as 0x0000
+ Doing so will permanently lock the CSM
¢ Flash addresses 0x3F7F80 to Ox3F7FF5,

inclusive, must be programmed to 0x0000 to
securely lock the CSM

¢ Remember that code running in unsecured
RAM cannot access data in secured memory

+ Don’t link the stack to secured RAM if you have
any code that runs from unsecured RAM

¢ Do not embed the passwords in your code!
+ Generally, the CSM is unlocked only for debug
+ Code Composer Studio can do the unlocking

CSM Password Match Flow

Device permanently locked
Start CPU access is limited —
device cannot be debugged
or reprogrammed
Flash device
secure after
reset or runtime
Do dummy read of PWL Write password to KEY registers,
Ox3F 7FF8 — Ox3F 7FFF ) 0x00 OAEO — 0x00 OAE7
I (EALLOW) protected

Device unlocked

Correct Yes

password? User can access on-

chip secure memory
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Code Security Module (CSM)

CSM C-Code Examples

Unlocking the CSM:

for (i = O;

KEYO
KEY1
KEY2
KEY3
KEY4
KEY5
KEY6
KEY7

i<8; i++) tmp

asm (’ EALLOW);
CsmRegs.
CsmRegs.-
CsmRegs.-
CsmRegs.-
CsmRegs.-
CsmRegs.
CsmRegs.
CsmRegs.
asm (’ EDIS™);

PASSWORDO ;
PASSWORD1 ;
PASSWORD2 ;
PASSWORD3;
PASSWORD4 ;
PASSWORDS ;
PASSWORDG ;
PASSWORD7 ;

volatile int *PWL = &CsmPwl_.PSWDO;
volatile int i, tmp;

= *PUL++;

//Pointer to PWL register file

//Dummy reads of PWL locations

//KEY regs are EALLOW protected
//Write the passwords
//to the Key registers

Locking the CSM:

asm(” EALLOW™);
CsmRegs.CSMSCR.bit.FORCESEC = 1;
asm (” EDIS™);

//CSMSCR reg is EALLOW protected
//Set FORCESEC bit

TMS320C28x DSP Workshop - System Design

10-15



Lab 10: Programming the Flash

Lab 10: Programming the Flash
» Objective

The objective of this lab is to use the techniques discussed in module 10 and program the on-chip
flash memory. The TMS320F2808 device has been designed for standalone operation in an
embedded system. Using the on-chip flash eliminates the need for external non-volatile memory
or a host processor from which to bootload. In this lab, the steps required to properly configure
the software for execution from internal flash memory will be covered.

Lab 10: Programming the Flash

ePWM1 ADC
TB Counter ADCINAO | RESULTO |Qmath
Compare > .
Action Qualifier FIR Filter
connector ¥
wire o
ePWM2 triggering ADC on
period match using SOC A @ data
trigger every 20 ps (50 kHz) memory
ePWM2
S 2
Objective: E CPU copies
i 2 {Jesf?étrté)urin
¢ Program system into Flash = . ADCISR °
Memory = :
o
¢ Learn use of CCS Flash SN e
Plug-in Disp@(yzs
usin
¢ DO NOT PROGRAM g
PASSWORDS
> Procedure
Project File

Note: LAB1O files have been provided as a starting point for the lab and need to be
completed. DO NOT copy files from a previous lab.

1. A project named Lab1O.pjt has been created for this lab. Open the project by
clicking on Project -> Open.. and look in C:\C28x\Labs\Lab10. All Build
Options have been configured like the previous lab. The files used in this lab are:
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Lab 10: Programming the Flash

Main_10.c
Lab.cdb
User_10.cmd
SysCtrl.c

DSP280x_GlobalVariableDefs.c

Defaultlsr_10.c
EPwm_7_8 9 10.c
Filter.c

Labcfg.cmd
DSP280x_Headers_B10S.cmd
CodeStartBranch.asm

Gpio.c
PieCtrl_10.c
Adc.c

ECap_7 8 9 10.c
DelayUs.asm

Link Initialized Sections to Flash

Initialized sections, such as code and constants, must contain valid values at device power-up.
For a stand-alone embedded system with the F2808 device, these initialized sections must be
linked to the on-chip flash memory. Note that a stand-alone embedded system must operate
without an emulator or debugger in use, and no host processor is used to perform bootloading.

Each initialized section actually has two addresses associated with it. First, it has a LOAD

address which is the address to which it gets loaded at load time (or at flash programming time).
Second, it has a RUN address which is the address from which the section is accessed at runtime.
The linker assigns both addresses to the section. Most initialized sections can have the same
LOAD and RUN address in the flash. However, some initialized sections need to be loaded to
flash, but then run from RAM. This is required, for example, if the contents of the section needs

to be modified at runtime by the code.

2. This step assigns the RUN address of those sections that need to run from flash. Using
the memory section manager in the DSP/BIOS configuration tool (Lab . cdb) link the
following sections to on-chip flash memory:

BIOS Data tab

BIOS Code tab

Compiler Sections tab

.gblinit .bios text
.Sysinit .switch
hwi .cinit
rtdx_text pinit

.econst / .const

.data

3. This step assigns the LOAD address of those sections that need to load to flash. Again
using the memory section manager in the DSP/BIOS configuration tool (Lab . cdb),
select the Load Address tab and check the “Specify Separate Load
Addresses” box. Then set all entries to the flash memory block.

TMS320C28x DSP Workshop - System Design
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Lab 10:

Programming the Flash

4. The section named “1Qmath’ is an initialized section that needs to load to and run from
flash. Recall that this section is not linked using the DSP/BIOS configuration tool
(Lab.cdb). Instead, this section is linked with the user linker command file
(User_10.cmd). Open and inspect User_10.cmd. Previously the “1Qmath”
section was linked to HOSARAM. Notice that this section is now linked to FLASH.

Copying .hwi_vec Section from Flash to RAM

The DSP/BIOS .hwi_vec section contains the interrupt vectors. This section must be loaded to
flash (load address) but run from RAM (run address). The code that performs this copy is located
in InitPieCtrl(). The DSP/BIOS configuration tool generates global symbols that can be accessed
by code in order to determine the load address, run address, and length of the .hwi_vec section.
The C-compiler runtime support library contains a memory copy function called memcpy() which
will be used to perform the copy.

5. Open and inspect InitPieCtrl() (in PieCtrl_10.c file). Notice the memcpy() function
and the symbols used to initialize (copy) the .hwi_vec section.

Copying the .trcdata Section from Flash to RAM

The DSP/BIOS .trcdata section is used by CCS and DSP/BIOS for certain real-time debugging
features. This section must be loaded to flash (load address) but run from RAM (run address).
The DSP/BIOS configuration tool generates global symbols that can be accessed by code in order
to determine the load address, run address, and length of the .trcdata section. The memory copy
function memcpy() will again be used to perform the copy.

The copying of .trcdata must be performed prior to main(). This is because DSP/BIOS modifies
the contents of .trcdata during DSP/BIOS initialization, which also occurs prior to main(). The
DSP/BIOS configuration tool provides a user initialization function which will be used to
perform the .trcdata section copy prior to both main() and DSP/BIQS initialization.

6. Open the DSP/BIOS configuration file (Lab . cdb) and select the Properties for the
Global Settings. Check the box “Call User Init Function” and enter
the User Init() function name with a leading underscore: _UserInit. This will
cause the function Userlnit() to execute prior to main().

7. Open and inspect the file Main_10.c. Notice that the function UserInit() is used
to copy the .trcdata section from its load address to its run address before main().

Initializing the Flash Control Registers

The initialization code for the flash control registers cannot execute from the flash memory (since
it is changing the flash configuration!). Therefore, the initialization function for the flash control
registers must be copied from flash (load address) to RAM (run address) at runtime. The memory
copy function memcpy() will again be used to perform the copy. The initialization code for the
flash control registers InitFlash() is located in the Flash . c file.

8. Add Flash.c to the project.

10-18
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9. Open and inspect Flash_c. The C compiler CODE_SECTION pragma is used to place
the InitFlash() function into a linkable section named ““secureRamFuncs”.

10. Since the DSP/BIOS configuration tool does not know about user defined sections, the
““secureRamFuncs” section will be linked using the user linker command file
User_10.cmd. Open and inspect User_10.cmd. The “secureRamFuncs” will
load to flash (load address) but will run from LISARAM (run address). Also notice that
the linker has been asked to generate symbols for the load start, load end, and run start
addresses.

While not a requirement from a DSP hardware perspective (since the C28x DSP has a
unified memory architecture), Code Composer Studio generally prefers code to be linked
to program space (and data to be linked to data space). Therefore, notice that for the
L1SARAM memory we are linking “secureRamFuncs™ to, we are specifiying
“PAGE = 0”(which is program space). The LISARAM memory is currently defined in
data space in the Lab . cdb, but in the next step we will redefine it to exist in the
program space.

11. Using the DSP/BIOS configuration tool (Lab . cdb) modify the entry for LLSARAM so
that it is defined in the program space (code).

12. Open and inspect Main_10.c. Notice that the memory copy function memcpy() is
being used to copy the section “secureRamFuncs, which contains the initialization
function for the flash control registers.

13. Add a line of code to main() to call the InitFlash() function. There are no passed
parameters or return values. You just type

InitFlash(Q);

at the desired spot inmain().

Code Security Module and Passwords

The CSM module provides protection against unwanted copying (i.e. pirating!) of your code from
flash, OTP memory, and the LO and L1 RAM blocks. The CSM uses a 128-bit password made
up of 8 individual 16-bit words. They are located in flash at addresses 0x3F7FF8 to Ox3F7FFF.
During this lab, dummy passwords of OxFFFF will be used — therefore only dummy reads of the
password locations are needed to unsecure the CSM. DO NOT PROGRAM ANY REAL
PASSWORDS INTO THE DEVICE. After development, real passwords are typically placed in
the password locations to protect your code. We will not be using real passwords in the
workshop.

The CSM module also requires programming values of 0x0000 into flash addresses 0x3F7F80
through Ox3F7FF5 in order to properly secure the CSM. Both tasks will be accomplished using a
simple assembly language program Passwords .asm.

14. Add Passwords.asm to your CCS project.
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Programming the Flash

15. Open and inspect Passwords.asm. This file specifies the desired password values
(DO NOT CHANGE THE VALUES FROM 0xFFFF) and places them in an initialized
section named ““passwords”. It also creates an initialized section named
““csm_rsvd” which contains all 0x0000 values for locations 0x3F7F80 to 0x3F7FF5
(Iength of 0x76).

16. Open User_10.cmd and notice that the initialized sections for ““passwords’ and
“csm_rsvd” are linked to memories named PASSWORDS and CSM_RSVD,
respectively.

17. Using the DSP/BIOS configuration tool (Lab . cdb) define memory blocks for
PASSWORDS and CSM_RSVD. You will need to setup the MEM Properties for each
memory block with the proper base address and length. Set the space to code for both
memory blocks. (Uncheck the “create a heap in this memory” box for each block). You
may also need to modify the existing flash memory block to avoid conflicts. If needed, a
slide is available at the end of this lab showing the base address and length for the
memory blocks.

Executing from Flash after Reset

The F2808 device contains a ROM bootloader that will transfer code execution to the flash after
reset. When the boot mode selection pins are set for “Jump to Flash” mode, the bootloader will
branch to the instruction located at address Ox3F7FF6 in the flash. An instruction that branches
to the beginning of your program needs to be placed at this address. Note that the CSM
passwords begin at address 0x3F7FF8. There are exactly two words available to hold this branch
instruction, and not coincidentally, a long branch instruction “LB” in assembly code occupies
exactly two words. Generally, the branch instruction will branch to the start of the C-
environment initialization routine located in the C-compiler runtime support library. The entry
symbol for this routine is _c_int00. Recall that C code cannot be executed until this setup routine
is run. Therefore, assembly code must be used for the branch. We are using the assembly code
file named CodeStartBranch._asm.

18. Open and inspect CodeStartBranch.asm. This file creates an initialized section
named ““codestart” that contains a long branch to the C-environment setup routine.
This section needs to be placed in memory using the DSP/BIOS configuration tool.

19. Using the DSP/BIOS configuration tool (Lab . cdb) define a memory space named
BEGIN_FLASH.

20. Setup the MEM Properties with the proper base address, length, and space.
(Uncheck the “create a heap in this memory” box). Be sure to avoid memory section
conflicts. If needed, a slide is available at the end of this lab showing the base address
and length for the memory block.

21. In the earlier lab exercises, the section “codestart’ was directed to the memory
named BEGIN_MO. Open and modify User_10.cmd so that the section
“codestart” will be directed to BEGIN_FLASH.

22. The eZdsp™ board needs to be configured for “Jump to Flash” bootmode. Move switch
SW1 positions 1, 2 and 3 to the “open” position to accomplish this. Details of switch
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Lab 10: Programming the Flash

positions can be found in Appendix A. This switch controls the pullup/down resistor on
the GP1018, GP1029, and GP1034 pins, which are the pins sampled by the bootloader to
determine the bootmode. (For additional information on configuring the “Jump to Flash”
bootmode see the TMS320x280x DSP Boot ROM Reference Guide, and also the eZdsp
F2808 Technical Reference).

Build — Lab.out

23.

24.

At this point we need to build the project, but not have CCS automatically load it since
CCS cannot load code into the flash! (the flash must be programmed). On the menu bar
click: Option - Customize.. and select the “Program/Project Load” tab.
Uncheck ““Load Program After Build”.

CCS has a feature that automatically steps over functions without debug information.
This can be useful for accelerating the debug process provided that you are not interested
in debugging the function that is being stepped-over. While single-stepping in this lab
exercise we do not want to step-over any functions. Therefore, select the ““Debug
Properties” tab. Uncheck “Step over functions without debug
information when source stepping”, then click OK.

Click the ““Bui 1d” button to generate the Lab . out file to be used with the CCS Flash
Plug-in.

CCS Flash Plug-in

25.

26.

27.

28.

29.

30.

31.

Open the Flash Plug-in tool by clicking :
Tools > F28xx On-Chip Flash Programmer

Notice that the eZdsp™ board uses a 20 MHz oscillator (located on the board near LED
DS2). Confirm the “Clock Configuration” in the upper left corner has the OSCCLK set
to 20 MHz and the PLLCR value is set to 10. Recall that the PLL is divided by two,
which gives a SYSCLKOUT of 100 MHz.

Confirm that all boxes are checked in the “Erase Sector Selection” area of the plug-in
window. We want to erase all the flash sectors.

We will not be using the plug-in to program the “Code Security Password”. Do not
modify the Code Security Password fields.

In the “Operation” block, notice that the “COFF file to Program/Verify” field
automatically defaults to the current . out file. Check to be sure that “Erase, Program,
Verify” is selected. We will be using the default wait states, as shown on the slide in this
module.

Click “Execute Operation” to program the flash memory. Watch the programming status
update in the plug-in window.

After successfully programming the flash memory, close the programmer window.
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Running the Code — Using CCS

32.

33.

34.

35.

36.

37.

In order to effectively debug with CCS, we need to load the symbolic debug information
(e.g., symbol and label addresses, source file links, etc.) so that CCS knows where
everything is in your code. Click:

File > Load Symbols - Load Symbols Only..
and select Lab10.out in the Debug folder.

Reset the DSP. The program counter should now be at 0x3FFB50, which is the start of
the bootloader in the Boot ROM.

Single-Step <F11> through the bootloader code until you arrive at the beginning of the
codestart section in the CodeStartBranch.asm file. (Be patient, it will take about
65 single-steps). Notice that we have placed some code in CodeStartBranch.asm
to give an option to first disable the watchdog, if selected.

Step a few more times until you reach the start of the C-compiler initialization routine at
the symbol _c_int0O0.

Now do Debug > Go Main. The code should stop at the beginning of your main()
routine. If you got to that point succesfully, it confirms that the flash has been
programmed properly, and that the bootloader is properly configured for jump to flash
mode, and that the codestart section has been linked to the proper address.

You can now RUN the DSP, and you should observe the LED on the board blinking. Try
resetting the DSP and hitting RUN (without doing all the stepping and the Go Main
procedure). The LED should be blinking again.

Running the Code — Stand-alone Operation (No Emulator)

38.
39.
40.
41.

42.

Close Code Composer Studio.

Disconnect the emulator (USB cable) from the eZdsp™ board.
Remove the power from the board.

Re-connect the power to the board.

The LED should be blinking, showing that the code is now running from flash memory.
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Return Switch SW1 Back to Default Positions

43. Remove the power from the board.

44. Please return the settings of switch SW1 back to the default positions “Jump to
MOSARAM” bootmode (see Appendix A for switch position details):

Position 3 Position 2 Position 1 Boot
GPI1O18 GP1029 GP1034 Mode
Closed -0 Open-1 Closed -0 MO SARAM

End of Exercise
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Lab 10 Reference: Programming the Flash

Flash Memory Section Blocks
base =
0x3E 8000
FLASH
len = OxFF80
space = code User_10.cmd
SECTIONS
{
Ox3F7F80|  cgM_RSVD codestart > BEGIN_FLASH, PAGE =0
len = 0x76 passwords :> PASSWORDS, PAGE =0
space = code csm_rsvd > CSM_RSVD, PAGE =0
Ox3F 7FF6|  BEGIN_FLASH }
len = Ox2 \/_
space = code
0x3F 7FF8|  PASSWORDS
len = 0x8
space = code

BIOS Startup Sequence from Flash Memory

0x3E 8000

— Ox3F 7FF6

0x3F 8000

®

0x3F FO00

——
-
-

FLASH (64Kw)

Passwords (8w)

_c_int00

HO SARAM (8Kw)

Boot ROM (4Kw)

Boot Code
0x3F FB50

@Sv 0x3F FFCO

RESET

{SCAN GPIO}

BROM vector (32w)

0x3F FB50 ——

BIOS code Sections
BIOS_reset()

BIOS _init()

main ()

BIOS_start()

IDL_run()

“rts2800_ml.lib”

“user” code sections
main ()

return;

}
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Communications

Introduction

The TMS320C28x contains features that allow several methods of communication and data
exchange between the C28x and other devices. Many of the most commonly used
communications techniques are presented in this module.

The intent of this module is not to give exhaustive design details of the communication
peripherals, but rather to provide an overview of the features and capabilities. Once these
features and capabilities are understood, additional information can be obtained from various
resources such as documentation, as needed. This module will cover the basic operation of the
communication peripherals, as well as some basic terms and how they work.

Learning Objectives

Learning Objectives

¢ Serial Peripheral Interface (SPI)
¢ Serial Communication Interface (SCI)
¢ Inter-Integrated Circuit (12C)

¢ Enhanced Controller Area Network (eCAN)

Note: Up to 4 SPI modules (A/B/C/D), 2 SCI modules (A/B), 1 12C
modules, and 2 eCAN (A/B) modules are available on the
F280x devices.

TMS320C28x DSP Workshop - Communications 11-1



Module Topics
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Communications Techniques

Communications Techniques

Several methods of implementing a TMS320C28x communications system are possible. The
method selected for a particular design should reflect the method that meets the required data rate
at the lowest cost. Various categories of interface are available and are summarized in the
learning objective slide. Each will be described in this module.

Synchronous vs. Asynchronous

¢ Synchronous ¢ Asynchronous
+ Short distances (on- + longer distances
board) . é%‘f‘)’er data rate (= 1/8 of
+ High data rate

e + Implied clock (clk/data
+ Explicit clock mixed)

« Economical with
reasonable performance

C28x C28x

Port u2 Port_‘>_

Destination

PCB PCB

Serial ports provide a simple, hardware-efficient means of high-level communication between
devices. Like the GPIO pins, they may be used in stand-alone or multiprocessing systems.

In a multiprocessing system, they are an excellent choice when both devices have an available
serial port and the data rate requirement is relatively low. Serial interface is even more desirable
when the devices are physically distant from each other because the inherently low number of
wires provides a simpler interconnection.

Serial ports require separate lines to implement, and they do not interfere in any way with the data
and address lines of the processor. The only overhead they require is to read/write new words
from/to the ports as each word is received/transmitted. This process can be performed as a short
interrupt service routine under hardware control, requiring only a few cycles to maintain.

The C28x family of devices have both synchronous and asynchronous serial ports. Detailed
features and operation will be described next.
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Serial Peripheral Interface (SPI)

The SPI module is a synchronous serial 1/0O port that shifts a serial bit stream of variable length
and data rate between the C28x and other peripheral devices. During data transfers, one SPI
device must be configured as the transfer MASTER, and all other devices configured as
SLAVES. The master drives the transfer clock signal for all SLAVES on the bus. SPI
communications can be implemented in any of three different modes:

e MASTER sends data, SLAVES send dummy data
¢ MASTER sends data, one SLAVE sends data
e MASTER sends dummy data, one SLAVE sends data

In its simplest form, the SPI can be thought of as a programmable shift register. Data is shifted in
and out of the SPI through the SPIDAT register. Data to be transmitted is written directly to the
SPIDAT register, and received data is latched into the SPIBUF register for reading by the CPU.
This allows for double-buffered receive operation, in that the CPU need not read the current
received data from SPIBUF before a new receive operation can be started. However, the CPU
must read SPIBUF before the new operation is complete of a receiver overrun error will occur. In
addition, double-buffered transmit is not supported: the current transmission must be complete
before the next data character is written to SPIDAT or the current transmission will be corrupted.

The Master can initiate a data transfer at any time because it controls the SPICLK signal. The
software, however, determines how the Master detects when the Slave is ready to broadcast.

SPI Data Flow

¢ Simultaneous transmits and receive
¢ SPI Master provides the clock signal

SPI Device #1 - Master SPI Device #2 - Slave
shift _ ihif_t _
| SPI Shift Register [ | SPI Shift Register [
clock
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Serial Peripheral Interface (SPI)

SPI Block Diagram

C28x - SPI Master Mode Shown

MSB

RX FIFO_0

RX FIFO_15

SPIRXBUF.15-0

t

SPIDAT.15-0

| LsB

SPISIMO

SPISOMI

t

SPITXBUF.15-0

TX FIFO_O

TX FIFO_15

LSPCLK =——>

baud
rate

clock

clock

polarity

phase

SPICLK

SPI Transmit / Receive Sequence

1.

2.

Slave writes data to be sent to its shift register (SPIDAT)

Master writes data to be sent to its shift register (SPIDAT or SPITXBUF)

Completing Step 2 automatically starts SPICLK signal of the Master

MSB of the Master’s shift register (SPIDAT) is shifted out, and LSB of the Slave’s shift

register (SPIDAT) is loaded

Step 4 is repeated until specified number of bits are transmitted

SPIDAT register is copied to SPIRXBUF register

SPI'INT Flag bitissetto 1

An interrupt is asserted if SPI INT ENA bitissetto 1

If data is in SPITXBUF (either Slave or Master), it is loaded into SPIDAT and transmission
starts again as soon as the Master’s SPIDAT is loaded

TMS320C28x DSP Workshop - Communications
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Serial Peripheral Interface (SPI)

Since data is shifted out of the SPIDAT register MSB first, transmission characters of less than 16
bits must be left-justified by the CPU software prior to be written to SPIDAT.

Received data is shifted into SPIDAT from the left, MSB first. However, the entire sixteen bits
of SPIDAT is copied into SPIBUF after the character transmission is complete such that received
characters of less than 16 bits will be right-justified in SPIBUF. The non-utilized higher
significance bits must be masked-off by the CPU software when it interprets the character. For
example, a 9 bit character transmission would require masking-off the 7 MSB’s.

SPI| Data Character Justification

¢ Programmable data
length of 1 to 16 bits

* ;Fr{anslrg ilt)t'?d da_tat %f llesf? SPIDAT - Processor #1
an ITS must be 1e
[Uetified 1100100 LXXXXXXXX |

*MSB transmitted first

¢ Received data of less
than 16 bits are right
justified SPIDAT - Processor #2

XXXXXXXX11001001 | +—

& User software must
mask-off unused MSB'’s
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Serial Peripheral Interface (SPI)

SPI Registers

SPI Baud Rate Register

SpixRegs.SPIBRR

Need to set this only when in master mode!

15-7 6-0
reserved SPI BIT RATE
_LSPCLK _ spiBRR=3t0 127
(SPIBRR + 1)
SPICLK signal =
LSP—4CLK, SPIBRR =0, 1, or 2

Baud Rate Determination: The Master specifies the communication baud rate using its baud rate
register (SPIBRR.6-0):

e For SPIBRR =3 t0 127: SPI| Baud Rate = ﬂ bits/sec
(SPIBRR +1)
e ForSPIBRR=0,1,0r2: SPIBaud Rate = % bits/sec

From the above equations, one can compute
Maximum data rate = 25 Mbps @ 100 MHz

Character Length Determination: The Master and Slave must be configured for the same
transmission character length. This is done with bits 0, 1, 2 and 3 of the configuration control
register (SPICCR.3-0). These four bits produce a binary number, from which the character length
is computed as binary + 1 (e.g. SPICCR.3-0 = 0010 gives a character length of 3).
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Serial Peripheral Interface (SPI)

Select SPI Registers
¢ Configuration Control spixregs.spiccr

« Reset, Clock Polarity, Loopback, Character Length

¢ Operation Control spixregs.spicTL

« Overrun Interrupt Enable, Clock Phase, Interrupt Enable
+ Master / Slave Transmit enable

& Status spixregs.spIsT
+ RX Overrun Flag, Interrupt Flag, TX Buffer Full Flag

& FIFO Transmit spixregs.spiFFTx

FIFO Receive spixregs.SPIFFRX

+ FIFO Enable, FIFO Reset

FIFO Over-flow flag, Over-flow Clear

Number of Words in FIFO (FIFO Status)

FIFO Interrupt Enable, Interrupt Status, Interrupt Clear
FIFO Interrupt Level (Number of Words in FIFO)

. * * .

Note: refer to the reference guide for a complete listing of registers

SPI Summary

SPI Summary

¢ Provides synchronous serial
communications

+ Two wire transmit or receive (half duplex)

+ Three wire transmit and receive (full duplex)
¢ Software configurable as master or slave
+ C28x provides clock signal in master mode
Data length programmable from 1-16 bits

¢ 125 different programmable baud rates

2

11-8 TMS320C28x DSP Workshop - Communications



Serial Communications Interface (SCI)

Serial Communications Interface (SCI)

The SCI module is a serial 1/0O port that permits Asynchronous communication between the C28x
and other peripheral devices. The SCI transmit and receive registers are both double-buffered to
prevent data collisions and allow for efficient CPU usage. In addition, the C28x SCl is a full
duplex interface which provides for simultaneous data transmit and receive. Parity checking and

data formatting is also designed to be done by the port hardware, further reducing software
overhead.

SCI Pin Connections

(Full Duplex Shown)

TXFIFO_0 TXFIFO_0
TXFIFO_15 TXFIFO_15
Transmitter-data Transmitter-data
buffer register buffer register
Transmitter SCITXD SCITXD Transmitter
shift register shift register
Receiver SCIRXD SCIRXD Receiver
shift register shift register
Receiver-data Receiver-data
buffer register buffer register
RX FIFO_0 RX FIFO_0
RX FIFO_15 RX FIFO_15
SCI Device #1 SCI Device #2
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Serial Communications Interface (SCI)

SCI Data Format

NRZ (non-return to zero) format

Addr/ . T T
Start | LSB 2 3 4 5 6 7 MSB Data Parity [Stop 1 Stop 2

This bit present only in Address-bit mode A

Communications Control Register (ScixRegs.SCICCR)

7 6 5 4 3 2 1 0
Stop  |Even/Odd| Parity |Loopback|Addr/idle| SCI SCI SCI
Bits Parity Enable Enable Mode Char2 Charl Char0
| - _/
e
0 =1 Stop bit 0 = Disabled 0 =Idle-line mode # of data bits = (binary + 1)
1 =2 Stop bits 1=Enabled 1 = Addr-bit mode e.g. 110b gives 7 data bits
0=0dd 0 = Disabled
1=Even 1 = Enabled

The basic unit of data is called a character and is 1 to 8 bits in length. Each character of data is
formatted with a start bit, 1 or 2 stop bits, an optional parity bit, and an optional address/data bit.
A character of data along with its formatting bits is called a frame. Frames are organized into
groups called blocks. If more than two serial ports exist on the SCI bus, a block of data will
usually begin with an address frame which specifies the destination port of the data as determined
by the user’s protocol.

The start bit is a low bit at the beginning of each frame which marks the beginning of a frame.
The SCI uses a NRZ (Non-Return-to-Zero) format which means that in an inactive state the
SCIRX and SCITX lines will be held high. Peripherals are expected to pull the SCIRX and
SCITX lines to a high level when they are not receiving or transmitting on their respective lines.

When configuring the SCICCR, the SCI port should first be held in an inactive state. This
is done using the SW RESET bit of the SCI Control Register 1 (SCICTL1.5). Writing a O to this
bit initializes and holds the SCI state machines and operating flags at their reset condition. The
SCICCR can then be configured. Afterwards, re-enable the SCI port by writing a 1 to the SW
RESET bit. At system reset, the SW RESET bit equals 0.
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Serial Communications Interface (SCI)

SCI Data Timing

 Start bit valid if 4 consecutive SCICLK periods of zero bits after falling edge
e Majority vote taken on 4th, 5th and 6th SCICLK cycles

Majority

\ Vote /
SCICLK

(Internal) ,: 12 3 4 5 6 7 8 1 2 3 45 6 7 8 1 2
SCIRXD 7&%%{7 by WX
Start Bit LSB of Data

: Falling Edge Detected

Note: 8 SCICLK periods per data bit

Multiprocessor Wake-Up Modes

Multiprocessor Wake-Up Modes

¢ Allows numerous processors to be hooked
up to the bus, but transmission occurs
between only two of them

¢ Idle-line or Address-bit modes

¢ Sequence of Operation

1. Potential receivers set SLEEP = 1, which disables RXINT
except when an address frame is received

2. All transmissions begin with an address frame

3. Incoming address frame temporarily wakes up all SCIs on bus
4. CPUs compare incoming SCI address to their SCI address

5. Process following data frames only if address matches
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Serial Communications Interface (SCI)

Idle-Line Wake-Up Mode

¢ Idle time separates blocks of frames

¢ Receiver wakes up when SCIRXD high for 10 or
more bit periods

¢ Two transmit address methods
+ deliberate software delay of 10 or more bits
+ set TXWAKE bit to automatically leave exactly

11 idle bits
Idle periods
of less than Block of Frames
10 bits R
gg:%)fDD/ TV LastData : Addr_|sp|sT[ Data |sp|ST[ LestData | SP 1STL Addr _isPi
Idled Address frame 1st data frame Idled
Period  follows 10 bit Perio
10 bits or greater idle 10 bits
or greater 9 or greater

Address-Bit Wake-Up Mode

¢ All frames contain an extra address bit
¢ Receiver wakes up when address bit detected

¢ Automatic setting of Addr/Data bit in frame by
setting TXWAKE = 1 prior to writing address to
SCITXBUF

Block of Frames

gg:%)((g/ “LastDal o s |sT[ Adar [1]sp|sT[ Data [0]sP| ST|LestData] 0] sPLST! Addr 1jsPi

>/_/ First frame within  1st data frame .
no additional

Idle Period block is Address. idle bits needed
length of no ADDR/DATA beyond stop bits
significance bit set to 1
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Serial Communications Interface (SCI)

The SCI interrupt logic generates interrupt flags when it receives or transmits a complete
character as determined by the SCI character length. This provides a convenient and efficient
way of timing and controlling the operation of the SCI transmitter and receiver. The interrupt
flag for the transmitter is TXRDY (SCICTL2.7), and for the receiver RXRDY (SCIRXST.6).
TXRDY is set when a character is transferred to TXSHF and SCITXBUF is ready to receive the
next character. In addition, when both the SCIBUF and TXSHF registers are empty, the TX
EMPTY flag (SCICTL2.6) is set. When a new character has been received and shifted into
SCIRXBUF, the RXRDY flag is set. In addition, the BRKDT flag is set if a break condition
occurs. A break condition is where the SCIRXD line remains continuously low for at least ten
bits, beginning after a missing stop bit. Each of the above flags can be polled by the CPU to
control SCI operations, or interrupts associated with the flags can be enabled by setting the
RX/BK INT ENA (SCICTL2.1) and/or the TX INT ENA (SCICTL2.0) bits active high.

Additional flag and interrupt capability exists for other receiver errors. The RX ERROR flag is
the logical OR of the break detect (BRKDT), framing error (FE), receiver overrun (OE), and
parity error (PE) bits. RX ERROR high indicates that at least one of these four errors has
occurred during transmission. This will also send an interrupt request to the CPU if the RX ERR
INT ENA (SCICTLL1.6) bit is set.
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Serial Communications Interface (SCI)

SCI Registers

SCI Baud Rate Registers

_LSPCLK  BRR =110 65535
(BRR + 1) x 8
SCI baud rate =
_ BSRERS BRR = 0
16

Baud-Select MSbhyte Register (ScixRegs.SCIHBAUD)

7 6 5 4 3 2 1 0
B(’:AUSDBl)S BAUD14 | BAUD13 | BAUD12 | BAUD11 | BAUD10 | BAUD9 | BAUDS

Baud-Select LSbyte Register (ScixRegs.SCILBAUD)

7 6 5 4 3 2 1 0
BAUDO
BAUD7 | BAUD6 | BAUDS | BAUD4 | BAUD3 | BAUD2 | BAUD1 (LSB)

Baud Rate Determination: The values in the baud-select registers (SCIHBAUD and SCILBAUD)
concatenate to form a 16 bit number that specifies the baud rate for the SCI.

e For BRR =1 to 65535: SCI Baud Rate = ﬂ bits/sec
(BRR+1)x8
e ForBRR=0: SCI Baud Rate = % bits/sec

Max data rate = 6.25 Mbps @ 100 MHz

Note that the CLKOUT for the SCI module is one-half the CPU clock rate.
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Select SCI Registers
& Control 1 scixregs.scici1

+ Reset, Transmitter / Receiver Enable
« TX Wake-up, Sleep, RX Error Interrupt Enable

& Control 2 scixregs.spicTL2
« TX Buffer Full / Empty Flag, TX Ready Interrupt Enable
« RXBreak Interrupt Enable

& Receiver Status scixregs.scirxsT

« Error Flag, Read_¥, Flag Break-Detect Flag, Framin%Error
Detect Flag, Parity Error Flag, RX Wake-up Detect Flag

& FIFO Transmit scixregs.SciFFTx

FIFO Recelve scixregs.SCIFFRX

+ FIFO Enable, FIFO Reset

FIFO Over-flow flag, Over-flow Clear

Number of Words in FIFO (FIFO Status)

FIFO Interrupt Enable, Interrupt Status, Interrupt Clear
FIFO Interrupt Level (Number of Words in FIFO)

* * * *

Note: refer to the reference guide for a complete listing of registers

SCl Summary

SCI Summary

*

Asynchronous communications format
65,000+ different programmable baud rates

¢ Two wake-up multiprocessor modes
+ Idle-line wake-up & Address-bit wake-up

¢ Programmable data word format
« 1to 8 bit dataword length

« 1or 2stop bits
+ even/odd/no parity

Error Detection Flags
« Parity error; Framing error; Overrun error; Break detection

Double-buffered transmit and receive
Individual interrupts for transmit and receive

*

L 2R 2
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Inter-Integrated Circuit (12C)

Inter-Integrated Circuit (12C)
Inter-Integrated Circuit (12C)

Philips 12C-bus specification compliant, version 2.1

Data transfer rate from 10 kbps up to 400 kbps

Each device can be considered as a Master or Slave

Master initiates data transfer and generates clock signal

Device addressed by Master is considered a Slave

Multi-Master mode supported

Standard Mode — send exactly n data values (specified in register)

Repeat Mode — keep sending data values (use software to initiate a
stop or new start condition)

L 2K JEE ZEE 2R JER JEK 2B 4

VDD

Pull-up 28xx 12C
Resisters 12C Controller

Serial Data (SDA) l l
Serial Clock (SCL)

12C 28xx
EPROM 12C

12C Block Diagram

[I2CXSR I2CDXR
TX FIFO
SDA < >
RX FIFO
» |2CRSR » |2CDRR
SCL < . Clock
Circuits
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Inter-Integrated Circuit (12C)

I2C Operating Modes and Data Formats

12C Operating Modes

Operating Mode

Description

Slave-receiver mode

Module is a slave and receives data from a master
(all slaves begin in this mode)

Slave-transmitter mode

Module is a slave and transmits data to a master
(can only be entered from slave-master mode)

Master-receiver mode

Module is a master and receives data from a slave
(can only be entered from master-transmit mode)

Master-transmitter mode

Module is a master and transmits to a slave
(all masters begin in this mode)

I2C Serial Data Formats

7-Bit Addressing Format

1 7 1 1 1 n 1 1
| S | Slave Address | R/\N|ACK| Data |ACK| Data | ACK| P |
10-Bit Addressing Format
1 7 1 1 8 1 n 1 1
[s] 111108 [RWw][ACK] AAAAAAAATACK] Data  [AcK] P |
Free Data Format
1 n 1 n 1 n 1 1
[s] Data  |ACK] Data | AcK] Data  |ACK| P |

n =1 to 8 bits

R/W = 0 — master writes data to addressed slave
R/W = 1 — master reads data from the slave

S = Start (high-to-low transition on SDA while SCL is high)
P = Stop (low-to-high transition on SDA while SCL is high)

TMS320C28x DSP Workshop - Communications
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Inter-Integrated Circuit (12C)

L 4

12C Arbitration

If two or more master-transmitters simultaneously
start transmission, an arbitration procedure is
invoked

+ Procedure uses data presented on serial data bus (SDA) by
competing transmitters

» First master-transmitter which drives SDA high is overruled
by another master-transmitter that drives SDA low

+ Procedure gives priority to the data stream with the lowest
binary value

Device #1 lost arbitration

sct | [ 1 [ 1]
. and switches to master-
Data from W receiver mode
device #1 :

Data from Device #2

: 0 0 110 1 i
device #2 1 : \/ drives SDA

SDA 1t0 0|1|0]1

12C Summ

ary

* o

* & o

12C Summary

Compliance with Philips 12C-bus
specification (version 2.1)

Support for 1-bit to 8-bit format
transfers

7-bit and 10-bit addressing modes

Data transfer rate from 10 kbps up to
400 kbps

16-bit receive FIFO
16-bit transmit FIFO
Module enable/disable

11-18

TMS320C28x DSP Workshop - Communications



Enhanced Controller Area Network (eCAN)

Enhanced Controller Area Network (eCAN)
Controller Area Network (CAN)

A Multi-Master Serial Bus System

¢ CAN 2.0B Standard

¢ High speed (up to 1 Mbps)

¢ Add anode without disturbing the bus (humber of nodes not
limited by protocol)

¢ Less wires (lower cost, less maintenance, and more reliable)

¢ Redundant error checking (high reliability)

¢ No node addressing (message identifiers)

¢ Broadcast based signaling

® ©

CAN does not use physical addresses to address stations. Each message is sent with an identifier
that is recognized by the different nodes. The identifier has two functions — it is used for message
filtering and for message priority. The identifier determines if a transmitted message will be
received by CAN modules and determines the priority of the message when two or more nodes
want to transmit at the same time.
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Enhanced Controller Area Network (eCAN)

CAN Bus and Node

CAN Bus

¢ Two wire differential bus (usually twisted pair)

¢ Max. bus length depend on transmission rate
+ 40 meters @ 1 Mbps

CAN CAN
NODE A NODE B

CAN_H

120Q

g

1200
CAN L

The DSP communicates to the CAN Bus using a transceiver. The CAN bus is a twisted pair wire,

and the transmission rate depends on the bus length. If the bus is less than 40 meters the
transmission rate is capable up to 1 Mbit/second.

CAN Node

Wired-AND Bus Connection
CAN_H

1200 1200
CAN_L

m\

CAN Transceiver
(e.g. TI SN65HVD23x)

X RX

CAN Controller
(e.g. TMS320F2808)
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Enhanced Controller Area Network (eCAN)

Principles of Operation

Principles of Operation

¢ Data messages transmitted are identifier based,
not address based

¢ Content of message is labeled bK an identifier that
is unique throughout the networ

+ (e.g. rpm, temperature, position, pressure, etc.)

¢ All nodes on network receive the message and
each performs an acceptance test on the identifier

¢ If message is relevant, it is processed (received);
otherwise it is ignored

¢ Unique identifier also determines the priority of the
message

+ (lower the numerical value of the identifier, the higher the
priority)
¢ When two or more nodes attempt to transmit at the
same time, a non-destructive arbitration technique
guarantees messages are sent in order of priority
and no messages are lost

Non-Destructive Bitwise Arbitration

¢ Bus arbitration resolved via arbitration with
wired-AND bus connections

+ Dominate state (logic 0, bus is high)
+ Recessive state (logic 1, bus is low)

ot
Node A ™ il - Node A wins

........... LI =L
Node B L[ 1

NodeC ] [ — |
—

CANBUs ™ L L
Node B Ioses_j k Node C loses
arbitration arbitration
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Enhanced Controller Area Network (eCAN)

Message Format and Block Diagram

CAN Message Format

¢ Datais transmitted and received using Message Frames
¢ 8 byte data payload per message
¢ Standard and Extended identifier formats

& Standard Frame: 11-bit Identifier (CAN v2.0A)

Arbitration Control
Field Field Data Field
S| 11-bit [R|! E
O | 1dentifier] T|D|r0 DLC| 0...8 Bytes Data | CRC | ACK| O
F RIE F

¢ Extended Frame: 29-bit Identifier (CAN v2.0B)

Control
Avrbitration Field Field Data Field
S A S|l . R E
11-bit 18-bit
('3 \dentifier E E Identifier; r1{r0 DLC| 0...8 Bytes Data | CRC | ACK ('3

The DSP CAN module is a full CAN Controller. It contains a message handler for transmission
and reception management, and frame storage. The specification is CAN 2.0B Active — that is,

the module can send and accept standard (11-bit identifier) and extended frames (29-bit
identifier).

eCAN Block Diagram

Address
TeCANOINT TeCANlINT |_| Data

| I

Memory Management
Unit

. eCAN Memory
Mg{gogyEQeQ\)M (512 bytes)

— —N
CPU Interface, ;
32 Mailboxes <:§> Receive Control Unit <:§> LS 20l Ul

(4 x 32-bit words) Timer Management Unit Sl ]

A message mailbox
Identifier - MID
Control - MCF

Data low — MDL Receive Buffer
Data high - MDH Transmit Buffer
Control Buffer
Status Buffer

SN65HVD23x
3.3-V CAN Transceiver

1]

CAN Bus
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Enhanced Controller Area Network (eCAN)

The CAN controller module contains 32 mailboxes for objects of 0 to 8-byte data lengths:
e configurable transmit/receive mailboxes
e configurable with standard or extended indentifier

The CAN module mailboxes are divided into several parts:
o MID - contains the identifier of the mailbox

e MCF (Message Control Field) — contains the length of the message (to transmit or
receive) and the RTR bit (Remote Transmission Request — used to send remote
frames)

¢ MDL and MDH - contains the data

The CAN module contains registers which are divided into five groups. These registers are
located in data memory from 0x006000 to 0x0061FF. The five register groups are:

e Control & Status Registers

o Local Acceptance Masks

e Message Object Time Stamps
o Message Object Timeout

e Mailboxes

eCAN Summary

eCAN Summary

¢ Fully CAN protocol compliant, version 2.0B
¢ Supports data rates up to 1 Mbps

¢ Thirty-two mailboxes
+ Configurable as receive or transmit
+ Configurable with standard or extended identifier
+ Programmable receive mask
+ Uses 32-bit time stamp on messages
+ Programmable interrupt scheme (two levels)
+ Programmable alarm time-out

¢ Programmable wake-up on bus activity
¢ Self-test mode
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Enhanced Controller Area Network (eCAN)
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Development Support

Introduction

This module contains various references to support the development process.

Learning Objectives

Learning Objectives

¢ Signal Processing Libraries

¢ Additional Resources
+ Internet

+ Product Information Center
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Module Topics

Module Topics

DEVEIOPMENT SUPPOKT ...ttt ettt bbbt et e et e st e e et e besbeebe s beeb e e e e b e e seeeas 12-1
T LU T=N o ot 12-2
T1 SUPPOIT RESOUICES ...ttt sttt r ettt e e sn bbb nnens 12-3
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Tl Support Resources

Tl Support Resources

C28x Signal Processing Libraries
Signal Processing Libraries & Applications Software Literature #
ACI3-1: Control with Constant V/Hz SPRC194
ACI3-3: Sensored Indirect Flux Vector Control SPRC207
ACI3-3: Sensored Indirect Flux Vector Control (simulation) SPRC208
ACI3-4: Sensorless Direct Flux Vector Control SPRC195
ACI3-4: Sensorless Direct Flux Vector Control (simulation) SPRC209
PMSM3-1: Sensored Field Oriented Control using QEP SPRC210
PMSM3-2: Sensorless Field Oriented Control SPRC197
PMSM3-3: Sensored Field Oriented Control using Resolver SPRC211
PMSM3-4: Sensored Position Control using QEP SPRC212
BLDC3-1: Sensored Trapezoidal Control using Hall Sensors SPRC213
BLDC3-2: Sensorless Trapezoidal Drive SPRC196
DCMOTOR: Speed & Position Control using QEP without Index SPRC214
Digital Motor Control Library (F/C280x) SPRC215
Communications Driver Library SPRC183
DSP Fast Fourier Transform (FFT) Library SPRC081
DSP Filter Library SPRC082
DSP Fixed-Point Math Library SPRCO085
DSP 1Q Math Library SPRC087
DSP Signal Generator Library SPRCO083
DSP Software Test Bench (STB) Library SPRC084
C280x C/C++ Header Files and Peripheral Examples SPRC191

Available from Tl DSP Website = http://www.ti.com/c2000

For More Information . ..

Internet
Website: http://www.ti.com

FAQ: http://www-k.ext.ti.com/sc/technical_support/knowledgebase.htm

+ Device information ¢ my.ti.com
+ Application notes . + News and events
¢ Technical documentation ¢ Training

Enroll in Technical Training:  http://www.ti.com/sc/training

USA - Product Information Center ( PIC)
Phone: 800-477-8924 or 972-644-5580
Email: support@ti.com

+ Information and support for all TI Semiconductor products/tools
+ Submit suggestions and errata for tools, silicon and documents
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Tl Support Resources

European Product Information Center (EPIC)

Web: http://www-k.ext.ti.com/sc/technical support/pic/euro.htm

Phone: Language Number

Belgium (English) +32 (0) 27 45 55 32
France +33 (0) 1 30 70 11 64
Germany +49 (0) 8161 80 33 11
Israel (English) 1800 949 0107 (free phone)
Italy 800 79 11 37 (free phone)
Netherlands (English) +31 (0) 546 87 95 45
Spain +34 902 35 40 28
Sweden (English) +46 (0) 8587 555 22
United Kingdom +44 (0) 1604 66 33 99
Finland (English) +358(0) 9 25 17 39 48

Fax: All Languages +49 (0) 8161 80 2045

Email: epic@ti.com

+ Literature, Sample Requests and Analog EVM Ordering

+ Information, Technical and Design support for all Catalog Tl
Semiconductor products/tools

+ Submit suggestions and errata for tools, silicon and documents

12-4
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Appendix A —eZdsp™ F2808

Note: This appendix only provides a description of the eZdsp™ F2808 interfaces used in this
workshop. For a complete description of all features and details, please see the eZdsp™
F2808 USB Technical Reference manual.
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Appendix

eZdsp™ F2808

eZdsp™ F2808 Connector / Header and Pin Diagram

TMS3EAF 2808

+ eldipm

-+

B

&)

o

B B

. =

L5

s

[

e

=

08‘_’5

—.

[

o

+ PS5 AR ok ﬁb =

mlﬂlDDDODDUUU':S L 5

DLDUDOGOQGDD i) E‘i

=00 oo 0 0 Ohe * \ g

\5 > 8"’ \ E_j

vl s .\
. S b

N - P
(sw1) (Ps/P9) (JPs)
SN SN T e

Table 1: eZdsp™ F2808 Connectors

Connector Function
P1 JTAG Interface
P8 I/O Interface
P5/P9 Analog Interface
P& Power Connector
P10 DB-9, R5-232
P11 DB9, eCAN-A
J10 2x5 Header, SCIB
J11 2%5 header, eCAN-B
USE Controller
J201 Interface
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Appendix

P8 — I/O Interface

* Dafealll b5 Mo Conmed. (M. Uear @n jumpsr iz +3.25% of +5% on backdde of sZdep

with JP4.

214 |6 | a(1012|14 |16 [18[ 20|22 |24 |26 |28 |30 (32 (234|326 |38 |40
113 719 (11|13 (15|17 (19|21 (232 |25| 27| 28| 31|33 (35 |37 (39
Tabds Z: FE, 100 Conneion

F'||:I|.'|E-1' P& Eignal Frnﬁl: P& Signal

1 0 B B ¢ b 0 i BN
a WMUE_SFACSEH 4 MLUE_SFACSEE
E P4 = P30

7 GPKE = GPEDEZE

@ GPKXD 10 GPK

11 e o iz GPKxE

18 GPd 14 GRPIDE

15 GPKT 12 GPI=

17 GRS 18 GPEDH
16 GHD 30 GHD

| GRPKT 2 SRS
23 GPKe M GEPET
25 GPKg . =] GEPED
ar WUE_GACE o= MLUE_GACE0
20 WU _SFCAA 30 WU _SHCE
D | WL _SR1C0 3z MLUE_SFCA 0
aa SR EGR 2 k= (' o
a5 GPKa = GP RS
ar GPKZ 3, SPEDER
an GHD 40 GHD

P8
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P5 /P9 — Analog Interface

P5 ANALOG

1123 |4 |5 678|910
214 |6 |8 101214 (16 | 18| 20
113 (5| 79 [ 11[13[15]|17 (19

P9
Table 3: P5/P9, Analog Interface Connector
Pli:nS# Signal Pli:ng# Signal Plijng# Signal

1 ADCINBO 1 GND 2 ADCINAD
2 ADCINB1 3 GND 4 ADCINA1
3 ADCINB2 5 GND 6 ADCINA2
4 ADCINB3 7 GND 8 ADCINAS
5 ADCINB4 9 GND 10 ADCINA4
6 ADCINBS 11 GND 12 ADCINAS
7 ADCINBG 13 GND 14 ADCINAG
8 ADCINB7 15 GND 16 ADCINAT
9 ADCREFM 17 GND 18 VREFLO *
10 ADCREFP 19 GND 20 No connect

* Connect VREFLO to AGND or VREFLO of target system for proper ADC operation.
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SW1 - Switch
U | GPI1034
_2| ] | cPox
% 3 . I | criots
4 [ | Seria EEPROM WP
Serial EEPROM
5
‘:- Pu”ups
s Il ] | serialEEPROM-A1
Open | Closed

Default from factory

Table 4: SW1 Switch Positions

Position Function
1-3 Boot Mode Select
4 Serial EEPROM WP
Serial EEPROM Pullups
6 Serial EEPROM - A1
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Table 5: SW1, Positions 1-3

Position 3 Position 2 Position 1 Boot
GPIO18 GPIO29 GPI1O34 Mode
Open-1 Open-1 Opean-1 Flash
Open-1 Open-1 Closed-0 SCI-A
Open-1 Closed-0 Open-1 SPI-A
Open-1 Closed-0 Closed-0 2c.a
Closed-0 Open-1 Open-1 eCAN-A
Closed-0 Open-1 Closed-0 MO SABAM *
Closed-0 Closed-0 Open-1 OTP
Closed-0 Closed-0 Closed-0 /O

* factory default
DS1/DS2 - LEDs
Table 6: LEDs
LED # | Color Controlling Signal
DS1 Green +5 Volts
Ds2 Green GPI0O34 bit (GPIO34 high = on)

J1/J2 - Test Points

Table 7: Test Points

Test Point Signal
J1 Analog Ground
J2 Ground
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Appendix B — Addressing Modes

Introduction

Appendix B will describe the data addressing modes on the C28x. Immediate addressing allows
for constant expressions which are especially useful in the initialization process. Indirect
addressing uses auxiliary registers as pointers for accessing organized data in arrays. Direct
addressing is used to access general purpose memory. Techniques for managing data pages,
relevant to direct addressing will be covered as well. Finally, register addressing allows for
interchange between CPU registers.

Learning Objectives

Learning Objectives

¢ Explain .sect and .usect assembly directives
¢ Explain assembly addressing modes
¢ Understand instruction formats

¢ Describe options for each addressing mode
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Module Topics
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Labels, Mnemonics and Assembly Directives

Labels, Mnemonics and Assembly Directives

Labels and Mnemonics
elLabels ref Etart )
_ sect vectors
> Optional for all assembly :make reset vector address 'start’
instructions and most reset: .long start
assembler directives
> Must begin in column 1 def start
o count .set 9
> The * : " is not treated as :create an array x of 10 words
part of the label name X .usect  “mydata”, 10
» Used as pointers to T sect | “code” |
memory or INStructions ——_ Lqa:  C280BJ ;operate in C28x mode
. MOV  ACC#1
+Mnemonics nextt MOVL XARI #x
> Lines of instructions _ ___{——— MOV  AR2#count
loop: MOV  *XARL++AL
> Use upper or lower case ’
upp W BANZ loop,AR2--
» Become components of bump: ADD ACC #1

program memory

SB next,UNC

Assembly Directives

+ Begin with a period (.) and are
lower case

» Used by the linker to locate —
code and data into specified

sections

« Directives allow you to:
> Define a label as global

> Reserve space in memory
for un-initialized variables ——-

p—
—
——

> Initialized memory ———7"7" "]
EsmEmEn DlreCtlveS eammmmmE
initialized section

.sect “name” |
used for code or constants
uninitialized section

.ref start
| __ > .Sect “vectors”
;make reset vector address 'start'
reset: .long start
__—».def start
[count .set 9
; create an array x of 10 words
X _—».Usect  “mydata”, 10
L ———.sect “code”
start: C280BJ ;operate in C28x mode
MOV  ACC#1
next: MOVL XARI#x
MOV  AR2#count
loop: MOV  *XAR1++AL
BANZ loop,AR2--
bump: ADD ACC#1

label .usect “name",5|

SB next,UNC

used for variables

TMS320C28x DSP Workshop - Appendix B - Addressing Modes



Addressing Modes

Addressing Modes

Addressing Modes

Mode Symbol | Purpose

(register)| Register Operate between Registers

(constant)| Immediate| # Constants and Initialization
(paged)| Direct @ General-purpose access to data
(pointer) | Indirect * Support for pointers — access arrays,

lists, tables

Four main categories of addressing modes are available on the C28x. Register addressing mode
allows interchange between all CPU registers, convenient for solving intricate equations.
Immediate addressing is helpful for expressing constants easily. Direct addressing mode allows
information in memory to be accessed. Indirect addressing allows pointer support via dedicated
‘auxiliary registers’, and includes the ability to index, or increment through a structure. The C28x
supports a true software stack, desirable for supporting the needs of the C language and other
structured programming environments, and presents a stack-relative addressing mode for
efficiently accessing elements from the stack. Paged direct addressing offers general-purpose
single cycle memory access, but restricts the user to working in any single desired block of
memory at one time.
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Instruction Formats

Instruction Formats

Instruction Formats

INSTR dst ,src Example

INSTR REG NEG AL

INSTR REG,#imm MOV ACC,#1
INSTR REG,mem ADD AL, @x

INSTR mem,REG SUB AL,®@ARO
INSTR mem,#imm MOV *XARO++,#25

€ What is a“REG”"?
& 16-bit Access = ARO through AR7, AH, AL, PH, PL, T and SP
& 32-bit Access = XARO through XAR7, ACC, P, XT

€ What is an “#imm”?
& an immediate constant stored in the instruction
€ What is a “mem”?
& A directly or indirectly addressed operand from data memory
¢ Or, one of the registers from “REG”!
¢ loc16 or loc32 (for 16-bit or 32-bit data access)

The C28x follows a convention that uses instruction, destination, then source operand order
(INSTR dst, src). Several general formats exist to allow modification of memory or registers
based on constants, memory, or register inputs. Different modes are identifiable by their leading
characters (# for immediate, * for indirect, and @ for direct). Note that registers or data memory
can be selected as a ‘mem’ value.
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Register Addressing

Register Addressing

Register Addressing

32-bit Registers
IXARO — XAR7 ACC P XT]

16-bit Registers
/ARO-AR7 AH AL PH PL T TL DP SP|

¢ Allows for efficient register to register
operation

16-bit and 32-bit Register Address modes

¢ Reduces code overhead, memory
accesses, and memory overhead

*

Register addressing allows the exchange of values between registers, and with certain instructions
can be used in conjunction with other addressing modes, yielding a more efficient instruction set.
Remember that any ‘mem’ field allows the use of a register as the operand, and that no special
character (such as @, *, or #) need be used to specify the register mode.

Register Addressing — Example

Format—| MOV Ax, locl6| |[MOVL loc32,ACC
Instructon——| MOV AH, @AL MOVL @XT,ACC

Format —>| MOV locl6,Ax,COND |
Instructon——| MOV @AR1,AL,GT

User Guide & Dis-assembler
use @ for second register
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Immediate Addressing

Immediate Addressing

Immediate Addressing — “#”

one word instruction
OPCODE  |8-bit OPERAND|

two word instruction
OPCODE
16-bit OPERAND

¢ Fixed value part of program memory
instruction

¢ Supports short (8-bit) and long (16-bit)
immediate constants

Long immediate can include a shift

¢ Used to initialize registers, and operate
with constants

2

Immediate addressing allows the user to specify a constant within an instruction mnemonic. Short
immediate are single word, and execute in a single cycle. Long (16-bit) immediate allow full
sized values, which become two-word instructions - yet execute in a single instruction cycle.

Immediate Addressing — Example

¢ Short Immediate, 1 Word (ANDB) ¢ Long Immediate, 2 Words (AND)

ANDB Ax,#8Bit AND locl6,#16Bit
[ anpB[Ax| #8Bit | AND loc16
#16Bit
AND automatically replaced by :
ANDB if IMM value is 8 bits or less AND  Ax, locl6,#16Bit
AND | Ax | 1oc16
#16Bit

AND ACC,#16Bit,<<0-16

AND | Acc | shift
#16Bit
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Direct Addressing

Direct Addressing

Direct addressing allows for access to the full 4-Meg words space in 64 word “page” groups. As
such, a 16-bit Data Page register is used to extend the 6-bit local address in the instruction word.
Programmers should note that poor DP management is a key source of programming errors.
Paged direct addressing is fast and reliable if the above considerations are followed. The watch
operation, recommended for use whenever debugging, extracts the data page and displays it as the
base address currently in use for direct addressing.

Direct Addressing —“@”

Data Page Offset Data Memory
00 0000 0000 0000 00 |00 0000

L] L] L]
00 0000 0000 0000001111111
00 0000 0000 0000 01 (00 0000

L] L L
00 0000 0000 000001111 1111
00 0000 0000 0000 10 |00 0000

L] L] L]
00 0000 0000 000010111 1111
L] L]

Page 0: 00 0000 — 00 003F

Page 1: 00 0040 — 00 007F

Page 2: 00 0080 — 00 OOBF

[ [ [
1111111111 1111 11 {00 0000

° ° [ Page 65,535: 3F FFCO — 3F FFFF
1111111111 1111 11111111

¢ Data memory space divided into 65,536 pages with
64 words on each page

Data page pointer (DP) used to select active page

¢ 16-bit DP is concatenated with a 6-bit offset from the
instruction to generate an absolute 22-bit address

¢ Access data on a given page in any order

*
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Direct Addressing

Direct Addressing — Example

Q 0 0 1 F F
Z=X+Y 0000|0000 (0000|0001 (1111 (11211
! DP i offset

Data Memory

USRI T o address | data
-sect  “code” } Page7[00]  [0001C0 0001
MOVW DP,#x 64 .-
MOV  AL,@x Page7[3D] X:| 0001FD {1000
ADD AL,Q@y Page7[3E] y:| 0001FE |0500
MOV @z, AL Page7[3F] z:| 0001FF | 1500
DP=0007 Accumulator
variations: Mov AL,ex|O O O 0|1 0 O O
> MOVW DP,#imm ;2W, 16-bit (4 Meg) ADD AL,@y|0 O O 0|1 5 O O}
> MOVZ DP#imm ;1W, 10-bit (64K) !
» MOV DP#mm ;DP(15:10) unchanged MOV @2 ,AL <t
Direct Addressing — Caveats
(X 'and Y not on the same page)
Z=X+Y Data Memory
. address | data
DP i _offset Page7[00] |0001CO|0001

0000|0000 (0000|0001 1111 {1111 |--->
Page7[3F] x:[0001FF 1000

10/00 ... -Page7[3F]x:|0001FF|1000 .
0000 | 0000 [ 0000 (0010 OQOO 0000 50056616566

"X page8[00]Y:

DP=0007 Accumulator
0007 |--=--]---- X .usect “samp”,3
0007 000021000 .sect “code”
0007 0000/10,01 MOVW DP,#x
b MOV  AL,@x
expecting 1500 . 1____ ADD AL, @y
MOV @z, AL

Solution: Group and block variables in ASM file:

x .usect “samp”,3,1] ;Force all locations to same data
y .set x+1 ;page (1st hole, else linker error)

z .set x+2 ;Assign vars within block
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Indirect Addressing

Indirect Addressing

Indirect Addressing — “«”

Data Memory

XARO
XAR1
XAR2  —)
XAR3
XAR4
XARS
XAR6
XAR7

¢ Auxiliary Registers (XARn) used to access full
data memory space

¢ Address Register Arithmetic Unit (ARAU) used
to modify the XARN

¢ Access data from arrays anywhere in data
memory in an orderly fashion

Any of eight hardware pointers (ARs) may be employed to access values from the first 64K of
data memory. Auto-increment or decrement is supported at no additional cycle cost. XAR register
formats offer larger 32-bit widths, allowing them to access across the full 4-Giga words data
space.

Indirect Addressing Modes

& Auto-increment / decrement: *XARn++, *--XARN
+ Post-increment or Pre-decrement
¢ Offset: *+XARN[ARO or AR1], *+XARnN[3bit]
+ Offset by 16-bit ARO or AR1, or 3-bit constant
& Stack Relative: *-SP[6bit]
« Index by 6-bit offset (optimal for C)
¢ Immediate Direct: *(0:16bit)
+ Access low 64K
¢ Circular: *AR6%++
+ ARL(7:0) is buffer size
+ XARG6 is current address
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Indirect Addressing

Indirect Addressing — Example

4
y=> X,

n=0

Autoincrement

X .usect “samp”’,6

y .set (x + 5)
.sect ‘““code”
MOVL XAR2,#x
MOV ~ ACC,*XAR2++
ADD  ACC,*XAR2++
ADD  ACC,*XAR2++
ADD  ACC,*XAR2++
ADD  ACC,*XAR2++
MOV  *(0:y),AL

Data

X X0 |<— XAR2
x1
X2
X3
x4

[ S N g N

*(0:16bit) - 16 bit label
- must be in lower 64K
- 2 word instruction

Fast, efficient access to arrays, lists, tables, etc.

Indexed addressing offers the ability to select operands from within an array without modification
to the base pointer. Stack-based operations are handled with a 16-bit Stack Pointer register, which
operates over the base 64K of data memory. It offers 6-bit non-destructive indexing to access
larger stack-based arrays efficiently.

Indirect Addressing — Example

Offset
Data
—sX| X0
x[2] =x[1] +x[3] AT
[?] %2
b | X3
X4
X .usect *“_samp”,5
.sect “.code” ” -
X .usect “_.samp”’,5
o e
MOV  AR1,#3 MOVL XAR2,#x
MOV ACC,*+XAR2[ARO] MOV ACC,*+XAR2[1]
ADD ACC,*+XAR2[AR1] ADD ACC,*+XAR2[3]
MOV *+XAR2[Z].AL MOV *+XAR2[2],AL

16 bit offset
Allows offset into arrays with fixed base pointer

3 bit offset
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Indirect Addressing

Indirect Addressing — Example
Stack Relative

Data Memory

x2 =x1+ x3 012 0|x3
0 3 2 0|x2 «
0200x1
| -SP - |—| empty
empty
Instr. 3
.sect “.code”
MOV AL,*-SP[1] Accumulator
ADD AL *-SP[A] nstr.1{0_ 0 0 0/0 2 0 O]
MOV *-SP[2],AL Instr.2|0 00 0|0 32 0| ........

Useful for stack based operations

Indirect Addressing — Example

Circular
start of buffer Buffer Size N
| AAAA .. AAAA |AAAA AAAA |oooo oooo|—> Element 0 T

(align on 256 word boundary)
access pointer XARG6 (32) circular
| AAAA .. AAAA |AAAA AAAA |xxxx xxxxi-» buffer
range
AR1 Low (16)
end of buffer | ———————— | N-1 Element N-1

(AR1 Low is set to buffer size — 1)

MAC P,*AR6%++,*XAR7++

LINKER.CMD
SECTIONS

{ Buf_Mem: align(256) { } > RAM PACE 1
}
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Review

Review

0x000000

0x00003F

OxO0FFFF

OX3FFFFF

OXFFFFFFFF

Addressing Range Review

|

Stack
Addressing

SP
64K

Direct
Addressing
Indirect
Dpillhi+6) Addressing
XARN
4G

Data memory can be accessed in numerous ways:
Stack Addressing: allows a range to 64K

Direct Addressing: Offers a 16-bit DP plus a 6-bit offset, allowing a 4M range
Indirect Addressing: Offers the full 4G range
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Review

Exercise B
Exercise B: Addressing
Given: DP =4000 DP = 4004 DP = 4006
Address/Data (hex) 100030 ({0025 100100 (0105 100180 |0100
Fill in the 100031 |0120 100101 ({0060 100181 |0030
table below 100032 100102 (0020 100182 | 0040
Src Mode Program ACC DP XAR1 | XAR2

MOVW DP,#4000h
MOVL XAR1,#100100h
MOVL XAR2,#100180h
MOV AL,@31h

ADD AL, *XARL++
SUB AL,@30h

ADD AL, *XARL++
MOVW DP,#4006h

ADD AL,@1

SUB AL, *XARL

ADD AL ,*XAR2

SUB AL,*+XAR2[1]
ADD AL,#32

SUB AL,*+XAR2[2]
MOV @32h,AL

Imm: Immediate;  Dir: Direct;
Reg: Register; Idr: Indirect

In the table above, fill in the values for each of the registers for each of the instructions. Three
areas of data memory are displayed at the top of the diagram, showing both their addresses and
contents in hexadecimal. Watch out for surprises along the way. First, you should answer the
addressing mode for the source operand. Then, fill in the change values as the result of the in-
struction operation.

B-14 TMS320C28x DSP Workshop - Appendix B - Addressing Modes



Lab B: Addressing

Lab B: Addressing

Note: The lab linker command file is based on the F2812 memory map — modify as needed, if
using a different F28xx device memory map.

» Objective

The objective of this lab is to practice and verify the mechanics of addressing. In this process we
will expand upon the ASM file from the previous lab to include new functions. Additionally, we
learn how to run and observe the operation of code using Code Composer Studio.

In this lab, we will initialize the “vars’ arrays allocated in the previous lab with the contents of
the “const” table. How is this best accomplished? Consider the process of loading the first
““const” value into the accumulator and then storing this value to the first ““vars’ location,
and repeating this process for each of the succeeding values.

o What forms of addressing could be used for this purpose?
o Which addressing mode would be best in this case? Why?
e What problems could arise with using another mode?

> Procedure

Copy Files, Create Project File

1. Create a new project called LabB.pjt in C:\C28x\Labs\Appendix\LabB and add
LabB_asm, and LabB.cmd to it. Check your file list to make sure all the files are there.
Be sure to setup the Build Options by clicking: Project - Build Options onthe
menu bar. Select the Linker tab. In the middle of the screen select ““No
Autoinitialization” under “Autoinit Model:". Create a map file by typing
-\Debug\LabB.map inthe Map Filename [-m] field. Enter start inthe
“Code Entry Point (-e):” field. Next, select the Compiler tab. Note that “Full
Symbolic Debug (-g)” under “Generate Debug Info:” isselected. Then
select OK to save the Build Options.

Initialize Allocated RAM Array from ROM Initialization Table

2. Edit LabB.asm and modify it to copy table[9] to data[9] using indirect addressing. (Note:
data[9] consists of the allocated arrays of data, coeff, and result). Initialize the allocated
RAM array from the ROM initialization table:

o Delete the NOP operations from the ““code’ section.

¢ Initialize pointers to the beginning of the “const’ and ““vars” arrays.
o Transfer the first value from ““const’ to the “vars” array.

o Repeat the process for all values to be initialized.

To perform the copy, consider using a load/store method via the accumulator. Which part of an
accumulator (low or high) should be used? Use the following when writing your copy routine:
- use AR1 to hold the address of table
- use AR2 to hold the address of data
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Lab B: Addressing

3.

It is good practice to trap the end of the program (i.e. use either “end: B end,UNC” or
“end: B start,UNC”). Save your work.

Build and Load

4.

Click the ““Rebui ld Al I’ button and watch the tools run in the build window. Debug as
necessary. To open up more space, close any open files or windows that you do not need.

Load the output file onto the target. Click:

File > Load Progranm..

If you wish, right click on the LabB_asm source window and select Mixed Mode to
debug using both source and assembly.

Note: Code Composer Studio can automatically load the output file after a successful build. On
the menu bar click: Option > Customize.. and select the ““Program Load
Options™ tab, check “Load Program After Build”, then click OK.

6. Single-step your routine. While single-stepping, it is helpful to see the values located in

table[9] and data[9] at the same time. Open two memory windows by using the “View
Memory’’ button on the vertical toolbar and using the address labels table and data.

Setting the properties filed to “Hex — TI style” will give you more viewable data in the
window. Additionally, it is useful to watch the CPU core (and status) registers. Open the
CPU core (and status) registers by using the “View - CPU Registers”. Deselect
“Allow Docking’ and move/resize the window as needed. Check to see if the program is
working as expected.

You might want to use your workspace from the previous lab. Look under File = Recent
Workspaces on the menu bar to select your saved workspace quickly. 1f needed, reload your
project.

End of Exercise
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OPTIONAL Lab B-C: Array Initialization in C

OPTIONAL Lab B-C: Array Initialization in C

Note: The lab linker command file is based on the F2812 memory map — modify as needed, if
using a different F28xx device memory map.

» Objective

The objective of this lab is to practice and verify the mechanics of initialization using C.
Additionally, we learn how to run and observe the operation of C code using Code Composer
Studio. In this lab, we will initialize the ““vars’ arrays with the contents of the ““const” table.

> Procedure

Create Project File

1. In Code Composer Studio create a new project called LabB-C.pjtin
C:\C28x\Labs\Appendix\LabB\LabB-C and add LabB-C.c, LabB-C.cmd and
C:\ti1\c2000\cgtools\1ib\rts2800_ml.libtoit. Check your file list to make
sure all the files are there. Do not setup any Build Options. The default values will be used.
In Appendix Lab D exercise, we will experiment and explore the various build options when
working with C.

Initialize Allocated RAM Array from ROM Initialization Table

2. Edit LabB-C. c and modify the “main” routine to copy table[9] to the allocated arrays of
data[4], coeff[4], and result[1]. (Note: data[9] consists of the allocated arrays of data, coeff,
and result).

Build and Load

3. Click the ““Rebui ld Al button and watch the tools run in the build window. Debug as
necessary.

Note: Have Code Composer Studio automatically load the output file after a successful build. On
the menu bar click: Option > Customize.. and select the “Program Load Options”
tab, check “Load Program After Build”, then click OK.

4. Under Debug on the menu bar click ““Go Main”. Single-step your routine. While single-
stepping, it is helpful to see the values located in table[9] and data[9] at the same time. Open
two memory windows by using the ““View Memory’” button on the vertical toolbar and
using the address labels table and data. Setting the properties filed to “Hex — T1 style”
will give you more viewable data in the window. Additionally, you can watch the CPU (and
Status) registers. Open the CPU core and status registers by using the “View -> CPU
Registers”. Deselect “Allow Docking’ and move/resize the window as needed.
Check to see if the program is working as expected.

End of Exercise
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Solutions

Solutions
Exercise B: Addressing - Solution
Given: DP = 4000 DP = 4004 DP = 4006
Address/Data (hex) 100030 {0025 100100 |0105 100180 {0100
Fill in the 100031 (0120 100101 {0060 100181 |0030
table below 100032 100102 10020 100182 [0040
Src Mode Program ACC DP XAR1 [ XAR2
Imm MOVW DP,#4000h 4000
Imm MOVL XAR1,#100100h 100100
Imm | MOVL XAR2,#100180h 100180
Dir MOV AL,@31h 120
Idr ADD AL,*XAR1++ 225 100101
Dir SUB AL,@30h 200
1dr ADD AL,*XAR1++ 260 100102
Imm MOVW DP,#4006h 4006
Dir ADD AL,@1 290
1dr SUB AL, *XAR1 270
Idr ADD AL,*XAR2 370
Idr SUB AL, *+XAR2[1] 340 100180
Imm ADD AL,#32 360
Idr SUB AL,*+XAR2[2] 320 100180
Dir MOV @32h,AL 1001B2 (0320
Imm: Immediate;  Dir: Direct;
Reg: Register; Idr: Indirect
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Appendix C — Assembly Programming

Introduction

Appendix C discusses the details of programming in assembly. It shows you how to use
different instructions that further utilize the advantage of the architecture data paths. It gives
you the ability to analyze the instruction set and pick the best instruction for the application.

Learning Objectives

Learning Objectives

¢ Perform simple program control using
branch and conditional codes

¢ Write C28x code to perform basic
arithmetic

¢ Use the multiplier to implement
sum-of-products equations

¢ Use the RPT instruction (repeat) to
optimize loops

¢ Use MAC for long sum-of-products

¢ Efficiently transfer the contents of one
area of memory to another

¢ Examine read-modify-write operations
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Module Topics

Module Topics
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Program Control

Program Control

The program control logic and program address generation logic work together to provide proper
program flow. Normally, the flow of a program is sequential: the CPU executes instructions at
consecutive program memory addresses. At times, a discontinuity is required; that is, a program
must branch to a nonsequential address and then execute instructions sequentially at that new
location. For this purpose, the C28x supports interrupts, branches, calls, returns, and repeats.
Proper program flow also requires smooth flow at the instruction level. To meet this need, the
C28x has a protected pipeline and an instruction-fetch mechanism that attempts to keep the

pipeline full.
Branches
Branch Types and Range
> 3 Branch Types
0x000000
! | Long
Short Branch Branch B H
ranc
Program| ©ffse€t *1271 oeeet 4132k
X 1128d 5 q absolute 4M
Memor -wor ~ 2-word
/ instruction instruction insz,t_\r,\lljc():rt(ijon
| |
~—PC
Ox3FFFFF

The PC can access the entire 4M words (8M bytes) range. Some branching operations offer 8-
and 16-bit relative jumps, while long branches, calls, and returns provide a full 22-bit absolute
address. Dynamic branching allows a run-time calculated destination. The C28x provides the fa-
miliar arithmetic results status bits (Zero, oVerflow, Negative, Carry) plus a Test Control bit
which holds the result of a binary test. The states of these bits in various combinations allow a
range of signed, unsigned, and binary branching conditions offered.
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Program Control

Program Control Instructions

Program Control - Branches

Function Instruction Cycles T/F|Size
Short Branch SB 8bit,cond 7/4 1
Fast Short Branch SBF 8bit,EQINEQJTC|NTC 4/4 1
Fast Relative Branch| B 16bit,cond 7/4 2
Fast Branch BF 16bit,cond 4/4 2
Absolute Branch LB 22bit 4 2
Dynamic Branch LB *XAR7 4 1
Branch on AR BANZ 16bit,ARn-- 4/2 2
Branch on compare | BAR 16bit,ARn,ARn,EQ]NEQ 4/2 2

Condition Code

NEQ LT LO(NC) NTC @ Condition flags are set on
EQ LEQ LOS TC the prior use of the ALU
GT HI NOV UNC . .
@ The assembler will optimize
GE HIS (C ov . .
= ©) NBIO B to SB if possible

Program Control - Call/Return

Function Call Code Cycles | Return code Cycles
Call LCR 22bit 4 LRETR 4
Dynamic Call LCR *XARn 4 LRETR 4
Interrupt Return IRET 8
¢ More Call variations LCR _Func Stack
in the user guide are LRETR Local
for code backward Var
compatibility RPC | Old RPC [—/———|22-bit old

New RPC ---------- >| Ret Addr J RPC
c
Ret Addr
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Program Control

4
y=> X,

n=0 Data

x1
X2
x3
x4

AR3

<— XAR2

| S 7 g

BANZ Loop Control Example

€ Auxliary register used as loop counter
€ Branch if Auxilary Register not zero
@ Test performed on lower 16-bits of XARx only

len

sum:

-set
-usect
-set

-sect
MOVL
MOV
MOV
ADD
BANZ
MOV

5
“Samp” , 6
(x+len)

“code”
XAR2 , #x
AR3,#len-2
AL, *XAR2++
AL, *XAR2++
sum,AR3--
*(0:y),AL
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ALU and Accumulator Operations

ALU and Accumulator Operations

Product (32)

ALU and Accumulator

16/32 data mem,
16/32 bit registers

MUX | &/16mm |

ALU and Barrel Shifter

ACC

AH (31-16)

AL (15-0)

AH.MSB | AH.LSB

AL.MSB | AL.LSB

One of the major components in the execution unit is the Arithmetic-Logical-Unit (ALU). To
support the traditional Digital Signal Processing (DSP) operation, the ALU also has the zero
The enhancement that the C28x has is the additional
data paths added form the ALU to all internal CPU registers and data memory. The connection to
all internal registers helps the compiler to generate efficient C code. The data path to memory
allows the C28x performs single atomic instructions read-modify-write to the memory.

cycle barrel shifter and the Accumulator.

The following slides introduce you to various instructions that use the ALU hardware. Word,

byte, and long word 32-bit operation are supported.
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ALU and Accumulator Operations

Simple Math & Shift

Accumulator - Basic Math Instructions
g XXX Ax, #16b ;word XXX = instruction: MOV, ADD, SUB, ...
S| xxxB Ax, #8b :byte | AX= AH orAL .

o Assembler will automatically convert to 1
L | xxxL  ACC, #32b ;long | word instruction.
< |ADD ACC, #01234h<<4 Two word instructions with shift option
W | ApDB AL, #34h One word instruction, no shift
Ax = AH or AL Operations
ACC Operations MOV  Ax, locl6
< | MOV 5 ACC,locl6<<shift ADDE A, locl6
] SUB Ax, locl6
2 | ADD } from memory (left shift 2
© | SUB optional) AND Ax, locl6
= = OR Ax, locl6
© | MOV ACC, #16b<<sh >
> AgD } CC,#16b<<shiTt XOR  Ax, locl6
16-bit constant (left shift
SUB optional) AND Ax, locl6,#16b
NOT AX
MOV locl6,ACC <<shift ;AL| | NEG  Ax
MOVH locl6,ACC <<shift ;AH MOV locl6,Ax

Shift the Accumulator
Shift full ACC 3. 0
LSL ACC <<shift (1-16) C ACC 0 LSL
SFR ACC >>shift
LSL ACC <<T (0-15) 31......... 0
SFR  ACC >>T SXM ACC |—cC [SFR
15 ... 0
LSL AX <<shift
LSR AX <<shift 15......... 0
ASR  AX >>shift SXM—| Ax |—cC|ASR
LSL AX <<T
LSR  AX <<T 15 ......... 0
ASR  AX >>T 0— Ax |—cC]|LSR
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ALU and Accumulator Operations

32 Bit Shift Operations [ACC]

31 0
C ACC 0
Examples:
Logical Shift Left — Long: LSLL LSLL ACC, T
LSRL ACC, T
3. 0
n A6 T — ¢ ASRL ACC, T
Logical Shift Right — Long: LSRL Note: T(4:0) are used;
other bits are ignored
31 0
Oor1l ACC |—C
based on SXM

Arithmetic Shift Right — Long: ASRL
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Multiplier

Multiplier

Multiply Unit

XT Register

T Register

Data Mem
or Register

32x32 Multiply Unit

Prog Mem (16)
or
Immed (8,16)

P Register (32)

Shift (PM)

ACC (32)

Digital signal processors require many multiply and add math intensive operations. The single
cycle multiplier is the second major component in the execution unit.
traditional 16-bit-by-16-bit multiplier as previous Tl DSP families. In-addition, the C28x has a
single cycle 32-bit-by-32-bit multiplier to perform extended precision math operations. The large
multiplier allows the C28x to support higher performance control systems requirement while

maintaining small or reduce code.

The C28x has the

The following slides introduce instructions that use the 16-bit-by-16-bit multiplier and multiply
and add (MAC) operations. The 32-bit-by-32-bit multiplication will be covered in the appendix.
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Multiplier

Basic Multiplier

Multiplier Instructions

Instruction Execution Purpose

MOV T,locl6 T

MPY ACC,T,locl6|ACC
MPY P,T,locl6 P
MPYB  ACC,T,#8bu |ACC
MPYB P,T,#8bu P

locl6 Get first operand

T*locl16 For single or first product
T*locl16 For nt product

T*8bu Using 8-bit unsigned const
T*8bu Using 8-bit unsigned const

MOV ACC,P ACC =P Move 1%t product<<PM to ACC
ADD ACC,P ACC += P Add nth product<<PM to ACC
SUB ACC,P ACC -= Sub nt" product<<PM fr. ACC
Instruction Execution
MOVP T, locl6 ACC =P<<PM T =locl6
MOVA , locl6 ACC += P<<PM T =locl6

T
MOVS T, locl6 ACC - = P<<PM T =locl6
MPYA P, T, #16b ACC += P<<PM then P =T*#16b
P
P

MPYA , T, locl6 ACC += P<<PM then P =T*locl6
MPYS , 1, locl6 ACC - = P<<PM then P =T*locl6

Sum-of-Products

Y = A*X1 + B*X2 + C*X3 + D*X4

ZAPA ;ACC = P =0VC =0

MOV T,@X1 ;T = X1

MPY P,T,QA ;P = A*X1

MOVA T,@X2 ;T = X2 ;ACC = A*X1

MPY P,T,@B ;P = B*X2

MOVA T,@X3 ;T = X3 ;ACC = A*X1 + B*X2

MPY P,T,@C ;P = C*X3

MOVA T,@X4 ;T = X4;ACC = A*X1 + B*X2 + C*X3
MPY P,T,@D ;P = D*X4

ADDL ACC,P<<PM ;ACC =Y

MOVL @y,ACC
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Multiplier

32x32 Long Multiplication

x Ly | |

Integer long multiplication
u(long) = u(long) * u(long)

L X0 * YO |=<—---

Fraction long multiplication:
| (long) = (long) * (long)

| z3 | z2 | z1 | 20 |<----(long) 64 = (long) 32 * (long) 32
I

P-register |

<————————————

[ Y1 > xa

| Accumulator

IMPYAL  P,XT,loc32 P = u(XT)*u(loc32)
QMPYAL  ACC,XT,loc32| ACC = (XT)*(loc32)

IMACL  P,l0c32,*XAR7 | ACC +=P; P =u(loc32)*u(loc32)
QWACL P, l10c32,*XAR7 | ACC +=P; P = (loc32)*(loc32)

Repeat Instruction

Repeat Next: RPT

¢ Options:
> RPT #8bit up to 256 iterations
> RPT locl6 location “loc16” holds count value
& Features: Example :
» Next instruction iterated N+1 times int x[5]={0,0,0,0,0};

» Saves code space - 1 word
» Low overhead - 1 cycle

> Easy to use

» Non-interruptible T
» Requires use of || before next line

X .usect “samp”,5
MOV  AR1,#x

RPT #4

MOV ~ *XAR1++,#0

» May be nested within BANZ loops
Instruction |Cycles

RPT 1
BANZ 4-N

Refer to User Guide for more repeatable instructions
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Multiplier

Single repeat instruction (RPT) is used to reduce code size and speed up many operations in the
DSP application. Some of the most popular operations that use the RPT instruction to perform
multiple taps digital filters or perform block of data transfer.

MAC Instruction
Sum-of- Products RPT / MAC

.usect “sample”,20
19 y .usect “result”,2
y — Z X a .sect “coefficient”
n=mn a0: .word 0x0101
n=0 .word 0x0202

XAR1++ X0 .word 0x2020
X1 .sect “‘code”
SOP: SPM 0
MOVW  DP,#y
MOVL  XAR1,#x

MOVL  XAR7,#a0O
ZAPA <« Zero ACC & P

XART7++ A0 RPT #19 Repeat single
?neﬁcs){]gszp)%&ag? Al Il MAC P,*XAR1++,*XAR7++  Dual operand
ADDL  ACC,P<<PM «——— last ADD
MOVL  @y,ACC
A19 B SOP,UNC

MOV T,Iocl6:|'> MOVA T,locl6 incd | S
ADD ACC,P MPY P,T,locl6 P=T*(*ARN++)

X19
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Data Move

Data Move
Data Move Instructions

DATA <& DATA (4G < 64K) DATA & PGM (4G <> 4M)
MOV locl6, *(0:16bit) PREAD 4|0016 ,*XAR?
MOV 4:(0:16bit), |0016‘> PWRITE/ *XAR7, |0clé\

-~ ~ / \

16-bit add;:ss concatenated 32-bit addre\ss memory pointer with a 22-bit
with 16 leading zeros location program memory address

.sect “.code”
START: MOVL  XAR5,#x

MOVL  XAR7,#TBL

RPT #len-1

11 PREAD *XAR5++,*XAR7

X :l-Jéect “_samp”,4
.sect “.coeff”

TBL: .word 1,2,3.,4

len .set $-TBL

¢ Optimal with RPT (speed and code size) & Faster than Load / Store, avoids

& In RPT, non-mem address is auto- accumulator
incremented in PC & Allows access to program memory

Conditional Moves

Instruction Execution (if COND is met)
MOV locl6,AX,COND [locl6] = AX

MOVB locl6,#8bit,COND | [locl6] = 8bit
Instruction Execution (if COND is met)
MOVL loc32,ACC,COND [loc32] = AX

Example
If A<B, Then B=A
Accumulator
A .usect “var”,2,1 looo0o0j0120]
B .set A+l
-sect code Data Memory Data Memory
MOVW DP, #A
MOV AL, GA 012 0|A 012 0A
CMP AL, 0B 0320B 0120B
MOV @B, AL, LT Before After

The conditional move instruction is an excellent way to avoid a discontinuity (branch or call)
based upon a condition code set prior to the instruction. In the above example, the 1% step is to
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Data Move

place the contents of A into the accumulator. Once the Ax content is tested, by using the CMP
instruction, the conditional move can be executed.

If the specified condition being tested is true, then the location pointed to by the “loc16” address-
ing mode or the 8-bit zero extended constant will be loaded with the contents of the specified AX
register (AH or AL): if (COND ==true) [loc16] = AX or 0:8bit;

Note: Addressing modes are not conditionally executed. Hence, if an addressing mode performs a
pre or post modification, it will execute regardless if the condition is true or not. This instruction
is not repeatable. If this instruction follows the RPT instruction, it resets the repeat counter
(RPTC) and executes only once.

Flags and Modes

N - If the condition is true, then after the move, AX is tested for a negative condition. The nega-
tive flag bit is set if bit 15 of AX is 1, otherwise it is cleared.

Z - If the condition then after the move, AX is tested for a zero condition. The zero flag bit is set
if AX =0, otherwise it is cleared.

V - If the V flag is tested by the condition, then V is cleared.

C-Example
;if (VarA>20)
:VarA =0;

CMP @VarA #20 ; Set flags on (VarA - 20)
MOVB @VarA #0,GT ; Zero VarA if greater then

TMS320C28x DSP Workshop - Appendix C - Assembly Programming



Logical Operations

Logical Operations

Byte Operations and Addressing

MOVB AX.

MOVB AX.

Byte Operations

LSB,locl16

MSB,loc16

MOVB loc16, AX.LSB

MOVB locl6, AX.MSB
Byte = 1. Low byte for register addressing

2. Low byte for direct addressing
3. Selected byte for offset indirect addressing

For loc16 = *+XARN[Offset]

0000 0000 Byte AX
Byte No change AX

No change Byte loc16

No change Byte loc16

Odd Offset | Even Offset loc16

Byte Addressing

AHMSB AH.LSB AL.MSB AL.LSB

12

| 34 [ % | B |
LlB bit memory
78 | 0 —AR2 |
83 56
34 | 04
&7 12

Example of Byte Un-Packing Example of Byte Packing

MOVL
MOVB
MOVB
MOVB
MOVB

XAR2, #MemA MOVL XAR2, #MemA
*+XAR2[1], AL.LSB MOVB AL.LSB,*+XAR2[1]
*+XAR2[2], AL.MSB MOVB AL.MSB,*+XAR2[2]
*+XAR2[5], AH.LSB MOVB AH.LSB,*+XAR2[4]
*+XAR2[6], AH.MSB MOVB AH.MSB,*+XAR2[7]
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Logical Operations

Test and Change Memory Instructions

The compare (CMPx) and test (TxxXx) instructions allow the ability to test values in memory. The
results of these operations can then trigger subsequent conditional branches. The CMPXx instruc-
tion allows comparison of memory with respect to a specified constant value, while the Txxx in-
structions allow any single bit to be extracted to the test control (TC) field of status register 0.
The contents of the accumulator can also be non-destructively analyzed to establish branching
conditions, as seen below.

Test and Change Memory

Instruction Execution Affects
TBIT  l1ocl6,#(0-15) | STO(TC) = loc16(bit_no) TC
TSET  locl6,#(0-15) | Test (loc16(bit)) then set bit TC
TCLR locl6,#(0-15) | Test (loc16(bit)) then clr bit TC

CMPB  AX, #8bit Test (AX - 8bit unsigned) CN,Z
CMP AX, locl6 Test (AX —locl6) CN,Z
CMP locl6,#16b Test (locl6 - #16bit signed) C,N,Z
CMPL  ACC, @P Test (ACC - P << PM) CN,z
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Logical Operations

Min/Max Operations

MIN/MAX Operations

Instruction Execution
MAX ACC, locl6 ACC < locl6, ACC = loclé6
ACC >= locl6, do nothing
ACC > locl6, ACC = locl6
ACC <= locl6, do nothing
ACC < loc32, ACC = loc32
ACC >= loc32, do nothing
ACC > loc32, ACC = loc32
ACC <= loc32, do nothing
P < loc32, P = loc32
P >= loc32, do nothing
P > loc32, P = loc32
P <= loc32, do nothing

MIN ACC, locl6

MAXL ACC, loc32

MINL ACC, loc32

MAXCUL P,loc32
(for 64 bit math)
MINCUL P,loc32
(for 64 bit math)

=h =h|=h =h|=h =h|=h =h|=h =h|=h =

Find the maximum 32-bit number in a table:
MOVL ACC#0
MOVL XAR1 #table
RPT #(table_length — 1)
I MAXL ACC,*XAR1++
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Read Modify Write Operations

Read Modify Write Operations

The accumulator (ACC) is the main working register for the C28x. It is the destination of all
ALU operations except those, which operate directly on memory or registers. The accumulator
supports single-cycle move, add, subtract and compare operations from 32-bit-wide data memory.
It can also accept the 32-bit result of a multiplication operation. These one or two cycle
operations are referred to as read-modify-write operations, or as atomic instructions.

Read-Modify-Write Instructions

€ Work directly on memory — bypass ACC
€ Atomic Operations — protected from interrupts

AND locl6,AX AND locl6,#16b

OR locl6,AX OR locl6,#16b

XOR locl16,AX AH XOR locl6,#16b 16- bit
AL constant

ADD locl6,AX ADD locl6,#16b

SUB  locl6,AX SUBR locl6,#16b
SUBR locl6.AX | | b Tt Y

INC locl6 T TSET locl6,#bit
DEC 1locl6 TCLR locl6,#bit
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Read Modify Write Operations

Read-Modify-Write Examples

update with a mem update with a constant update by 1
VarA +=VarB | VarA +=100 VarA +=1
SETC INTM SETC INTM SETC INTM
MOV AL, @VarB MOV AL, @VarA MOV AL, @VarA
ADD AL, @VarA ADD AL, #100 ADD AL, #1
MOV @varA, AL MOV @varA, AL MOV @varA, AL
CLRC INTM CLRC INTM CLRC INTM
MOV AL, @varB ADD @varA,#100 INC @varA
ADD @varA, AL

V

Benefits of Read-Modify-Write Instructions
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Lab C: Assembly Programming

Lab C: Assembly Programming

Note: The lab linker command file is based on the F2812 memory map — modify as needed, if
using a different F28xx device memory map.

Objective

The objective of this lab is to practice and verify the mechanics of performing assembly language
programming arithmetic on the TMS320C28x. In this process we will expand upon the _asm file
from the previous lab to include new functions. Code will be to added to obtain the sum of the
products of the values from each array.

Perform the sum of products using a MAC-based implementation. In a real system application,
the coeff array may well be constant (values do not change), therefore one can modify the
initialization routine to skip the transfer of this arrays, thus reducing the amount of data RAM and
cycles required for initialization. Also, there is no need to copy the zero to clear the result
location. The initialization routine from the previous lab using the load/store operation will be
replaced with a looped BANZ implementation.

As in previous lab, consider which addressing modes are optimal for the tasks to be performed.
You may perform the lab based on this information alone, or may refer to the following
procedure.

Procedure

Copy Files, Create Project File

1. Create a new project called LabC.pjtin C:\C28x\Labs\Appendix\LabC and
add LabC.asm, and LabC.cmd to it. Check your file list to make sure all the files are
there. Be sure to setup the Build Options by clicking: Project -> Build
Options onthe menu bar. Select the Linker tab. In the middle of the screen select
“No Autoinitialization” under “Autoinit Model:”. Create a map file by
typing .\Debug\LabC.map inthe Map Filename [-m] field. Enter start
in the “Code Entry Point (-e):” field. Next, select the Compiler tab. Note that
“Full Symbolic Debug (-g)” under “Generate Debug Info:”is
selected. Then select OK to save the Build Options.

Initialization Routine using BANZ

2. Edit LabC.asm and modify it by replacing the initialization routine using the load/store
operation with a BANZ process. Remember, it is only necessary to copy the first four
values (i.e. initialize the data array). Do you still need the coeff array in the vars section?

3. Save your work. If you would like, you can use Code Composer Studio to verify the
correct operation of the block initialization before moving to the next step.
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Lab C: Assembly Programming

Sum of Products using a RPT/MAC-based Implementation

4. Edit LabC.asmto add a RPT/MAC-based implementation to multiply the coeff array by
the data array and storing the final sum-of-product value to result.

Build and Load

5. Click the ““Rebui ld All’’ button and watch the tools run in the build window. Debug

as necessary. To open up more space, close any open files or windows that you do not
need.

6. Ifthe “Load program after build’ option was not selected in Code Composer
Studio, load the output file onto the target. Click: File > Load Progranm..

If you wish, right click on the source window and select Mixed Mode to debug using
both source and assembly.

7 . Single-step your routine. While single-stepping, open memory windows to see the values
located in table [9] and data [9] . Open the CPU Registers. Check to see if the program is
working as expected. Debug and modify, if needed.

Optional Exercise

After completing the above, edit LabC.asm and modify it to perform the initialization
process using a RTP/PREAD rather than a load/store/BANZ.

End of Exercise
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OPTIONAL Lab C-C: Sum-of-Products in C

OPTIONAL Lab C-C: Sum-of-Products in C

Note: The lab linker command file is based on the F2812 memory map — modify as needed, if
using a different F28xx device memory map.

» Objective
The objective of this lab is to practice and verify the mechanics of performing C programming
arithmetic on the TMS320C28x. The objective will be to add the code necessary to obtain the
sum of the products of the n-th values from each array.
» Procedure
Create Project File
1. In Code Composer Studio create a new project called LabC-C.pjtin
C:\C28x\Labs\Appendix\LabC\LabC-C and add LabC-C.c, LabC-C.cmd
and C:\ti1\c2000\cgtools\1ib\rts2800_ml.libtoit. Check your file list to
make sure all the files are there. Do not setup any Build Options. The default values will
be used. In Appendix Lab D exercise, we will experiement and explore the various build
options when working with C.
Sum of Products using a MAC-based Implementation
2. Edit LabC-C. c and modify the “main” routine to perform a MAC-based
implementation in C. Since the MAC operation requires one array to be in program
memory, the initialization routine can skip the transfer of one of the arrays, thus reducing
the amount of data RAM and cycles required for initialization.
Build and Load
3. Click the ““Rebuild Al I’ button and watch the tools run in the build window. Debug
as necessary.
Note: Have Code Composer Studio automatically load the output file after a successful build. On
the menu bar click: Option - Customize.. and select the “Program Load Options”
tab, check “Load Program After Build”, then click OK.
4. Under Debug on the menu bar click “Go Main. Single-step your routine. While
single-stepping, open memory windows to see the values located in table [9] and data
[9] . (Note: data[9] consists of the allocated arrays of data, coeff, and result). Open the
CPU Registers. Check to see if the program is working as expected. Debug and modify,
if needed.
End of Exercise
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Appendix D — C Programming

Introduction

The C28x architecture, hardware, and compiler has been designed to efficiently support C code
programming.

Appendix D will focus on how to program in C for an embedded system. Issues related to
programming in C and how C behaves in the C28x environment will be discussed. Also, the C
compiler optimization features will be explained.

Learning Objectives

Learning Objectives

Learn the basic C environment for
the C28x family

How to control the C environment
How to use the C-compiler optimizer
Discuss the importance of volatile
Explain optimization tips

*

*® O ¢ o
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Module Topics

Module Topics
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Linking Boot code from RTS2800.lib

Linking Boot code from RTS2800.lib
Boot.ASM - Invoked With “-C”

| Reset : PC <- *Ox3F FFCO |
vectors.asm 1
.ref _c_int00

Reset:
-long _c_int00

_c_int00 !

. Allocate stack

Init SP to top of stack

Initialize status bits

. Copy .cinit to .bss (skip if “-cr”)
. Call “_main”

a b~ wN P

The boot routine is used to establish the environment for C before launching main. The boot
routine begins with the label _c_int00 and the reset vector should contain a ".long" to this address
to make boot.asm the reset routine. The contents of the boot routine have been extracted and
copied on the following page so they may be inspected. Note the various functions performed by
the boot routine, including the allocation and setup of the stack, setting of various C-requisite
statuses, the initialization of global and static variables, and the call to main. Note that if the link
was performed using the "—cr" option instead of the "—c" option that the global/static variable
initialization is not performed. This is useful on RAM-based C28x systems that were initialized
during reset by some external host processor, making transfer of initialization values unnecessary.
Later on in this chapter, there is an example on how to do the vectors in C code rather than
assembly.
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Set up the Stack

Set up the Stack

The Stack
Data Memory
The C/C++ compiler uses a
stack to:
¢ Allocate local variables
SP— 0x400| cCaller’s
(reset) (o v ¢ Pass arguments to
Arguments functions
passed on & Save the processor status
Return ¢ Save the function return
address .stack address
Function
return addr ¢ Savetemporary results
Temp results The compiler uses the hardware
stack pointer (SP) to

64K manage the stack.
SP defaults to 0x400 at reset.
AM The run-time stack grows from

low addresses to higher
addresses.

The C28x has a 16-bit stack pointer (SP) allowing accesses to the base 64K of memory. The stack
grows from low to high memory and always points to the first unused location. The compiler
uses the hardware stack pointer (SP) to manage the stack. The stack size is set by the linker.

Setting Up the Stack

Boot.asm sets up SP to
point at .stack

Linker command file: & The .stack section has to

SECTIONS { be linked into the low 64k
.stack :> RAM align=2 of data memory. The SP is
} a 16-bit register and cannot
access addresses beyond
64K.

¢ Stack size is set by the
linker. The linker creates a

Note: The compiler provides no
means to check for stack
overflow during compilation or at
runtime. A stack overflow
disrupts the run-time
environment, causing your
program to fail. Be sure to allow
enough space for the stack to
grow.

global symbol,
--STACK-SIZE, and assigns
it a value equal to the size
of the stack in bytes.
(default 1K words)

¢ You can change stack size
at link time by using the
-stack linker command
option.

In order to allocate the stack the linker command file needs to have “align = 2.”
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C28x Data Types

C28x Data Types
C28x C-Language Data Types

Type Bit Value Range

char 16 Usually 0 .. 255, but can hold 16 bits
int (natural size CPU word) 16 -32K .. 32K, 16 bits signed
unsigned int 16 0..64K, 16 bits unsigned
short (same as int or smaller) 16 same as int

unsigned short 16 same as unsigned int
long (same as int or larger) 32 -2M .. 2M, 32 bits signed
unsigned long 32 0..4M, 32 bits unsigned
float 32 |EEE single precision
double 64 |EEE double precision
long double 64 |EEE double precision

Suggestion: Group all longs together, group all pointers together

Data which is 32-bits wide, such as longs, must begin on even word-addresses (i.e. 0x0,
0x2, etc). This can result in “holes” in structures allocated on the stack.
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Accessing Interrupts / Status Register

Accessing Interrupts / Status Register
Accessing Interrupts / Status Register

Initialize via C :
extern cregister volatile unsigned int IFR;
extern cregister volatile unsigned int IER;

IER &= ~Mask; //clear desired bits
IER |= Mask; //set desired bits
IFR = 0x0000; //clear prior interrupts

¢ Interrupt Enable & Interrupt Flag Registers (IER, IFR) are not
memory mapped

¢ Only limited instructions can access IER & IFR (more in interrupt
chapter)

¢ The compiler provides extern variables for accessing the IER & IFR
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Using Embedded Assembly

Using Embedded Assembly

Embedding Assembly in C

¢ Allows direct access to assembly language from C
¢ Useful for operating on components not used by C, ex:

asm (“CLRC INTM ;enable global interrupt™);

#define EINT asm (“CLRC INTM”)

¢ Note: first column after leading quote is label field - if no label,
should be blank space.

¢ Avoid modifying registers used by C

¢ Lengthy code should be written in ASM and called from C
» main C file retains portability
> Yyields more easily maintained structures
» eliminates risk of interfering with registers in use by C

The assembly function allows for C files to contain 28x assembly code. Care should be taken not
to modify registers in use by C, and to consider the label field with the assembly function. Also,
any significant amounts of assembly code should be written in an assembly file and called from
C.

There are two examples in this slide — the first one shows how to embed a single assembly
language instruction into the C code flow. The second example shows how to define a C term that
will invoke the assembly language instruction.
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Using Pragma

Using Pragma

Pragma is a preprocessor directive that provides directions to the compiler about how to treat a
particular statement. The following example shows how the DATA_SECTION pragma is used
to put a specific buffer into a different section of RAM than other buffers.

The example shows two buffers, bufferA and bufferB. The first buffer, bufferA is treated
normally by the C compiler by placing the buffer (512 words) into the ".bss" section. The second,
bufferB is specifically directed to go into the “my_sect” portion of data memory. Global
variables, normally ".bss", can be redirected as desired.

When using CODE_SECTION, code that is normally linked as ".text", can be identified
otherwise by using the code section pragma (like .sect in assembly).

Pragma Examples

& User defined sections from C :

#pragma CODE_SECTION (func, section name’)
#pragma DATA_SECTION (symbol, “section name’)

& Example - using the DATA_SECTION Pragma
¢ Csourcefile

char bufferA[512];
#pragma DATA SECTION(bufferB, my sect”)
char bufferB[512];

¢ Resulting assembly file

.global bufferA, bufferB
-bss __bufferA,512
_bufferB: .usect “my_sect”,512

More #pragma are defined in the C compiler UG
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Optimization Levels

Optimization Levels

Optimization Scope
FILE1.C

. -00, -01 -02 -03 -pm -03
SESE
} LOCAL
single block
S A +_ FuncTION
coo ) . across FILE
} SESE: Single Entry, Single Exit blocks ACIOSS
} l functions PROGRAM
________________________________ across files
{
}
FILE2.C
{
}

Optimizations fall into 4 categories. This is also a methodology that should be used to invoke the
optimizations. It is recommended that optimization be invoked in steps, and that code be verified
before advancing to the next step. Intermediate steps offer the gradual transition from fully sym-
bolic to fully optimized compilation. Compiler switched may be invoked in a variety of ways.

Here are 4 steps that could be considered:
1% use —g
By starting out with —g, you do no optimization at all and keep symbols for debug.

2" use —-g —03
The option —03 might be too big a jump, but it adds the optimizer and keeps symbols.

3" use —g —03 -mn
This is a full optimization, but keeps some symbols

4™ use —03
Full optimization, symbols are not kept.
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Optimization Levels

Optimization Performance

-00 Performs control-flow-graph simplification
Allocates variables to registers

LOCAL Performs loop rotation

Eliminates unused code

Simplifies expressions and statements

Expands calls to functions declared inline

-0l Performs local copy/constant propagation
Removes unused assignments
Eliminates local common expressions

| —02  Default (-0)

FUNCTION Pe_rfqrms loop optimizations _
1 Eliminates global common sub-expressions
Eliminates global unused assignments

| -03 Removes all functions that are never called
FILE Simplifies functions with return values that are never used
1 Inlines calls to small functions
Identifies file-level variable characteristics

PROGRAM —03 —pm
\

Optimizer levels zero through three, offer an increasing array of actions, as seen above. Higher
levels include all the functions of the lower ones. Increasing optimizer levels also increase the
scope of optimization, from considering the elements of single entry, single-exit functions only,
through all the elements in a file. The “-pm” option directs the optimizer to view numerous input
files as one large single file, so that optimization can be performed across the whole system.

D-10
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Optimization Levels

Volatile Usage

Optimization Issue: “Volatile” Variables

Problem: The compiler does not know that this pointer may refer to a
hardware register that may change outside the scope of the C program.
Hence it may be eliminated (optimized out of existence!)

Wrong: Wait loop for a hardware signal Optimizer removes
unsigned int *CTRL empUHO%L
while (*CTRL !=1); R

empt

Solution: ! pty|

loop
volatile unsigned int *CTRL S
while (*CTRL 1=1);

¢ When using optimization, it is important to declare variables as
volatile when:

» The memory location may be modifed by something other than the
compiler (e.g. it’s a memory-mapped peripheral register).

» The order of operations should not be rearranged by the compiler
¢ Define the pointer as “volatile” to prevent the optimizer from optimizing
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Optimization Levels

Compiler Advanced Options

To get to these options, go to Project > Build Options in Code Composer Studio.

In the category, pick Advanced.

The first thing to notice under advanced options is the Auto Inlining Threshold.

- Used with —03 option

- Functions > size are not auto inlined

Note: To prevent code size increases when using —03, disable auto inlining with -0i0

The next point we will cover is the Normal Optimization with Debug (-mn).

- Re-enables optimizations disabled by “~g” option (symbolic debug)

- Used for maximum optimization

Note: Some symbolic debug labels will be lost when —mn option is used.

Optimizer should be invoked incrementally:

-g test Symbols kept for debug

-g -03 test Add optimizer, keep symbols

-g -03 -mn test More optimize, some symbols

-03 test Final rev: Full optimize, no symbols

[-mf] : Optimize for speed instead of the default optimization for code size

[-mi] : Avoid RPT instruction. Prevent compiler from generating RPT instruction. RPT instruc-
tion is not interruptible

[-mt] : Unified memory model. Use this switch with the unified memory map of the 281x &
280x. Allows compiler to generate the following:
-RPT PREAD for memory copy routines or structure assignments

-MAC instructions
-Improves efficiency of switch tables
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Optimization Levels

Optimization Tips Summary

YV V VYV V V

»
>
>

>

Summary: Optimization Tips

¢ Within C functions :
> Use const with variables for parameter constants

Minimize mixing signed & unsigned ops : SXM changes
Keep frames <= 64 (locals + parameters + PC) : *-SP[6bit]
Use structures <= 8 words : use 3 bit index mode

Declare longs first, then declare ints : minimize stack holes
Avoid: long = (int * int) : yields unpredictable results

¢ Optimizing : Use -00, -01, -02, -03 when compiling

Inline short/key functions

Pass inlines between files : static inlines in header files
Invoke automatic inlining : -03 -oi

Give compiler project visibility : use -pm and -03

¢ Tune memory map via linker command file
¢ Re-write key code segments to use intrinsics or in assembly

App notes 3rd Parties

The list above documents the steps that can be taken to achieve increasingly higher coding effi-
ciency. It is recommended that users first get their code to work with no optimization, and then
add optimizations until the required performance is obtained.
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Lab D: C Optimization

Lab D: C Optimization

Note: The lab linker command file is based on the F2812 memory map — modify as needed, if
using a different F28xx device memory map.

» Objective

The objective of this lab is to practice and verify the mechanics of optimizing C programs. Using
Code Composer Studio profile capabilities, different routines in a project will be benchmarked.
This will allow you to analyze the performance of different functions. This lab will highlight the
profiler and the clock tools in CCS.

> Procedure

Create Project File

1. Create a new project in C:\C28x\Labs\Appendix\LabD called LabD.pjt and
add LabD.c, LabD.cmd, and sop-c.c to it. (Note that sop-asm.asm will be used
in the next part of the lab, and should not be added now). Also, add the compiler run-
time support library to the project
(C-\ti\c2000\cgtools\lib\rts2800 ml.lib).

2. Setup the Build Options. Select the Linker tab and in the middle of the screen select
“Run-time Autoinitialization” under “Autoinit Model:”. Create a
map file by typing .\Debug\LabD.map inthe Map Filename [-m] field. Do
not enter anything in the ““Code Entry Point (-e):” field (leave it blank). Set
the stack size to 0x400. Next, select the Compiler tab. Note that ““Full Symbolic
Debug (-g)” under “Generate Debug Info:” in the Basic Category is
selected. On the Feedback Category pull down the interlisting options and select ““C
and ASM (-ss)”. On the Assembly Category check the Keep generated .asm
Files (-k), Keep Labels as Symbols(-as) and Generate Assembly
Listing Files (-al). The -as will allow you to see symbols in the memory
window and the —al will generate an assembly listing file (.Ist file). The listing file has
limited uses, but is sometime helpful to view opcode values and instruction sizes. (The
st file can be viewed with the editor). Both of these options will help with debugging.
Then select OK to save the Build Options.

Build and Load

3. Click the “Rebui ld A1’ button and watch the tools run in the build window. Be
sure the ““Load program after build” option is selected in Code Composer
Studio. The output file should automatically load. The Program Counter should be
pointing to _c_int00 in the Disassembly Window.
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Lab D: C Optimization

Set Up the Profile Session

4. Restart the DSP (debug - restart) andthen “Go Main’. This will run
through the C initialization routine in Boot.asm and stop at the main routine in
LabD.c.

5. Set a breakpoint on the NOP in the while(1) loop at the end of main() in LabD.c.

6. Set up the profile session by selecting Profiler - Start New Session.
Enter a session name of your choice (i.e. LabD).

7. Inthe profiler window, hover the mouse over the icons on the left region of the window
and select the icon for Profile All Functions. Click onthe “+” to expand the
functions. Record the “Code Size” of the function sop C code in the table at the end of
this lab. Note: If you do not see a “+” beside the .out file, press “Profile All Functions”
on the horizontal tool bar. (You can close the build window to make the profiler window
easier to view by right clicking on the build window and selecting “hide™).

8. Select F5 orthe runicon. Observe the values present in the profiling window. What do
the numbers mean? Click on each tab to determine what each displays.

Benchmarking Code

9. Let’s benchmark (i.e.count the cycles need by) only a portion of the code. This requires
you to set a breakpoint pair on the starting and ending points of the benchmark. Open the
file sop-c.c and set a breakpoint on the “for’” statement and the “return”
statement.

10. In CCS, select profFiler > enable clock (mustbe checked). Then select
profiler - view clock.

11. Now “Restart’ the program and then ““Run’” the program. The program should be
stopped at the first breakpoint in sop. Double click on the clock window to set the clock
to zero. Now you are ready to benchmark the code. “Run” to the second breakpoint.
The number of cycles are displayed in the clock window. Record this value in the table
at the end of the lab under “C Code - Cycles”.

C Optimization

12. To optimize C code to the highest level, we must set up new Build Options for our
Project. Select the Compiler tab. In the Basic Category Panel, under “Opt Level”
select File (-03). Thenselect OK to save the Build Options.

13. Now “Rebui I1d”’ the program and then “Run’’ the program. The program should be
stopped at the first breakpoint in sop. Double click on the clock window to set the clock
to zero. Now you are ready to benchmark the code. “Run” to the second breakpoint.
The number of cycles are displayed in the clock window. Record this value in the table
at the end of the lab under “Optimized C (-03) - Cycles”.

14. Look in your profile window at the code size of sop. Record this value in the table at the
end of this lab.
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Benchmarking Assembly Code

15. Remove sop-c.c from your project and replace it with sop-asm.asm. Rebuild and
set breakpoints at the beginning and end of the assembly code (MOVL & LRETR).

16. Start a new profile session and set it to profile all functions. Run to the first breakpoint
and study the profiler window. Record the code size of the assembly code in the table.

17. Double Click on the clock to reset it. Run to the last breakpoint. Record the number of
cycles the assembly code ran.

18. How does assembly, C code, and oprimized C code compare on the C28x?

C Code Optimized C Code (-03) Assembly Code

Code Size

Cycles

End of Exercise
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OPTIONAL Lab D2: C Callable Assembly

OPTIONAL Lab D2: C Callable Assembly

Note: The lab linker command file is based on the F2812 memory map — modify as needed, if
using a different F28xx device memory map.

» Objective

The objective of this lab is to practice and verify the mechanics of implementing a C callable
assembly programming. In this lab, a C file will be used to call the sum-of-products (from the
previous Appendix LabC exercise) by the “main” routine. Additionally, we will learn how to use
Code Composer Studio to configure the C build options and add the run-time support library to
the project. As in previous labs, you may perform the lab based on this information alone, or may
refer to the following procedure.

> Procedure

Copy Files, Create Project File

1. Create a new project in C:\C28x\Labs\Appendix\LabD2 called LabD2 .pjt and
add LabD2.c, LabD2.cmd, and sop-c.-c to it. Also, add the compiler run-time
support library to the project (C:\ti\c2000\cgtools\lib\rts2800_ml.lib).

2. Do not add LabC.asm to the project (copy of file from Appendix Lab C). Itis only
placed here for easy access. Parts of this file will be used later during this lab exercise.

3. Setup the Build Options. Select the Linker tab and in the middle of the screen select
“Run-time Autoinitialization” under “Autoinit Model:”. Create a
map file by typing .\Debug\LabD2.map inthe Map Filename [-m] field.
Do not enter anything in the “Code Entry Point (-e):” field (leave it blank).
Set the stack size to 0x400. Next, select the Compiler tab. Note that “Full
Symbolic Debug (-g)” under “Generate Debug Info:” inthe Basic
Category is selected. On the Feedback Category pull down the interlisting options and
select “C and ASM (-ss)”. On the Assembly Category check the Keep
generated .asm Files (-k), Keep Labels as Symbols(-as) and
Generate Assembly Listing Files (-al). The —as will allow you to see
symbols in the memory window and the —al will generate an assembly listing file (.Ist
file). The listing file has limited uses, but is sometime helpful to view opcode values and
instruction sizes. (The .lIst file can be viewed with the editor). Both of these options will
help with debugging. Then select OK to save the Build Options.

Build and Load

4 _ Click the ““Rebuild Al button and watch the tools run in the build window. Be
sure the “Load program after build” option is selected in Code Composer
Studio. The output file should automatically load. The Program Counter should be
pointing to _c_int00 in the Disassembly Window.

5. Under Debug on the menu bar click ““Go Main”’. This will run through the C
initialization routine in Boot.asm and stop at the main routine in LabD2 . c.
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OPTIONAL Lab D2: C Callable Assembly

Verify C Sum of Products Routine

6. Debug using both source and assembly (by right clicking on the window and select
Mixed Mode orusing View — Mixed Source/ASM).

7. Open a memory window to view result and data.

8. Single-step through the C code to verify that the C sum-of-products routine produces the
results as your assembly version.

Viewing Interlisted Files and Creating Assembly File

9. Using File — Openview the LabD2.asm and sop-c.asm generated files. The
compiler adds many items to the generated assembly file, most are not needed in the C-
callable assembly file. Some of the unneeded items are .func / .endfunc. .sym, and .line.

10. Look for the _sop function that is generated by the compiler. This code is the basis for
the C-callable assembly routine that is developed in this lab. Notice the comments
generated by the compiler on which registers are used for passing parameters. Also,
notice the C code is kept as comments in the interlisted file.

11. Create a new file (File — New, or clicking on the left most button on the horizontal
toolbar “New”) and save it as an assembly source file with the name sop-asm.asm.
Next copy ONLY the sum of products function from LabC.asm into this file. Add a
_sop label to the function and make it visible to the linker (. de¥). Also, be sure to add a
.sect directive to place this code in the “code” section. Finally, add the following
instruction to the end:

LRETR ; return statement

12. Next, we need to add code to initialize the sum-of-products parameters properly, based
on the passed parameters. Add the following code to the first few lines after entering the
_sop routine: (Note that the two pointers are passed in AR4 and AR5, but one needs to
be placed in AR7. The loop counter is the third argument, and it is passed in the
accumulator.)

MOVL XAR7,XAR5 ;XAR7 points to coeff [0]
MOV  AR5,AL ;move n from ACC to AR5 (loop counter)
SUBB XAR5,#1 ;subtract 1 to make loop counter = n-1

Before beginning the MAC loop, add statements to set the sign extension mode, set the
SPM to zero, and a ZAPA instruction. Use the same MAC statement as in Lab 4, but use
XAR4 in place of XAR2. Make the repeat statement use the passed value of n-1 (i.e.
ARb).

RPT AR5 ;repeat next instruction AR5 times
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OPTIONAL Lab D2: C Callable Assembly

Now we need to return the result. To return a value to the calling routine you will need to
place your 32-bit value in the ACC. What register is the result currently in? Adjust your
code, if necessary.

13. Save the assembly file as sop-asm.asm. (Do not name it LabD2 . asm because the

compiler has already created with that name from the original LabD2 . c code).

Defining the Function Prototype as External

14. Note in LabD2 . c an “extern” modifier is placed in front of the sum-of-products function
prototype:

extern int sop(int*,int*,int); //sop function prototype

Verify Assembly Sum of Products Routine

15. Remove the sop-c. c file from the project and add the new sop-asm.asm assembly
file to the project.

16. Rebuild and verify that the new assembly sum-of-products routine produces the same
results as the C function.

End of Exercise
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Solutions

Solutions
Lab D Solutions
C Code |Optimized|Assembly
C Code Code
(-03)
Code Size 27 12 11
Cycles 118 32 22
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